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Introduction

The Papyrus Bibliography & Knowledge Management System helps you maintain a permanent collection of reference citations.
If you need to locate all references on a particular topic, or track down an article you recall
having read last year, you can use Papyrus to rapidly search your citation collection. The results can then be sorted and formatted however you like.
If you are a student, a scholar, a researcher, or the secretary of any of these, then Papyrus can
also automate the bibliographic aspects of your work. Whenever you need to print a bibliography for a manuscript in preparation you can select the appropriate references from your
collection and use Papyrus to print the bibliography in any desired format. Papyrus can work
with your word processor to automatically read your manuscript, create the bibliography, and
produce a final draft of your manuscript in which the in-text citations have been appropriately
edited.
New references may be added to your collection at any time, and existing references can, of
course, be edited or deleted. You can also import references from virtually anywhere—national
online databases, CD-ROM bibliographic databases, monthly diskette update services, other
personal bibliographic database programs, general-purpose database applications, or existing
bibliographies from your word processor.
You can also attach an unlimited number of notecards to each of your references. Each notecard
provides ample room for your comments on your reading, or quotations from the original
sources. Notecards are ideal for preparing a dissertation or for summarizing a series of lengthy
works. Notecards can also help you organize your own works in progress.
Papyrus lets you link your references to each other to indicate various kinds of connections;
e.g., that one reference refutes another reference, or that one work is a review of another.
The current version of Papyrus incorporates literally thousands of suggestions from our users
over the past decade. We believe that Papyrus stands alone among bibliographic programs in
its power and ease of use. Nevertheless, we still consider Papyrus a work in progress, and will
always welcome your further recommendations.
This edition of Papyrus, Version 8.0, has been implemented on Macintosh computers running
System 7 or Mac OS 8. A full Windows implementation of Papyrus Version 8 is under development—check our Web site, www.rsd.com, for news. In the meantime Papyrus Version 7 for
DOS continues to be available.
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Welcome to Papyrus!

Full vs.Limited Versions of Papyrus
Papyrus Version 8 is available in two editions: the Full Version and the Limited Version. The
two are identical in all but a few respects.
First, the Full Version allows an essentially unlimited number of entries in your database. The
Limited Version will allow you to enter up to 200 references.
The second difference between the two versions is that the Limited Version is free. You and
your colleagues or students can download a copy from our Web site, www.rsd.com. You may
also make copies of the Limited Version and distribute them to others (provided that you copy
the entire Limited Version without modifications, changes, additions or deletions).
If you use Papyrus to assemble a large collection of references and your colleagues begin clamoring for their own copies of your database—or you think you could entice them to send you
large sums of money for their own copies of your database—then they will also need their own
copies of the Papyrus application in order to make use of your data files. While we do like to
think that all of your colleagues will rush out and purchase their own copies of Papyrus, the
Limited Version can serve as an interim solution. A legal interim solution.
When someone uses the Limited Version to access a database containing more than 200 references, the database will be opened in read-only mode. This means that they can review all the
information already in the database, but they cannot make any changes or additions.
So when you provide copies of your Papyrus database to your colleagues, you can simply
include a copy of the Limited Version of Papyrus along with your database files.
Of course, Research Software Design’s usual unlimited technical support is available
only to those of you who purchase the Full Version of Papyrus.
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We recognize that many of you will need to access your bibliographic database on more than
one computer. Perhaps one at work and another at home, or one on a researcher’s desk and
another on a secretary’s. So rather than restrict the number of computers on which you can use
this copy of Papyrus, we license the program based on the number of distinct Papyrus databases you use, regardless of how many different computers or people are accessing copies of
the same database.
For full details of our license policy, as well as some Site License options, please refer to the
License Agreement section.
We have taken this approach because we feel that you deserve it. But we won’t be able to
continue to offer these services if we go out of business, so please do your share—feel free to
distribute copies of the Limited Version to your friends, but don’t distribute copies of the Full
Version, and please do not use the Full Version yourself unless you are a fully licensed Registered User.
Thank you!
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Our Ridiculously Reasonable License Policy

Overview of the Papyrus Documentation
Different people learn best in different ways, so we have provided you sufficient materials for
more than one approach to learning Papyrus.
There are three main parts to the Papyrus documentation: WORKBOOK, CONCEPTS, and REFERENCE.
The WORKBOOK takes a tutorial, task-oriented approach. One chapter, for example, leads you
step by step through the process of entering references into Papyrus. Another walks you through
the steps of searching your database for a particular set of references and then printing them.
Using Papyrus with your word processor to assemble a bibliography for a manuscript is the
task reviewed in a later chapter.
The CONCEPTS section explains several fundamental ideas that, sooner or later, you need to understand in order to work with Papyrus. Some of these may already be familiar to you from
work with other computer programs, while others are specific to Papyrus.
Finally, the REFERENCE section contains a detailed review of each Papyrus feature.
If you like to jump right into new software, then turn to the WORKBOOK. The first few chapters
will help you master basic Papyrus operations—you can later work through the more advanced
chapters as you need them. When you require more detailed information on a particular feature, the WORKBOOK will refer you to the appropriate chapter of the REFERENCE section. And sooner
or later you should take the time to review the CONCEPTS section to ensure that you are not
missing any important ideas.
On the other hand, maybe you prefer a solid understanding of what this program is going to do
with your valuable information before you start giving it free rein. Then you should start with
CONCEPTS. Afterwards you will probably want to peruse at least the first several chapters of the
REFERENCE section. At that point you should feel quite confident entrusting your data to Papyrus,
understanding exactly how Papyrus will manipulate it. And when you later need to accomplish a particular task for the first time, you can turn to the appropriate chapter of the WORKBOOK.
Of course, there are some people who can only absorb difficult information directly from another human being. Unfortunately, Research Software Design lacks the resources to provide
your with a personal Papyrus tutor. But if you find yourself stymied despite all of our documentation, then please contact us.
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License Agreement—Summary
This Summary of the License Agreement is included for your convenience only, and
does not constitute a part of the License Agreement. For the text of the License Agreement, see below.

We encourage you to share Papyrus with your friends and colleagues. In fact, we give you full
permission to distribute copies of this documentation, in electronic or paper form, and copies
of the Limited version of the Papyrus application. Just be sure to include the entire Limited
application, including all associated files, plus all copyright and trademark notices, as well as
the License Agreement, without any modifications, changes, additions or deletions. The actual
License Agreement explains the details of these arrangements.
Basically, you may distribute copies of the Limited Version to anyone who would like to try it
out. But since we are hoping to make a few bucks here, you may not distribute the Full Version.
Research Software Design will only provide full technical support for those of you who purchase your own Full Version.
Just to be sure that you’re paying attention here:

You may distribute copies of the Limited Version of Papyrus.
You may not distribute copies of the Full Version of Papyrus.
Got it?
Next important point:

Your purchase of a Full Version entitles you to up to four
(4) distinct databases.
Two databases are “distinct“ if they contain independently maintained reference collections.
Allow me to explain.
First, you may keep as many Papyrus databases as you like on a single personal computer’s
hard disk(s) or on its collection of floppy disks, Zip disks, or other media. All of these databases
together constitute a single “distinct” database for our purposes here.
The preceding paragraph does not apply to either a network of computers nor a multiple-user
fileserver or minicomputer. In these situations, each and every Papyrus database is considered
a distinct database.
Second, if you make a copy of your database and bring it to a second computer for your own
use—e.g., you want a copy of the same data on both your work computer and your home computer—the copy does not count as an additional distinct database. Similarly, if a principal
investigator purchases Papyrus, then the same database may be copied to several computers
within the research group, and still be considered only a single distinct database.
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Of course, in these situations we give you permission to copy the Full Version of the
Papyrus application to each of these computers as well.

Note that your entitlement to four distinct databases does not mean that you get one, your
sister gets one, and two of your fellow graduate students each gets one. All four databases
must be used by you or your employees/staff/students.
Most of you will actually have only one “distinct” database, whether it is used by a single
person or by an entire research group—the point in these situations is that each of the computers has a copy of the same data. However, if Papyrus is purchased by, say, a university
department, then each research group in that department will presumably have its own distinct
database. In this case you will probably soon exceed the limit of four distinct databases.

If you plan to have more than four distinct databases, you
must purchase a Site License from us.
A Site License costs $200, in addition to your initial Papyrus purchase price. (Local resellers
may add an additional service charge.) Once you have paid this one-time fee, you may maintain a total of up to twenty (20) distinct databases, provided that all of them are used by the
Registered User or his/her/its employees/staff/students.
If you find your department exceeding 20 distinct databases, you may purchase additional
$200 Site Licenses at any time. Each raises your authorized limit by another 20 distinct databases.
In addition to these Departmental Site Licenses we also offer Institutional Site Licenses for
entire universities or corporations. Contact Research Software Design for details.
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CAREFULLY READ ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT PRIOR TO USING
THESE PROGRAMS. YOUR USE OF THE PROGRAMS OR YOUR REGISTRATION INDICATES YOUR
ACCEPTANCE OF THESE TERMS AND CONDITIONS.
1. LICENSE: You are hereby granted a limited, non-exclusive right to use the enclosed programs (together
known as “PAPYRUS”).
2. REGISTRATION: When you purchase a copy of PAPYRUS and complete the Registration Process, you
become a Registered User. The Registration Process involves your completion of a Registration Form or
Registration Card as provided by RSD, and your return of that completed Registration Form or Registration Card to RSD via postal, electronic, or other means acceptable to RSD.
3. SCOPE OF REGISTRATION: When you complete the Registration Form or Registration Card, you must
indicate the Registered User—either a specified organizational entity (such as a particular research group,
a particular university department, or a particular company), or a specified person. Use of the programs
and related documentation by any individual, as part of that individual’s duties to the specified entity or
person, will be considered to represent use by the Registered User.
4. DISTRIBUTION OF LIMITED VERSION: You may make and distribute copies of the Limited Version of
the enclosed programs, related files, and documentation to other individuals. These individuals will not
themselves be Registered Users, unless they too purchase their own copy of PAPYRUS and complete their
own Registration Process. You must include all copyright notices in any copies you make of the programs
or documentation, and you must make clear to any such individuals that they are bound by all terms of
this Agreement, whether they register or not. Furthermore, the obligations of RSD to Registered Users, as
specified in this Agreement, do not extend to unregistered users of the programs.
When distributing copies of the programs and documentation to other individuals, you may include
any or all of the files provided on your disk(s), tape(s), or other medium, except for the file representing
the Full Version of the PAPYRUS application. COPIES OF THE FULL VERSION OF THE PAPYRUS APPLICATION MAY NOT BE GIVEN TO INDIVIDUALS WHO ARE NOT REGISTERED USERS.
YOU MAY NOT COLLECT ANY PAYMENT FROM SUCH INDIVIDUALS, BEYOND YOUR ACTUAL
COSTS OF MAKING AND DISTRIBUTING THE COPIES.
5. DISTRIBUTION AND USE OF FULL VERSION: Your purchase of the Full Version of PAPYRUS entitles
you to use the enclosed programs to create a maximum of four (4) distinct databases. Two databases are
considered “distinct” if they contain independently maintained collections of data.
Any number of PAPYRUS databases maintained on the hard disk(s), floppy disks, Zip disks, or other
media all used with a SINGLE PERSONAL COMPUTER AND NOT ACCESSIBLE BY OTHER COMPUTERS will be considered to together constitute a SINGLE distinct database.
Any PAPYRUS database accessible via a NETWORK OF COMPUTERS or via a MULTIPLE-USER
FILESERVER will be considered a distinct database.
If a COPY is made of all or part of a database and placed on one or more other computers belonging to
the Registered User, for the sole purpose of accessing the same data at additional locations, these copies
will NOT be considered additional distinct databases. You may copy the Full Version of the PAPYRUS
program to each of these computers as well, provided that use of such copies of the Full Version is restricted to the Registered User as per Section 3 of this Agreement.
In the event of any dispute, RSD will have the sole right to determine how many distinct databases are
in use by a Registered User, provided such determinations are a reasonable interpretation of this provision.
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If you will have more than four distinct databases, you must purchase a Site License and pay an additional Site License Fee. The initial payment of this Fee will raise your authorized maximum number of
distinct databases from four (4) to twenty (20). Subsequent additional payments of the Site License Fee
will raise your authorized maximum number of distinct databases in increments of twenty (20) additional
distinct databases per Site License Fee paid.
6. TRANSFER OF REGISTRATION: You may transfer your Registration to another party if the other party
agrees to the terms and conditions of this Agreement and completes a Registration Card or equivalent
form and returns it to RSD. If you transfer your Registration, you may not keep any copies of the Full
Version of the PAPYRUS application, although you may keep and use copies of the documentation and
the Limited Version program and related files. If you do keep copies of any of the files, you remain bound
by all terms of this Agreement, even though RSD’s obligations to Registered Users no longer extend to
you.
7. COPYRIGHT: The programs and their related documentation are protected by the copyright laws of the
United States and other countries, as well as by international treaties and conventions. You may not make
any modifications, changes, additions or deletions, nor translate the programs nor documentation in any
way, without the prior written consent of RSD. Any preparation or distribution of copies of the programs
or documentation not in accordance with this License Agreement is in violation of both this Agreement
and U.S. and foreign copyright laws.
8. TERM: This license is effective until terminated. You may terminate it by destroying all copies of the
programs and documentation which are in your possession, plus all of your data-files created by these
programs. This license will also terminate if you fail to comply with any term or condition of this Agreement. You agree upon such termination to destroy all copies of the programs and documentation which
are in your possession, plus all of your data-files created by these programs.
9. LIMITED WARRANTY: RSD warrants to Registered Users that the enclosed programs will perform
substantially as indicated in the accompanying documentation. In the event they do not so perform, and
provided you are a Registered User, RSD will have the option of either providing corrections to the programs as per Section 10 of this Agreement, or of accepting return of all materials for a full refund of the
price you paid. You have no other remedy for breech of this warranty.
RSD warrants the disk(s), tape(s), or other medium on which the programs and documentation are
recorded to be free from defects for ninety (90) days from the date of shipping. RSD will replace any
defective disk, tape, or other medium which is returned to RSD within this ninety day period.
THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE THAT IS MADE BY RSD ON THIS RSD PRODUCT. THIS
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS
WHICH VARY FROM STATE TO STATE. NEITHER RSD NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS PROGRAM SHALL BE LIABLE
FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF
THE USE, THE RESULTS OF USE, OR INABILITY TO USE SUCH PRODUCT EVEN IF RSD HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIM. SOME STATES DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.
10. UPDATES, CORRECTIONS AND NEW VERSIONS: A “Maintenance Update” of PAPYRUS is a modified edition of the programs incorporating corrections or minor changes. A “New Version” of PAPYRUS is
a modified or new edition of the programs incorporating significant enhancements. RSD shall make these
designations at its sole discretion, provided that RSD uses the same categorizations for all of its customers.

I10

License Agreement

Maintenance Updates will be offered to all Registered Users free of charge, except for the actual costs of
materials, shipping and handling.
Should New Versions of the programs become available, these will be offered to all Registered Users at
not more than one third (1/3) of the suggested retail price.
11. SUPPORT SERVICES: RSD will respond in a timely fashion to any telephone calls or correspondence—
whether by mail, fax, or electronic mail—from Registered Users regarding difficulties with the programs
or documentation. There will be no fee for such services. RSD reserves the right to change its support
services, institute a charge for support services, or terminate support services at any time.
12. MISC.: This Agreement shall be governed by and construed in accordance with the laws of the State of
Oregon, United States of America. Any disputes under, or arising from, or related to this Agreement shall
be subject to the exclusive jurisdiction and venue of the courts of the State of Oregon, with venue in the
Multnomah County Circuit Court. Alternatively, at the election of RSD, jurisdiction and venue may instead lie with the United States District Court for the District of Oregon (Portland Branch).
13. ACKNOWLEDGMENT: YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT,
UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE
THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR
WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE
SUBJECT MATTER OF THIS AGREEMENT.
Should you have any questions concerning this Agreement, please contact: Research Software Design,
2718 SW Kelly Street, Suite 181, Portland, OR 97201; 503/796-1368; fax 503/241-4260; e-mail: info@rsd.com.
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RSD will announce the availability of Maintenance Updates and New Versions on the RSD Web site
and through any relevant e-mail subscription lists maintained by RSD.

Workbook

WORKBOOK

To sum up all; there are archives at every stage to be looked into,
and rolls, records, documents, and endless genealogies—
In short, there is no end of it.
—Laurence Sterne, Tristram Shandy
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Your First Database
If Papyrus has not yet been installed on your computer, turn to the Installing
Papyrus and Launching Papyrus chapters in the REFERENCES section. After you
have installed and launched Papyrus, return here.
When you launch Papyrus you will be greeted with a dialog looking for your Papyrus database:

Click the New button and the dialog will change to this:

Now type in whatever name you would like to give your database. For example, you might
enter something rather generic, such as My References. Or perhaps you would prefer something a bit more specific, such as Sally’s Dissertation.
Whatever name you use, you can always change it at a later date. So you needn’t be
overly creative at this point!

Now click the Save button.
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Papyrus will create two documents on your disk. The first is your actual database file, which
will have the name you have entered. The second is a corresponding index file—this will automatically be given the same name plus .idx:

Any time you wish to copy your database—to make a back-up copy, for example—be sure to
copy both of these documents.
Actually, should you ever lose your .idx file Papyrus can build a replacement for you.
But for a large database this will be time-consuming.

In the future you can launch Papyrus by double-clicking either of these icons.

Database Info
Now that you have created a fresh database, Papyrus asks you to supply a description:

Should you ever transfer some of your references to or from another Papyrus database, their
original database description will be transferred along with them. Thus you can always tell
from whose database a particular reference originated.
Each reference you enter into Papyrus is assigned a Reference Number. Papyrus allows Reference Numbers of up to 8 million. But if you will be sharing your work with another Papyrus
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As you will see in a moment, the description you enter here will be displayed in your database’s
Status window, so if you work with more than one database you can always tell which one you
currently have open.

user, it will usually be helpful to restrict each database to a different range of Reference Numbers. That way you can exchange references without running into numbering conflicts.
So if you are planning on sharing references among two or more Papyrus databases, you can
now enter a restricted range of allowable numbers for this database.
But as the dialog indicates, Don’t Worry about these issues. You can always come back at a later
date to change the Database Description or the Allowable Reference Numbers.
Once you have entered the Database Info, click the OK button.

Status window
Congratulations—you have now created your first Papyrus database. Papyrus will display your
database’s Status window:

As promised, both your database name and its description are shown. The various numbers
indicate that this is a new, empty database, containing nothing but a few built-in bits of information.
If you click the

button, the Database Info dialog will reappear. Go ahead—try it for yourself.

Additional Databases
Most users of Papyrus maintain only a single database. That way all of the information with
which you work is easily available in a single place.
Even if you work in two different areas of study, if there is any significant amount of overlap
between your two areas you will probably still want to keep all of your references in a single
database. This will obviate the duplication of references, journal names, and other information
between the two databases. It will also prevent the all-too-common phenomenon of realizing
that you’ve just spent the last hour entering fifty references into the wrong database.
On the other hand, you might be well advised to keep your research supervisor’s reprint collection in a database separate from your personal collection of X-Men comic books.
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Papyrus will let you create and maintain as many separate databases as you desire. Each Papyrus
database is represented by its own pair of documents on your disk—the actual database file
itself, plus its associated index file:

Papyrus can only work with one database at a time, so to create a new database you must first
close the currently-open database:

Then you can open a different database or create a new one:

WORKBOOK
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See Also...
You have now learned how to create a fresh Papyrus database. You’ve seen that a Papyrus
database consists of two documents—the actual database file and an associated index file. The
database has a description, and you can set limits on the allowable Reference Numbers if you
will be exchanging references with other Papyrus users.

See also:
CONCEPTS
Indexes
REFERENCE
Installing Papyrus
Launching Papyrus
Status Window
Database Info Dialog
SHORTCUTS
Status Window

W8

Getting Started

Chapter 2

Inputting References, Part 1

Introduction ........................................................ W10
Reference Entry window ................................... W10
An Article ............................................................ W13
A Chapter ........................................................... W16
A Book ................................................................. W18
See Also... ............................................................ W20

WORKBOOK

Chapter 2: Inputting References, Part 1

W9

Introduction
Since Papyrus’s raison d’être is the manipulation of bibliographic references, it would probably
be a good idea for us to begin this workbook by entering some references into the database. In
this chapter I will present three sample references and show you, step by step, how to type
them into Papyrus. In the process you will learn about many aspects of working with Papyrus.
Then in Inputting References, Part 2 we will enter four more references, exploring some more
advanced concepts and techniques. In subsequent chapters we will work with these seven references to explore Papyrus’s other functions.
This section assumes that you are using a freshly-created Papyrus database that does
not yet contain any information. I will also assume that you have not modified any of
Papyrus’s initial Preferences or other settings. But if you are working with a database
into which someone has already entered some references, then you will encounter differences in Papyrus’s behavior from what I describe below. For example, Papyrus will
not number our first entry “1” if there is already a Reference #1.

Here are the first three references we will enter into Papyrus. In the interests of fair play and
equal time I have chosen one fictional example each from biomedicine (hard sciences), psychology (social sciences) and literature (humanities). Regardless of your own field you should work
through all three examples, as I will use each to make different general points.
Runson,SK; Rogerstein,BT (1990): The judicious use of nitrous oxide in the treatment
of Grave’s disease. New Engl. J. Med. 182, 254-267.
Laszlo,JA; Snooks,BB; Old,DH (1991): Unconscious punning among medical researchers. In: Sublimation and Compensation. Vol. 2. (Eds: Jung,CG; Old,DH) Pergamon Press,
New York, 102-129.
LaFièvre,H (1992): Why Nothing is Funny: A Deconstructionist Analysis. 2nd ed. Harvard
University Press, Cambridge.

Note that all three references are shown in the Papyrus STANDARD format. This format probably presents the parts of the reference in a different order than you are accustomed to, and
with different punctuation marks. We will discuss formats in subsequent chapters, so just bear
with me for now.

The Reference Entry window
To enter references into Papyrus, begin by launching Papyrus and opening your database. You
should see the Status window:
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Now from the Reference menu pick New. A Reference Entry window will appear:

Before you take any actions, let me explain a few of this window’s components. (We’ll get to the
rest as we need them.)

This pop-up menu allows you to choose the reference type. As you can see, for
a fresh Papyrus database the default setting is Article in journal. Feel free to
click the menu to see Papyrus’s other predefined reference types—but make
sure you leave the setting at Article in journal before proceeding.

WORKBOOK

Papyrus displays a dynamic preview of the current reference. At the moment
this looks a bit odd, since we haven’t yet entered any information. But as we
proceed you will see this preview flesh itself out.
Clicking this button brings up the online help for this window, using your
Web browser.
Clicking this help button brings up the corresponding page in the REFERENCE section.
Holding down the Option key while clicking the help button takes you instead to the
corresponding SHORTCUTS page.
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Clicking this button brings up some information about the current reference—
when it was created, when it was last modified, whether it was entered by
hand or imported from some other source, etc. Try clicking the information
button now.
Most Papyrus windows include balloon help. Clicking this button turns balloon help on or off.
When balloon help is on, the button so indicates:

.

Balloon help is an excellent way to quickly learn or recall what a specific window item is for. Try it now—click the balloon button to turn on balloon help,
and then point at various parts of the window. When you’re done, click the
button again to turn off balloon help.
If you are playing along here, you will have discovered that the balloon button’s
own balloon describes another feature:

So give this a try, too. Double-click the balloon button and sit back to watch a
sequential display of all the help balloons for this window. This is a great way
to learn about the window, including things you would not otherwise have
thought to click.
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An Article
So let us enter our first reference:
Runson,SK; Rogerstein,BT (1990): The judicious use of nitrous oxide in the treatment
of Grave’s disease. New Engl. J. Med. 182, 254-267.

This one really is a journal article, so Papyrus’s default reference type of Article in journal is
correct. Papyrus has also suggested that this reference be given a Reference # of 1, which seems
reasonable.
The caret is blinking in the Author #1 field, waiting for you to enter the first author. So go ahead
and type Runson,SK, and then press Tab or Return. This is the standard way of entering names
into Papyrus: surname,initials. If you wish you can enter full first names rather than just the
initials.
You must enter the name with the surname first, then a comma, and then the first names or
initials. There is no need to type any periods or spaces. In fact, if you do include extraneous
punctuation Papyrus will remove it for you, as we shall see presently.
The Reference Entry Window chapter of the REFERENCE section describes further rules
for entering names, as well as some useful shortcuts.

When you pressed Tab or Return a new line will have appeared for Author #2. So let us enter
our second author. Just to be interesting, type her name like this: Rogerstein, B. T.—complete
with spaces and periods—and then press Tab. As promised, Papyrus automatically converts
your entry into its standard form.
Fear not! When later you need to output a bibliography you will be able to tell Papyrus to
display the author’s names in whatever form you need at the time. Because Papyrus
always stores names in the compact way shown here, it is a simple matter for the program to add periods and/or spaces, or to put the initials in front of the surname, when
outputting a list of references.

For the Year we must enter 1990. Papyrus assumes that most references you enter will be from
the current (or nearby) century, though, so it suffices to type just 90. Try it now, then press Tab.
Of course Papyrus will correctly handle 2-digit year entries as we enter the 21st century.
It pains me that you would think otherwise for even a moment!

Now we must provide the Title. So type this (without pressing the Return key): The judicious
use of nitrous oxide in the treatment of Grave’s disease. The period at the end of the title need
not be entered.
As you see, when you reach the end of a line Papyrus will automatically “wrap” your text onto
the next line. As with a word processor, you do not press the Return key at the end of each line,
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There are only two authors for this reference, so we will leave Author #3 blank. Just press Tab.

but only at the end of the whole field. So now press Return or Tab to move on to the Journal
field.
This reference is from New Engl. J. Med., which stands for the New England Journal of Medicine. Type New Engl. J. Med. (including the periods this time) and press Return.
Because no journals have yet been entered into your database, Papyrus does not recognize this
abbreviation. So up pops this dialog:

Here we are being asked to provide both the full name of the journal and its official abbreviation. The abbreviation we entered has already been filled in for us, so we need only type New
England Journal of Medicine in the Full Journal Name box. Go ahead and do that.
In addition to the full name and standard abbreviation for this journal, if we wished we
could enter several other pieces of information. Some of these might come in handy in
the future when looking for a particular issue of the journal in your library or on the World
Wide Web.
Since I don’t have any of this information handy right now, we’ll leave these fields empty.
You can always edit this journal entry in the future should you wish to provide the Call
Number, URL, etc.
We are also offered three checkboxes regarding extra data that are to be routinely
included in any citation to this journal. For the New England Journal of Medicine each
of these should be left unchecked. When a reference cites this journal there is no need
to indicate the issue number or the exact date, because the volume and page numbers
by themselves are sufficient to identify which 1990 issue we need. There are other
journals, though, that start each issue’s page numbers over again with Page 1; for those
journals a bibliographic citation needs to include either the issue number or the day and
month so that the reader can find the appropriate issue in the library. For a further
discussion of these concerns, you will want to read the Journals chapter in the CONCEPTS
section.
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Click the Done button. The New Journal dialog will disappear, and we’ll be back to our Reference
Entry window.
Now enter 182 for the Volume, and 254-267 for Page(s):

We have now finished entering the data for our first reference. We have no abstract, comments,
or keywords to provide, so we will leave those fields blank. Our final task is to save our work.
So go to the Reference menu and choose Save. Papyrus will save this reference, adding it to
your database. The Status window will update itself accordingly:
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If we had no more references to enter you would now close the Reference Entry window. But
since we still have two more to go, click the window’s
button. Clicking this button means
“Take me to the next reference in the database”—since you are already at the final reference,
Papyrus will ready itself to accept a new entry.

A Chapter
Now let’s enter the second of our three references:
Laszlo,JA; Snooks,BB; Old,DH (1991): Unconscious punning among medical researchers. In: Sublimation and Compensation. Vol. 2. (Eds: Jung,CG; Old,DH) Pergamon Press,
New York, 102-129.

This one is a chapter from a book, so we need to switch the reference type from Article in journal
to Chapter in book. Click the pop-up menu and change its setting accordingly.
Note that the field names in the left column have changed to reflect those needed for a chapter.
Go ahead and fill them in as follows, pressing Tab after typing in each field. Stop after you enter
the first Editor.

Note the difference in the way I have capitalized the chapter title compared to the book
title. In the sciences one capitalizes only the first word of an article or chapter title, but
for a book title you capitalize all major words. In the humanities, on the other hand,
everything gets capitalized as if it were a book title—though there is some controversy
about which words are too minor to capitalize. For more details see Bibliographic Conventions in the CONCEPTS section.

You’ll note that the book’s second editor, Old,DH, is the same as the third of the chapter’s authors. Although it would be easy enough to simply retype his name, I would like to take this
opportunity to demonstrate a couple of things.
We could go up to the Author #3 field and copy the name there, and then return to the Editor #2
field and paste in the name. But let’s be more modern and use drag & drop instead.
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Either way, we need to select the contents of the Author #3 field. You can get there using either
your keyboard or your mouse. With the keyboard, you can move up to the desired field by
repeatedly pressing either Shift-Tab or the key. With your mouse, clicking anywhere in the
contents of the field, Old,DH, will put the blinking caret there. Clicking the field name, Author #3,
will select the entire contents of the field—which is what we want to do now.
So, one way or another, select the contents of the Author #3 field:

Now click anywhere in the selected field and drag it to the Editor #2 field:

When you release the mouse button, Old,DH will appear as Editor #2.

WORKBOOK

For each Editor field Papyrus will offer a corresponding Role of “Editor” field:

In a typical Chapter reference the Book’s editors are indeed simply editors. But for more interesting citations you can select whichever roles actually apply for each person.
You might wish to experiment with these checkboxes now, watching how the reference preview changes each time. When you’re done playing, return to checking only Editor for each
role.
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As you fill in the remaining fields, notice that Papyrus will allow you to enter more than one
Publisher and City of Publication for those books published by more than one company, or by a
single publishing company that lists more than one city:

After you have entered the page numbers, click to tell Papyrus to move on to the next reference. Since we have not yet saved this reference, Papyrus will ask us if we wish to do so now:

Click the Save button, and then we’ll enter our final sample reference.

A Book
Here is our final reference:
LaFièvre,H (1992): Why Nothing is Funny: A Deconstructionist Analysis. 2nd ed. Harvard
University Press, Cambridge.

This one is an entire book, so switch the reference type from Article in journal to Book/Monograph.
There is something interesting about this author’s name: it contains a letter— è—that is not
available on United States keyboards. Now if you are using a non-U.S. keyboard that does
include this letter, you can simply type it as any other letter. But the rest of us must do something special.
Actually, what I’m about to describe is the standard Macintosh way of entering accented
letters. Unfortunately, many Mac users are unaware of it.
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Type the first four letters of the author’s name, LaFi. Now hold down your Option key and
press the grave accent key (`) which on U.S. keyboards is located in the upper-left of the keyboard, right above Tab. Now release Option and press the e key. Voilà!
For other built-in accents, including these: é, î, ü, and ñ check the documentation that
came with your Macintosh. You can also use Key Caps (from your Apple menu)—press
Option and watch the Key Caps display carefully.

Now go ahead and complete this reference:

Those “Authors” role checkboxes are there because for some books, the “authors” are actually
editors, compilers, translators or commentators. For example: Diem,K; Lentner,C (eds.) (1970):
Scientific Tables. CIBA-GEIGY, Basle, Switzerland.
We’re done with this reference, so go ahead and save it.

WORKBOOK
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See Also...
If you have followed along for this entire chapter, you are now well on your way toward mastering Papyrus! You have learned how to work with Papyrus’s Reference Entry window. You
have used three different reference types and learned Papyrus’s conventions for entering author
names and journal abbreviations. Finally, you have dealt with accented letters and Papyrus’s
drag & drop facilities.
To continue your exploration of entering references into Papyrus, proceed to the next chapter.

See also:
CONCEPTS
Output Formats
Bibliographic Conventions
Reference Types and Fields
Journals
REFERENCE
Papyrus Conventions
Reference Types and Their Fields
Reference Entry Window
Journals Window
SHORTCUTS
Reference Entry Window
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Introduction
In the last chapter we entered three different types of reference into Papyrus. This time we will
work with four similar references, so that you can learn some of the shortcuts Papyrus provides
during reference entry.
Here are the references:
Ramasubramanian,SR; Martin,S (1979): Eclectic neurosurgery, Part I: Excision of inhibitions. JAMA 280, 324-330.
Ramasubramanian,SR; Mull,M (1979): Eclectic neurosurgery, Part II: Implantation of
healthy attitudes. JAMA 280, 331-338.
Ramasubramanian,SR (1992): Eclectic neurosurgery. In: Work Once, Publish Forever.
(Ed: Perish,N) (Career Maintenance Series, Part 27) Academic Press, Chicago, 201240.
Rogerstein,BT (1992): Nitrous oxide toxicity. In: Work Once, Publish Forever. (Ed:
Perish,N) (Career Maintenance Series, Part 27) Academic Press, Chicago, 135-152.

As you can see, two of these are articles from the same issue of the same journal, and the other
two are chapters from the same book. One author appears three times, and one hard-to-spell
phrase—Eclectic neurosurgery—keeps coming up. You will often encounter such repetitions
when working with bibliographic citations.
Let’s begin entering the first of these references. If you arrived here directly from the previous
chapter of the Workbook, then Papyrus will be poised for your entry. Otherwise launch Papyrus
now and choose New from the Reference menu.

Reference #4
The first new reference:
Ramasubramanian,SR; Martin,S (1979): Eclectic neurosurgery, Part I: Excision of inhibitions. JAMA 280, 324-330.

is indeed a journal article, so we need not change Papyrus’s suggested reference type.
Go ahead and enter the two authors and the year. Move to the Title field, but before you start
typing in the title let’s do something that will make the rest of our work easier.
From the Windows menu choose Glossary. This will open the Glossary window:
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The Glossary is a collection of words and phrases that you expect to use frequently. Putting a
phrase into the Glossary allows you to avoid typing it over and over in the future.
So let us add our repeated phrase to the Glossary. Click the New button and then type in Eclectic neurosurgery:

If we wished to add additional words or phrases to the Glossary we would next click the New
button. But for now this is our only Glossary entry, so click Done.
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As in most Papyrus dialog boxes, you can leave your hands on your keyboard here.
Pressing the letter N, C or D is a shortcut for clicking the New, Cancel or Done buttons.
Of course, as in any Macintosh dialog, pressing Esc or
-. is equivalent to clicking
Cancel, and pressing Return or Enter is a shortcut for clicking the darkly-outlined default
button.

Our phrase now appears in your database’s Glossary:
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We can now put the Glossary to good use. Click the Select button (or press Return or Enter).
As you see, clicking Select does two things. First, it pastes the currently-selected Glossary entry
into the current field of the Reference Entry window. Second, it brings the Reference Entry
window forward as the active window.
Now type the rest of the title.

This reference’s journal, JAMA, has the full name Journal of the American Medical Association.
Type JAMA in the Journal field, and press Tab or Return. Note that since this official abbreviation is unusual in its lack of periods, Papyrus mistakenly guesses that it is supposed to be the
full journal name, rather than the abbreviation. Fix this now, remembering to use Tab to move
from field to field, and Enter to dismiss the dialog box when all is correct:
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In its compulsion to keep your database free of all error, Papyrus asks you to confirm the unusual nature of this official abbreviation:

Click Yes and then finish entering the reference:
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Now save this reference and prepare to enter the next one
You already know that you can accomplish this by clicking the window’s
button.
Another way to do exactly the same thing is to press your keyboard’s Enter key. (Note:
not the Return key.)

Reference #5
Now let’s enter the next reference:
Ramasubramanian,SR; Mull,M (1979): Eclectic neurosurgery, Part II: Implantation of
healthy attitudes. JAMA 280, 331-338.

Rather than typing in Ramasubramanian,SR again, go to the Edit menu and pick Look up
Author.
Note the shortcut for this menu item, -L. This key combination is going to be one of
your good friends when using Papyrus.

This brings up the Names window:

Here we find all of the authors and editors who have so far been entered into your database.
The number after each name indicates how many references include that name as an author or
editor.
There are a few different ways for you to select a name in this window. Of course, you can
simply click on one of the names with your mouse. You can also use your ↑ and ↓ keys to move
about in the list. Finally, you can type the first few letters of the desired name.
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Using any of these methods, now select Ramasubramanian,SR, and then click Select. As with
the Glossary window, this will paste the selected name into the current Reference Entry window
and also bring that window to the fore.
Now go ahead and enter the second author (Mull,M) and the year (1979).
When you get to Title, use the Glossary to paste in the starting phrase. You can bring up the
Glossary window from the Windows menu, or you can go to the Edit menu and choose Look
up in Glossary.
Note that -L is still the shortcut for this version of “Look up”. In general, the “Look
up...” menu item changes to reflect whatever is appropriate for the current field, whether
that is the Glossary, the Names window, the Journal window or the Keywords window.

After selecting Eclectic neurosurgery from the Glossary window, type in the remainder of the
title.
For Journal type jama (no need to capitalize) and then press Tab. Papyrus looks through its
Journal Dictionary for any entry that could conceivably be abbreviated “jama”. Since there is
only one such entry, Papyrus automatically picks that one and replaces your jama with the
official name.
We could have instead used -L to pick an entry from the Journals window.

Now complete this reference and save it.
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Reference #6
Let us now proceed to the first of our two chapters:
Ramasubramanian,SR (1992): Eclectic neurosurgery. In: Work Once, Publish Forever.
(Ed: Perish,N) (Career Maintenance Series, Part 27) Academic Press, Chicago, 201240.

Begin by changing the Reference Type pop-up menu to Chapter in book.
Once again you can use -L
␣ to avoid typing Ramasubramanian,SR, and the chapter title can
be plucked in its entirety from the Glossary. Continue with the book title and editor:

Now where are we going to put Career Maintenance Series, Part 27? First of all, we need to
figure out what this information represents. In Papyrus terminology, Career Maintenance Series
is a Series Title, and Part 27 is the Place in Series.
But these two fields do not appear anywhere in the Reference Entry window. That is because
they are currently hidden. Papyrus actually provides places in each reference type for many
pieces of information that you will not need routinely. But rather than clutter up your windows
with a lot of irrelevancies, Papyrus keeps these hidden until you need them.
To expose all the hidden fields, click the Show hidden fields checkbox. Now you will find Series
Title and Place in Series, as well as many other new fields.
So proceed to Series Title and type Career Maintenance Series. Then enter Part 27 for Place in
Series.
We do not need to use any other of the hidden fields, so uncheck the Show hidden fields checkbox.
This will remove the hidden fields from your window—except for the two for which you have
provided responses.
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Papyrus allows you to decide which fields will be hidden. You may change the default
settings via the Database Settings... choice from the File menu. This is useful, for
example, if you wish to assign every book a Catalog Number, or provide a Location for
all references.

Completing this reference is now easy:

Now save this reference—this time choose Save from the File menu, so that the current reference remains in the window after saving.
Rather than re-use this Reference Entry window for our next entry, leave this window as it is
and pick New from the Reference menu to open a second Reference Entry window.

Reference #7
WORKBOOK

One more to go:
Rogerstein,BT (1992): Nitrous oxide toxicity. In: Work Once, Publish Forever. (Ed:
Perish,N) (Career Maintenance Series, Part 27) Academic Press, Chicago, 135-152.

This one is a different chapter from the same book as our last entry. So in the new Reference
Entry window you have just opened, begin by switching the Reference Type pop-up menu to
Chapter in book. Then enter the chapter author, year, and chapter title:
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Now, with the blinking insertion point in the Book Title field, go to the Edit menu and choose
Duplicate This Field from Reference #6. Papyrus obligingly pastes in the value from the same
field in the other Reference Entry window. This can be a great time-saver when you have to
enter a series of similar references.
Press Tab to accept the inserted book title and proceed to the next field.
The next shortcut is an even greater time-saver when two references are extremely similar. Try
it now: choose Duplicate Remaining Fields from Reference #6. Papyrus copies all remaining
fields from the other reference (including the hidden fields). At this point you need only correct
the page numbers and save the reference.
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By the way, you have no doubt been wondering why some field names—such as Author #1,
Year and Page(s)—appear in your window in a different text style than others—such as Edition
and Series Title. Papyrus considers the former fields to be required; a reference lacking one of
the required fields is considered incomplete. If you try to save an incomplete reference Papyrus
will first ask you to confirm that it is indeed supposed to be incomplete, and not simply suffering from an oversight on your part. For example, if a journal article is still in press you will not
be able to supply the volume and pages, so for the moment the reference really is “incomplete.”
As with hidden fields, you can use Database Settings... to specify which fields will be
required. You might wish to make fields such as Accession # required, for example, if
they are important for your internal use.
You can also choose the text styles used for the field names of required and non-required
fields, via the Preferences... button in the Reference Entry window.

Once you have saved this reference, close both of the Reference Entry windows.
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See Also...
In this and the previous chapter you have learned almost everything there is to know about
entering references into Papyrus. We have now discussed the Glossary, the -L “Look up”
shortcut, hidden and required fields, and copying information from a previously-entered
reference.
The next chapter will complete our discussion of entering reference information into Papyrus.

See also:
CONCEPTS
Bibliographic Conventions
Reference Types and Fields
Journals
Incomplete References
REFERENCE
Papyrus Conventions
Reference Types and Their Fields
Reference Entry Window
Glossary Window
Database Settings
SHORTCUTS
Reference Entry Window
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Introduction
In the previous two chapters you learned how to enter references into Papyrus. In this chapter
I will show you how to make changes to references that have already been entered, and how to
permanently delete a reference from your database. We will also discuss the use of keywords,
character formatting, and a few other tricks and shortcuts.
To begin, recall one of the articles we entered in the previous chapter:
Ramasubramanian,SR; Mull,M (1979): Eclectic neurosurgery, Part II: Implantation of
healthy attitudes. JAMA 280, 331-338.

It has just come to my attention that the page numbers we entered were incorrect. The correct
pages are 331-348. In order to fix this mistake we must tell Papyrus that we wish to edit this
particular reference.
Go to the Windows menu and choose All References. The All References window will appear:

As you can see, this window displays all of the references in your database. We can see that the
reference we need to edit is #5. Using your mouse or your ↑ and ↓ keys, select this reference:
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Now choose Edit from the Reference menu. A Reference Entry window will open for the
selected reference:

You could now save the modified reference. But before you do, let us add a few keywords to
this reference.
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All you need do now is move to the Page(s) field with your mouse or arrow keys, and change
338 to 348. So please go ahead and do just that.

Keywords, Part 1
You may add keywords to any or all of your references. While Papyrus does let you search for
references based on words appearing in the title, abstract or comments fields, you will probably want to devise your own personal set of keywords as well. With these you can readily
classify references into categories you find relevant and helpful.
The Keywords chapter in the CONCEPTS section includes suggestions on designing your keyword
system. It also discusses Papyrus’s distinction between major and minor keywords.
For now we will start by adding a few simple keywords to the reference on your screen.
Move to the Keyword #1 line. (You can get there in a hurry by pressing ␣ End.) Type Neurosurgery, and press Tab or Return. Not recognizing this as an existing keyword, Papyrus responds:

This is indeed a new keyword (as opposed to a misspelling of an existing one) so click Create to
add Neurosurgery to your Keyword Dictionary.
You can now enter another keyword on the next line. Type in Attitudes, and then Surgery as the
third keyword:

Now save the reference and close the Reference Entry window.
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Keywords, Part 2
Let us add some keywords to another of our entries:
Rogerstein,BT (1992): Nitrous oxide toxicity. In: Work Once, Publish Forever. (Ed:
Perish,N) (Career Maintenance Series, Part 27) Academic Press, Chicago, 135-152.

This is reference #6. Select it in the All References window and choose Edit from the Reference
menu.
As a shortcut, you can hold down your Option key and double-click the reference.

We are going to add these three keywords to reference #6:
Neurosurgery
Surgery
Review Article

In doing so, I’ll show you a few new things about keywords.
Go to the Keyword #1 field and type just the letter n. Now choose Look up Keyword from the
Edit menu (or press -L
␣). Since Papyr us currently knows of only a single keyword that
starts with this letter, it will automatically replace your n with Neurosurgery.
Press Tab or Return to open up a second Keyword field.
Now go to the Windows menu and pick Keywords. This will bring up the Keywords window:
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Here we see all of the keywords currently in your Keyword Dictionary. Let’s add a couple
more.
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Click the New button. A New Keyword window will open. Type in Review Article:

Note that a “keyword” can be a phrase, and not just a single word.

If we only had this one keyword to enter you’d now click Done. But we have one more keyword to add to the dictionary, so instead click New. Then type in this second keyword:

As Papyrus observes that we are in a keyword-entering mood, it switches the default
button from Done to New. So if you had a long list of keywords to enter, you could
simply press Return or Enter after each one to proceed to the next.

Click Done. Now you’ll be faced again with the Keywords window. The newest entry, Success, is already selected. Add Review Article to the selection by holding down your Shift key
and clicking Review Article:

Now click Select. By this time you should be able to predict what will occur.
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That’s enough for now about keywords. But don’t close this Reference Entry window just yet...

Styles and Fonts
While we’re editing this reference, let’s add something to its Comments field. Move to that field
and type this:
This chapter summarizes the author’s work on psychic surgery over the past twenty
years. Although he gravely discusses a small number of animal studies, the bulk of the
work presented deals directly with Homo sapiens.

Note again that Papyrus takes care of “wrapping” the text to a new line when necessary; you do
not press Return until the entire field has been entered.
While you’re typing, you might want to experiment with a few keyboard shortcuts (all of which
follow standard Macintosh conventions):
The arrow keys (↑, ↓, ←, →) do what you’d expect.
If you hold down Option while pressing ← or →, the insertion point will move
one word at a time.
Holding down 
␣ and pr essing ← or → will move you to either end of the
current line.
Holding down Shift while using the arrow keys (with or without Option or

␣ ) will select text.
The taxonomists amongst you will object to seeing Homo sapiens not italicized. Papyrus takes
the standard Macintosh approach to this: select these two words with your mouse or arrow
keys, and then choose Italic from the Style menu.

The small caps style doesn’t come up too often—it is mainly used when creating output
formats.
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As you can see, in addition to the usual bold, italic and underline, Papyrus also offers superscript, subscript and small caps. So you can easily type things such as 3H2O.

IMPORTANT NOTE REGARDING FONTS
You will seldom use the Font menu while entering a reference. Nearly always you
should leave this set to BASE FONT. Any text entered in BASE FONT can later be output
in whatever font you desire for that particular bibliography. But text entered in any
font other than BASE FONT will stay in precisely that font whenever the reference is
later printed or exported.
If you would prefer to work in a different font in your Reference Entry windows, click the
window’s Preferences... button. You can change the font and character styles used for
field names and for the values of fields.

One situation where you will need to change the font is when you need to use the Symbol font.
You can accomplish this via the Font menu, but Papyrus also provides a shortcut.
From the Edit menu choose Paste Symbol. Papyrus will present you with this dialog:

Use your arrow keys or mouse to pick a symbol—it will be pasted at your current insertion
point in the Reference Entry window.
Go ahead and experiment with styles, fonts and symbols. Make sure to clean up after yourself,
and then we’ll continue to work with this reference just a bit more.
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Collapse fields
Before you save your changes to reference #6, let me show you one last thing. Click the Collapse
Fields checkbox. Now if Comments is the active field, this action will have no visible effect. If
so, then move to another field and watch what happens to your Comments.
“Collapsing” fields means that apart from the currently-active field, all field values will be
reduced to their first lines only. As you move into a field, though, it immediately expands to
reveal its full self. If your references typically include lengthy titles, full abstracts and long
comments, then checking Collapse fields may make your window easier to read and navigate.
It is entirely up to you whether you ever invoke this feature.
Note that Collapse fields is independent of Show hidden fields.

For now, uncheck Collapse fields. Then save this reference and close its window.

Deleting a reference
In the Introduction to this chapter I promised to show you how to permanently remove a reference from your database. So let’s trash the Rogerstein citation we created in our previous
Workbook chapter.
You should still have the All References window open on your screen. If necessary, open it now
and bring it to the front of any other windows.
Select the Rogerstein reference, #7:
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Before we consign this work to the dustbin of intellectual history, let us give it one last perusal.
While we could examine the reference by opening it in a Reference Entry window, there is a
quicker way to examine a reference without making any changes to it. Namely, we can switch
the All References window from showing us this table of all the references to instead displaying
just a single reference:

Go ahead and click Individual items and observe the results:

If you wished to examine other nearby references, you could use your ↑ and ↓ keys, or (equivalently) click the
buttons at the top of the window.
When you’re done exploring these new abilities, return to reference #7. You can be in either the
Table or the Individual items view for what we’re about to do.
From the Reference menu, pick Delete. Because this is such a serious and irrevocable action,
Papyrus will ask you to confirm that you really do intend to permanently remove this reference
from your database:

I don’t know about you, but I feel no great attachment to Rogerstein’s efforts. Go ahead and
click Delete.
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See Also...
You have now mastered virtually all of the techniques needed to enter references into Papyrus,
correct mistakes, make emendations, and remove extraneous citations. You have also been introduced to keywords, and learned about using character styles and fonts.
But don’t be too proud of yourself just yet. There are plenty of fine points and shortcuts
lurking in the Reference Entry and All References windows. Sooner or later you will
want to review the REFERENCE and SHORTCUTS chapters indicated below.

Subsequent chapters will address various ways of making use of all this bibliographic information you have typed in.

See also:
CONCEPTS
Reference Types and Fields
Keywords
REFERENCE
Papyrus Conventions
Reference Types and Their Fields
Reference Entry Window
All References Window
Glossary Window
Database Settings
WORKBOOK

SHORTCUTS
Reference Entry Window
All References Window
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Introduction
One of the prime uses of Papyrus is to produce lists of references, including bibliographies for
your manuscripts. In this chapter I will show you how to tell Papyrus to send some or all of
your references to your printer or to your word processor.
In later WORKBOOK chapters we will build upon the lessons you learn here.
The exercises in this chapter assume that your database contains the references entered in the preceding chapters on Inputting and Modifying
References. If you have not entered those references, or if your database includes additional references, then some of the following exercises will yield
results different from those shown.

The Print/Export Dialog
To begin, let’s tell Papyrus which references we wish to output. Go to the Windows menu and
choose All References. When the All References window opens, select the first three references:

Now from the File menu pick Print/Export.... This dialog will appear:
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Let’s review your options here. (Except for that Include linked items checkbox, which I’ll save
for a future chapter.)

Here you indicate whether you wish to export all of your database’s references,
or only the ones you have selected in the All References window. For our present
purposes the latter will suffice, so click Selected items only.
As you will learn in a later chapter, a Group is a collection of references from your
database. The All References window is just a special Group window, namely the Group
of all references from your database. So in this case, “All items in Group” is equivalent
to “All items in your database.”

WORKBOOK

In Papyrus terminology, a format is a particular style of displaying a reference.
It tells Papyrus whether to put the authors’ initials before or after their surnames, whether the title comes immediately after the authors or whether the
year intervenes, whether to use a full journal name or just its abbreviation,
what punctuation should appear between the journal volume and the page
numbers, etc., etc.
Formats are identified by a descriptive name. For example:
STANDARD
APA
CHICAGO A

The built-in format that Papyrus uses routinely, and the one
I’ve been using so far in this Workbook.
The somewhat perverse style defined by the American Psychological Association.
One of the styles defined in the Chicago Manual of Style.
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VANCOUVER Used by a large number of biomedical journals ever since their
editors got together in Vancouver, British Columbia in 1978.
At the moment, your freshly-created Papyrus database knows only three formats: STANDARD, COMPACT and BRIEF. In the next chapter of this Workbook
I will show you how to access the multitude of predefined formats that we
have provided with your copy of Papyrus. And in a later chapter I will show
you how to create your own output formats. For our present purposes, though,
we shall stick to STANDARD.
All of the formats I’ve just mentioned are output formats. Papyrus also uses formats
when it imports references from other computer files—those formats are called import
formats. And there is a variant type of output format that displays references in neat
columns—we call these tabular formats. In fact, and as you have already seen in the
All References window, the built-in BRIEF format is a tabular one.

Some output formats, such as STANDARD, include each reference’s keywords,
comments and abstract along with the usual authors, title and so on. Depending on the use to which you are going to put this current reference list, you may
or may not wish to clutter it up with all of this extra information. If you tell
Papyrus to truncate any of these fields, then only the first line or so of that field
will appear on the list.
For example, here is our Reference #6 with nothing truncated:
6. Ramasubramanian,SR (1992): Eclectic neurosurgery. In: Work Once, Publish Forever. (Perish,N, ed.) (Career Maintenance Series, Part 27.) Academic Press, Chicago,
201-240.
<<This chapter summarizes the author’s work on psychic surgery over the past twenty
years. Although he gravely discusses a small number of animal studies, the bulk of the
work presented deals directly with Homo sapiens>>
[Neurosurgery; Review Article; Success]

Here is the same reference with truncation:
6. Ramasubramanian,SR (1992): Eclectic neurosurgery. In: Work Once, Publish Forever. (Perish,N, ed.) (Career Maintenance Series, Part 27.) Academic Press, Chicago,
201-240.
<<This chapter summarizes the author’s work on psychic surgery over the ...>>
[Neurosurgery; Review Article; Success]

For the current exercise you can leave all of the truncation checkboxes unchecked.
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Papyrus offers you even more flexibility than you see here—some of these four
choices provide further sub-choices. In the rest of this chapter we will examine
each of these choices in turn.
For now, stick with printer.
If there is no printer attached to your computer, then please just bear with the rest of us
for a little while.

Clicking this button lets you specify the overall layout of your reference list.
This includes such parameters as margins, title, font, font size, headers and
footers.
We’ll explore these settings in just a moment.

If we wished to use a format other than STANDARD for this reference list, we
would click this button to bring up a list of all output formats known to your
Papyrus database.
As discussed above, we’ll save this button for future chapters.
Now go ahead and click the Okay button. Your usual Macintosh printer dialog will appear, and
then Papyrus will print out your three selected references.

Now that you’ve printed your first list of Papyrus references, let’s explore some of the other
options that we passed by a moment ago.
Once again, choose Print/Export... from the File menu. When the Print/Export dialog opens,
click its Layout... button. This will produce:
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The Layout dialog

I think you’ll find most of this self-explanatory. Why don’t you try making some changes and
then proceed with printing, and see if Papyrus does what you expected? Go ahead—I’ll wait
here while you try a few experiments.
Back again? Did everything work as you expected?
I’d like to comment on just a few aspects of this Layout dialog.
As I hope you recalled from the previous chapter, you will usually enter your reference data
using what Papyrus calls BASE FONT. The Layout dialog is where you ultimately indicate
what actual font (and font size) to substitute for BASE FONT when outputting a particular list
of references.
The Header and Footer sections bear some explanation. For each of these there are three boxes.
What you type in the leftmost box will be left-justified in the header or footer of each printed
page. What you type in the middle box will be centered, and what you type in the rightmost
box will be right-justified.
For example, suppose you wished every page to have a footer like this:
Kangaroo courtship paper

- 2-

Draft of Fri, Sep 24, 1999

Then you would fill in the Footer section of the Layout dialog as follows:
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For the current date or time, or the page number, click the appropriate button to insert it into the
Footer boxes.
You can set the Starting page number when you print a bibliography for an already-printed
manuscript, so that the page numbers match up correctly.
The Single item per page checkbox comes in handy if you’d like to print your references onto
file cards.

Sending output to your word processor
Although Papyrus makes it easy for you send your reference lists directly to your printer, in
many cases you will instead wish to send them to your word processor, where you can add the
references to a manuscript or maybe do some typographical fine-tuning.
To accomplish this, in the Layout dialog you should click the appropriate radio button:

Papyrus will create either a MacWrite or an RTF document, ready to be opened by your particular word processor. Every Macintosh word processor can work with at least one of these file
formats.
Papyrus also needs you to tell it what word processor you use. Click the
button and then point Papyrus to your particular word processor application.

Why don’t you give this a try now? Here are the appropriate settings for a few of the more
popular word processors:
Microsoft Word
WordPerfect
Nisus Writer
AppleWorks
(a.k.a. ClarisWorks)

RTF
MacWrite
RTF
RTF
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Papyrus will set the “creator” of your new MacWrite or RTF document to this word processor. Should you double-click the document icon, the Finder will then know what
application is supposed to open the document.

Go ahead and send your list of references to a word processor document. When Papyrus has
finished doing that, go to your word processor and open the document to confirm that Papyrus
has done its job correctly.

Using AppleScript
Papyrus does also offer a more modern approach to interacting with your word processor:

AppleScript is the Macintosh’s very cool approach to integrating all of your applications and
system components, allowing them to pass information back and forth in completely flexible
ways. For example, Papyrus can use the Apple-defined “word processor suite” of AppleScript
commands to communicate with any properly designed word processor.
Which really would be cool. If there were any properly designed word processors.
Unfortunately, rather than follow Apple’s definition of AppleScript commands appropriate to
word processors, each manufacturer has instead created its own idiosyncratic AppleScript interface. So rather than a single generic set of word processor commands, Papyrus must use an
entirely different set of AppleScript instructions for each different word processor.
Guess which manufacturer has the most feeble AppleScript implementation. Did you
guess Microsoft? If so, guess again. Of the major word processors, it is AppleWorks
(formerly ClarisWorks) that makes the least effort to provide a minimal AppleScript
interface. That’s the word processor made by... Apple.
Discussions of product follow-through and market share are left as an exercise for the
reader.

Papyrus does have AppleScripts built in for Microsoft Word (Version 6.0 or newer) and Nisus
Writer (Version 5.0 or newer). As of this writing, however, WordPerfect’s AppleScript interface
contains too many bugs to use, and AppleWorks’s interface is too incomplete.
If you use Microsoft Word or Nisus Writer, go ahead and try the AppleScript option and see
how you like it. At the very least it can be entertaining to watch your word processor build a
document step-by-step in response to instructions from Papyrus.
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Creating text or HTML documents
At times you may wish to export your Papyrus references as a plain text document, without all
of the usual word-processor bric-a-brac of margins, fonts and so on. For example, perhaps you’ll
need to e-mail a simple list of references to a colleague.
Producing such a document is easy:

In addition to this Plain text setting there are two other sub-choices available.
Selecting HTML will yield a document ready to be included as part of your Web site. Why don’t
you try this now? Tell Papyrus to once again Print/Export some or all of your references, this
time creating an HTML text document. Then open the resulting document in your Web browser.
It won’t be impressively italicized or boldfaced, since the STANDARD format doesn’t include
any such frills, but at least you’ll be able to confirm that everything is working correctly.
Go ahead and give this a try.
The TeX option allows you to create a document ready to be read by the TeX typesetting system.
TeX is used mainly by academics in certain fields of study who prefer a great deal of fine control
over their documents. Papyrus actually includes a fair amount of support for TeX. Of course, if
you’ve never even heard of TeX before, you shouldn’t worry about any of this now.
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See Also...
You have now learned the basics of sending your Papyrus references to your printer, your
word processor or your Web site. Papyrus also offers other, more specialized sorts of exporting, such as author-indexed reference lists. But when you get to these advanced operations,
you’ll find that they still use the same Print/Export dialog with which you’re now familiar.

See also:
CONCEPTS
Output Formats
REFERENCE
Print/Export
Cross-reference List
Indexed List
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Introduction
Formats are very important to Papyrus. Papyrus uses an output format whenever you see a
reference displayed on your screen, and whenever you print or export references. And each
time you import references from some other source into your Papyrus database, you must specify
an import format that matches the incoming data.
In subsequent chapters I will show you how to create your own output and import formats. But
in this chapter you get a big head start—I’ll show you how to access the many formats we have
already provided with your copy of Papyrus.
A freshly-initialized Papyrus database contains only three formats: STANDARD, COMPACT
and BRIEF. You add to these three by creating your own new formats, or by copying existing
formats from a Format Library.

The Formats window
From your Windows menu choose Formats. Your database’s Formats window will appear:

As promised, your database includes the three built-in output formats and, so far, no others.
In this chapter we’re not going to touch the New, Edit, Delete, or Duplicate buttons. But let’s
take a quick look at our built-in formats using Preview.
With your mouse or arrow keys, select STANDARD:
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Now click the Preview button. This window will appear:
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This unsightly jumble of information is actually a sample journal article, displayed using
Papyrus’s STANDARD format. But the sample article takes advantage of nearly every hidden
field that Papyrus offers, including a Picture field that we haven’t discussed yet. Because STANDARD is Papyrus’s default onscreen output format, it must know how to display all of these
fields. Other formats, though, will include only those fields that they consider relevant—for
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example, an output format for a typical journal will not include fields such as Abstract, Comments, or Keywords.
The pop-up menu at the bottom of the Preview window allows you to see how the STANDARD
format would display sample references of types other than Article in journal. Go ahead and
take a look at Book/Monograph and some of the other reference types.
Now let’s preview each of the other built-in formats. You could simply close the current Preview window and use the Formats window’s Preview button again to accomplish this. But just
for fun, let’s use drag and drop instead.
Leaving the current Preview window open, move it aside so that it doesn’t obscure the Formats
window. Click the Formats window to bring it to the front. Now use your mouse to select the
BRIEF format. Notice what happens to your mouse cursor after you click:

The little hand icon indicates that you can drag whatever is beneath the mouse cursor. In this
case Papyrus is telling you that you can drag a copy of the BRIEF format to another window. So
go ahead: click and drag the BRIEF format to the already-open Preview window. Once there,
release your mouse button to drop the format onto that window:

Does this appear vaguely familiar? Indeed—the All References window uses the BRIEF format in its “table” display.
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Go ahead and do a Preview of the COMPACT format, too. It’s not one that you’ve encountered
so far in your exploration of Papyrus, but it won’t contain any mysteries for you.
When you’ve finished exploring the built-in formats, close the Preview window.

Format Libraries
Think of a Format Library as a suitcase for carrying formats from one Papyrus database to
another. Here at Research Software Design we have created hundreds of formats. From these
we have selected groups of related formats, and placed each group into a Format Library for
your benefit. But to actually use any of these formats you must first copy them from the Format
Library to your own database.
Before proceeding with this section, you’d better be sure that you have some Format Libraries
installed! A standard Papyrus installation includes several of these; you can also download
others from our Web site. Here’s what a Format Library icon looks like:

The name of a Format Library is intended to suggest its contents. For example, the Humanities
library includes several output formats of interest to workers in the humanities, while the Biomedical library contains lots of output formats corresponding to the styles used in important
biomedical journals.
You can open a Format Library simply by double-clicking it in the Finder. Or else from the
Formats window you can click the Library Open... button. Either way, go ahead now and open
one of your Format Libraries. I’ll use the Humanities library myself:
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As you can see, the Humanities library contains only output formats. Some other libraries contain import formats. Usually a Format Library provided by Research Software
Design will contain only one type of format, but you are certainly welcome to mix output
and import formats within any Format Library you create.

The Preview button works the same as the one you’ve already used in the Formats window.
You can use it to help determine which of the available formats are relevant to your needs.
To copy a format from a Format Library to your personal database, simply drag it from the
library window to your Formats window. Or you can use copy and paste to accomplish the
same thing.
Go ahead and copy some output formats from one or more libraries to your database. In a
coming chapter we will make use of these.
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See Also...
You now know how to open a Format Library and add any of its predefined formats to your
own Papyrus database. You will use these formats in chapters to come.

See also:
CONCEPTS
Output Formats
REFERENCE
Formats Window
Import
Shortcuts
Formats Window
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Introduction
A notecard is a special type of Papyrus reference. Rather than representing a bibliographic
citation, a notecard is the equivalent of a file card onto which you have jotted down some notes.
You can link a notecard to a reference. For example, while reading a book you could take notes
on different sections, or different themes. The result would be a series of notecards, each linked
to the book reference itself. Or you might wish to make a set of notecards linked to a journal
article reference, with one card summarizing the Methods section, another card summarizing
Results, etc.
You can also have free-standing notecards, not linked to any reference. And you can even link
notecards to one another. So you can create a whole web of information.
In a later chapter we’ll get into these more advanced sorts of links. For the present, though, I’ll
stick to simply linking notecards to their associated references.
If none of this sounds interesting to you right now, feel free to skip this
chapter. None of the following chapters assume that you have entered any
notecards into your database.

Creating a notecard
Entering a new notecard is as easy as entering a new reference. Go to the Reference menu
and pick New. In the resulting Reference Entry window, change the reference type to Notecard:
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As with any Papyrus reference, a notecard gets a Reference #. It also has room for Comments
and Keywords. It is in the Comments field that you will enter your notes.
Although you can type as much as you like into a single notecard, I’d suggest that if you
find yourself with an extremely large Comments field you consider splitting this into two
or more separate notecards.

The Card title field allows you to quickly identify a notecard. This comes in handy, for example,
in windows that show the Card titles of all the notecards linked to a particular reference.
Place in reference provides a spot where you can indicate to which portion of a linked reference this notecard pertains. Thus, if the reference is a book or a long article you might enter
something like pp. 23-30 here, or maybe Chapter 12.
Quotation is available for you to record a quotation from a linked reference. Notecards thus
provide a way for you to keep track of useful passages that you might later wish to quote in
your own work.
For use in the next section of this chapter, let’s enter the following notecard:
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Having typed in the notecard as shown, save it and close the window.
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Linking notecards to references
Now we’ll connect the notecard you’ve just created to an existing reference.
Open the All References window and select Reference #3:

Now click the Links window button. A new window will appear:

Since Reference #3 doesn’t yet have any linked notecards, at this point the Links window simply displays Reference #3 itself (using the COMPACT format).
Let us now link your new notecard to this reference. In the All References window, select the
notecard, Reference #7. Then drag it to the Links window. Papyrus will ask you what sort of
link applies between these two references:
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The suggested choice is correct: Reference #7 is indeed a notecard, and Reference #3 its linked
reference. So click the Link button.
The Links window now shows that our two entries are linked, and indicates the nature of that
link:

There are several other things you can do in this Links window, but we will save them for a
future chapter. If you’re really curious, feel free to double-click the balloon help icon for a tour.

Note that in the All References window, if you select either the notecard or its linked reference
the Links window button will now boldface itself to indicate that the selected item bears links
to other items.
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Now close the Links window.

Entering references and notecards together
You’ve just learned how to link an existing notecard with an existing reference. In practice,
though, you’ll often wish to enter a notecard right after you enter its reference. Or you may
want to enter several notecards, one after another, all for the same reference.
Papyrus provides a shortcut for creating new notecards and simultaneously linking them to
their parent reference.
In the All References window, select Reference #3. Then from the Reference menu choose
Edit.
We’re not actually going to make any changes to Reference #3 itself. But now that its Reference
Entry window is open we’re in a position to add one or more notecards to this reference.
From the Reference menu choose Add Notecards. Papyrus will do two things:
• open a new Links window for Reference #3 (you may have to move the front
window aside to see the Links window), and
• prepare the current Reference Entry window to accept a new notecard.
Now we can enter this new notecard:

Save this notecard by pressing Enter. Papyrus will automatically link the new notecard to
Reference #3, as evidenced in the Links window:
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Papyrus will also prepare the Reference Entry window for another new notecard. But we’re
done for now, so close the Reference Entry window. Do leave the Links window open, though.

Outputting linked notecards
There are two different ways to print or export a reference and its linked notecards together.
First, you can simply print a Links window. You should still have Reference #3’s Links window
open, so try this now. From the File menu pick Print/Export... The result will be extremely
similar to what you see in the Links window on your screen, including the connecting lines and
little triangles.
Second, any time you print or export some references you canask Papyrus to automatically
include any linked notecards. And vice versa, as you’ll see in a moment.
Close the Links window. With the All References window frontmost, pick Print/Export... from
the File menu. Select All items in Group, and then check Include linked items:
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Select To printer and click the OK button. After printing Reference #3 Papyrus will show that
reference’s notecards. And after printing the notecards themselves, References #7 and #8, Papyrus
will show each notecard’s linked reference (namely, Reference #3).
The Links... button allows you to tell Papyrus to show, for example, the notecards linked
to a reference but not the references linked to a notecard. More on this in a later chapter.

See Also...
You now know how to enter notecards into Papyrus, and to link them to references. You have
also seen how to output these linked notecards along with their references.
The link between a notecard and a reference is merely one kind of link that Papyrus allows
between any pair of references. The Reference Links WORKBOOK chapter provides further discussion of Papyrus’s linking capabilities.

See also:
CONCEPTS
Notecards and Linked References
REFERENCE
Reference Entry Window
Reference Links Window
Print/Export
SHORTCUTS
Reference Entry Window
Reference Links Window
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Introduction
Usually when you wish to print a list of references or export a nicely-formatted bibliography to
your word processor, you will not want to include every single reference from your Papyrus
database. Rather you will assemble a Group of the specific references that are relevant to your
needs of the moment.
A Group can contain the results of a search, or it might hold the references cited in a particular
manuscript you are writing. References can be added to the Group or removed from it with no
effect on your overall database. You can print or export the items in a Group, and perform
search-and-replace or spellcheck operations on them.
The references in a Group can be sorted however you wish. For example, you might need to
sort a bibliography alphabetically by authors. A curriculum vitae, on the other hand, might be
sorted by year of publication. You can even create a Group of references sorted by journal and
volume, so that you could print out the list and efficiently find the articles at your library.
Sometimes you will need to sort a Group in an arbitrary order. For example, many journals
demand that the bibliography be arranged in citation order.
For a complete understanding of Groups, be sure to read the Groups chapter
in the CONCEPTS section.

Creating a new Group
From the Group menu pick New Group. A fresh Group window will open:
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This window should look familiar to you, as it is extremely similar to the All References window.
In fact, the latter is merely a special Group window.
At this point your new Group is just an empty bucket. But while it does not yet contain any
references, it does have some starting properties of its own. The Group assumes that when you
print or export its contents you will want to use the STANDARD format. It also assumes, as
we’ll see in a moment, that you wish to sort the Group’s references alphabetically by author.
Each Group has room for a description. Someday you may have dozens of Groups stored on
your disk, and these descriptions will help you recall the purpose of each.
As you can see, the default description is a bit generic:
You can type a useful description here

So let’s change this default description to something at least marginally useful. From the Group
menu pick Edit Description. Then type in a new description, such as:
My first Group!

Press Tab or Return after you’ve entered your new description.

Adding and removing references
Leaving our Group window open, go to the Windows menu and select the All References
window. In that window select References #1, 2, and 3. Now we’ll add those references to our
Group window. You can either copy them in the All References window and then paste them
into the Group window, or else you can drag them from the All References window to the
Group window. Use whichever method you prefer.
As promised, note that Papyrus automatically sorts the references alphabetically by author:
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If you worked through the exercises in the Notecards chapter, then you’ll now notice that
the Links window button has boldfaced itself. As you’ll recall, this means that at least
one of the selected references has some notecards linked to it.

Removing a reference from a Group is equally straightforward. Let’s get rid of Reference #2.
First click in the window below the three references to deselect them. Then click Reference #2 so
that it is the only one currently selected:

Now you can do any of a number of normal Macintosh things to remove this reference from the
Group:
• press the Delete key
• press the Clear key
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• from the Edit menu choose Clear
• from the Edit menu choose Cut
Using your favorite of these methods, go ahead and remove Reference #2 from your Group.
If you were a child who enjoyed stacking blocks just so you could knock them down
again, feel free to undo the removal of Reference #2 and then try another of these
methods of eliminating it from the Group.
You can tell any onlookers that you are just being thorough in testing all of the available
options.

Note that although Reference #2 has been removed from this Group, it remains unscathed in
your database. A quick peek at the All References window will reassure you of this.

Sorting the Group
Before I can show you a few things about sorting your Group, we’d better fill it up a bit more. So
go ahead and add References #1 through #6 to it.
You can simply select all six of these references in the All References window and drag
them to the Group window. That two of them were already sitting in the Group window is
no problem.
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As before, you can see that Papyrus has automatically sorted these references alphabetically by
their authors.
The three references with the same first author have been sorted by their second authors. You can use the Individual items view to confirm this.
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Let’s change the Group’s sorting. For starters, how about sorting by Reference Number? Go to
the Group menu and pick Sort... This dialog will appear:

Our Group is currently sorted first by author, and then—if two references’ authors are identical—by year, and if necessary then by title and then by pages.
Let us erase this sorting pattern. You can press Tab to move to the sorting pattern, or else you
can use your mouse. Either way, erase the Author-Year-Title-Page(s) pattern:
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Now double-click Reference # in the list of available sorting fields.

Click the OK button and watch as Papyrus re-sorts your references.
That was entertaining, wasn’t it? Now let’s try another sort. This time we’ll sort the references
by their years. And just to make things a bit more interesting, we’ll tell Papyrus to sort the mostrecent references before the older ones by checking the Years in descending order checkbox:

WORKBOOK

Click OK and make sure that Papyrus does what it is supposed to.
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Citation/Manual order
As I mentioned earlier, sometimes a Group must be sorted in an arbitrary order, such as the
order in which the references were cited within a manuscript. In Papyrus terminology such a
Group is sorted in citation order or manual order.
That’s “manual” as opposed to “automatic.” I.e., you can manually rearrange the references within the Group.

Once again, go to the Group menu and pick Sort.... Then click the Citation/Manual order
button:

Because you have selected Citation/Manual order, the list of available fields is now
irrelevant and, hence, disabled.

Click OK. At this point the references of your Group will retain their former order:
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Now select Reference #4 and drag it to a position between References #3 and #6:
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When you release the mouse button, Reference #4 will indeed move to this new position:

If you like, go ahead and try some more experiments in dragging references about in the Group.
You might, for example, use Shift-click or  -click to select two or three references, and then
see what happens when you drag them as a bunch to a different position.

Printing the Group
You will find printing or exporting the contents of your Group easy, assuming that you’ve
already been through the Printing and Exporting Your References chapter.
But it would be boring to yet again use the STANDARD format here. Did you follow my previous suggestion and copy some other predefined output formats to your database? If so, then
let’s start by switching your Group’s format.
From the Group menu pick Set Format.... Papyrus will present you with a list of all the output
formats known to your database:
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Go ahead and pick whichever of these formats strikes your fancy, and then click the Select
button.
Next the Sort dialog will appear. It will be set to whatever sorting pattern is appropriate to the
format you’ve chosen. This will either be Author-Year-Title-Page(s) or else Citation/Manual order.
Click the OK button to accept this suggestion.
Now we can proceed with printing the Group’s references. From the File menu pick Print/
Export... I’ll now leave you to your own experimentation; everything will behave as you’ve
previously experienced.
When you’re satisfied, close the Group window. If you like you can first save the Group to your
disk for future experiments (or to proudly display your new skills to your colleagues).
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See Also...
You now know the basic operations for creating, assembling, sorting, formatting and printing a
Group. These are essential to using Papyrus, where much of the action relates to Groups.
However, there are still many additional capabilities and shortcuts involved with Groups. Be
sure that you eventually read both the CONCEPTS and REFERENCE chapters about Groups and the
Group window.

See also:
CONCEPTS
Groups
REFERENCE
Group Window
SHORTCUTS
Group Window
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Introduction
Besides producing nicely-formatted reference lists, Papyrus’s other main use is to enable you to
search through your database for the references that you need at any given moment.
In this chapter we will start with some basic searches. Then we’ll look at some shortcuts for the
simplest searches, and gradually proceed to more complicated searches and related issues.
The exercises in this chapter assume that your database contains the references entered in the preceding chapters on Inputting and Modifying
References. If you have not entered those references, or if your database includes additional references, then some of the following exercises will yield
results different from those shown here.

Simple searches
Let’s start by finding all references with Ramasubramanian as an author. From the Reference
menu choose Find... The Find dialog will open:

On the left is a list of fields that you can search. The one we want, Author, is already selected for
us.
Press Tab to move to the list of comparisons. As will most often be the case when you perform
a search, we want to pick =, which is already selected for us.
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Press Tab again to move to the search specification box. Here is where we build up our instructions to tell Papyrus which references it is to find for us. So far our specification indicates that
we want to search for a particular author. Now we must type in the name of that author.
You could just type in the whole name now:

But if you would rather save yourself some typing, enter just this much:

and then press our old friend, - L (which is equivalent to going to the Edit menu and
picking Look up Author). In the Names window that now opens, pick Ramasubramanian,S R
and click the Select button. The result:

If you had typed a few more letters, such as rama, before pressing - L, there would
have been only a single possible matching name in your database. In that case Papyrus
would have fleshed out the full name automatically, without taking you to the Names
window.

Now that we have a complete search specification—consisting of a field (Author), a comparison (=) and a value (Ramasubramanian,S R)—the Find button becomes available. Make sure
that the Load results while searching checkbox is checked, and then click the Find button.
Papyrus responds by opening a new Group, and filling it with the relevant references:

WORKBOOK

Chapter 9: Finding References

W85

This is a perfectly normal Papyrus Group. You can examine any of these references by switching to the Individual items view, you can edit any of them, you can print or export the Group.
The initial settings of this Group are worth noting:
• The description shows your search specification.
• The Group is set to use STANDARD format for its output.
• The Group is sorted in citation/manual order.
There is nothing sacred about the description corresponding to your search specification. If you
are going to keep this Group around for further use you are welcome to change the description
to anything you wish. But for starters, if you have several Group windows open on your screen
then this will be a helpful reminder of what this particular Group represents.
You can change both the format and the sorting pattern to whatever you like. Papyrus defaults
to citation order so that as it finds each matching reference it can simply add that reference to
the very end of the Group. If you should perform a large, complicated search, this implies that
you can safely examine and work with the references showing at the top of the Group window
while Papyrus continues to add additional references at the bottom.
You might want to read that last sentence again. Your current database is too small to
produce a time-consuming search, but when you do eventually collect a large number
of references and ask Papyrus to do some complex search for you, that search might
require several seconds or even minutes to complete. While the search is running,
though, you still have full access to most Papyrus functions, including the ability to
examine or modify any of the references that have so far been found and added to the
Group.

You can close this Group window now. There is no need to save this Group.
I hope you’ll agree that this search was quite easy to run. As it happens, though, for such a
simple search there is an even easier approach, which I’ll show you next.

Quick Finds
In your explorations of Papyrus so far, do you recall seeing some buttons labelled Quick Find?
Think for a moment and see if you can recall in what windows these buttons appeared.
Here’s a subtle hint: go to the Windows menu and open the Names window:
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With the name of our friend Ramasubramanian selected, go ahead and click the Quick Find
button now.
As you can see, the results are identical to those we obtained a moment ago.
Since the Names window actually includes not only Authors but also Editors, running a
Quick Find from the Names window will actually find any reference bearing the selected
name in any of its Author or Editor fields.

The Keywords and Journals windows also provide Quick Find buttons. Let’s do a quick keyword search next.
Open the Keywords window and pick Neurosurgery:
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Now click the Quick Find button. Papyrus should find the two references bearing the Neurosurgery keyword.

Complicated searches
Enough with these simple searches. Let’s try something a bit more interesting.
Often you’ll want to find all references that pertain to a particular topic. If you’re particularly
compulsive, then you will have already assigned an appropriate keyword to each of the relevant references, and could now just do a Quick Find from the Keywords window.
But let’s get real. Unless your grants are so generous that you have a platoon of undergraduates
adding keywords to all of your references, there are surely references without this keyword
that nevertheless mention this particular topic somewhere in a title, abstract or comments field.
So a simple keyword search won’t suffice here.
Let’s search all of these fields at once. Go to the Reference menu and choose Find... Using the
skills you acquired a moment ago, enter this search specification:

Now click the OR button. Then press Tab to get back to the field list.
Next we want to pick Abstract from this list. You could use your mouse to scroll the list until
you find that field, but here’s a keyboard shortcut: simply type the first few letters of the field
name:
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You’ll notice that as you type each letter Papyrus moves to the first available item that begins
with the letters you’ve so far typed. Once you’ve arrived at your desired item (which in this
case requires you to type ab), press Tab to add this item to your search specification.
Then press Tab again to add the = comparison.
Finally, once again type neurosurgery. Here’s how things should look so far:

Repeat the above steps until you have achieved the following search specification:
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Before we continue with our search, I’d better answer the most commonlyasked question about setting up this sort of search: when am I supposed to use
AND and when am I supposed to use OR?
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We have used OR here because we wish to find any reference that contains the
word neurosurgery in its Title field, or in its Abstract field, or in its Comments
field, or in its Keyword field. In other words, if neurosurgery appears in any of
these fields we’ll be satisfied.
In contrast, if we had used AND in place of each of those ORs, then we would
be telling Papyrus that we only care about references that contain neurosurgery in every one of the four fields. In other words, neurosurgery must appear
in the Title field and in the Abstract field and in the Comments field and in the
Keyword field. Few, if any, references will meet such stringent demands!
To put all this a different way, using OR relaxes your search requirements, offering an alternative route for a reference to be considered a successful match. Using
AND tightens your requirements, adding an additional test that any would-be
match must satisfy.
Okay, let’s proceed with the search. Click the Find button.
Uh-oh! Papyrus raises this objection:

Papyrus has just taken a quick peek into its index of Abstract words, and is telling us that
there’s no point in proceeding with this search, since no reference’s Abstract contains the word
neurosurgery.
For a lot of important information about indexes, you will eventually want to review the
CONCEPTS Indexes chapter.

Okay, so there is apparently no need to include the Abstract field as part of our search specification. Go ahead and erase that bit, leaving:

Now click Find again. Oh dear...
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Obviously we worked too hard in creating this search specification. Well, go ahead and erase
that part of the search specification:

One more time: click Find.
Finally! Papyrus now finds the relevant references for us.
•

•

•

For such a commonly-needed type of search, that was certainly a tedious experience! Fortunately, Papyrus includes a shortcut for simultaneously searching the Title, Comments, Abstract
and Keywords fields.
Open the Find dialog once again. Papyrus provides a special “field”:

Now click the Find button.
This Term search behaves identically to the longer search we entered above. However, Papyrus
doesn’t waste your time complaining about irrelevant pieces of the search specification, since it
understands your intention in using Term.
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Term translates to Title OR Comments OR Abstract OR Keywords. So enter this search specification:

Another complicated search
Let’s get even more interesting. How about finding all journal articles published after 1989?
Here’s how we indicate this:

As you’ll recall, AND implies that both requirements must be met for a reference to be considered a successful match. If we had mistakenly used OR instead, the search would have accepted
any reference that was a journal article, regardless of its year of publication, and also any reference published since 1989, regardless of its reference type.
As I’m sure you’ll also recall, Papyrus is intelligent about which century you have in
mind when you enter only two digits for a year. If you’re concerned that it might guess
wrong, though, you are always welcome to enter a year using all four digits.

What if we had actually wished our search to also include articles published during 1989? There
are two ways to accomplish this (the latter being a bit more elegant):

or:

That >= means “greater than or equal to.”

Wildcards
Papyrus follows the very common computer-searching convention of allowing you to type an
asterisk as a wildcard within your search specification. For example, this:

tells Papyrus to find any reference whose title includes any word such as neurology, neurotransmitter or neurosurgery.
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The asterisk need not appear at the end of a word. For example, this search:

will find all references with a title containing such words as surgery or neurosurgery.
To also include words such as surgeries and neurosurgical you could specify:

This one will find all references with an author whose surname begins with the letter R and
ends in an N:

You can even use the asterisk all by itself. For example, this search:

will locate all references that contain anything in their Comments field.
The asterisk in *surgery was willing to match nothing at all—thus that pattern would
successfully match the word surgery. But when you use an asterisk all by itself as we
have here, Papyrus interprets this to mean that you are specifically looking for a nonempty field.

NOT

Or how about looking for all references that have not yet had any Comments entered?

You can read this as “Find all references for which it is not the case that the Comments field
contains something.”
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Sometimes you need to find all references that fail to meet some criteria. For example, suppose
you want to find all of your database’s references that are not journal articles. Use the NOT
button:

NOT turns up most often as a way to restrict a search. For example, to locate all recent work by
anyone other than a certain prolific author:

Or suppose that you wish to find all of your references about cryosurgery, dermatosurgery,
telesurgery and surgery in general, but neurosurgery no longer intrigues you. You might enter
a search specification such as this:

Read this as “Find all references whose Title, Comments, Abstract or Keywords include a word
ending in surgery, but exclude from the results any including the word neurosurgery.”
Those of you who studied prepositional calculus during childhood already know that the
English word but is equivalent to the logical term and. For the rest of you, just remember that whenever you feel a desire to type BUT NOT in a search specification, you
must use AND NOT.

Parentheses
Sometimes a complicated search specification can be confusing or ambiguous. For example,
recall that this search:

will find all recent references lacking this particular author. Now, we could have just as easily
entered these two criteria in the opposite order:

What we intended here was:
It is not the case that Author = Ramasubramanian,SR
AND
Year > 1995
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But one could just as easily read this search specification as:
It is not the case that:
Author = Ramasubramanian,SR
AND
Year > 1995

In other words, does that NOT apply just to the first search condition regarding the author, or
does it apply to everything that follows? This is no small distinction—the second interpretation
will find all references in your database except for those that are both by Ramasubramanian and
were published since 1995. This is quite different from our intention!
You can use the ( and ) buttons to clear up such ambiguous situations. The version we intended
could be entered as:

while the undesired version would be:

If you’re ever in doubt about this sort of thing, feel free to add enough parentheses to make
things absolutely unambiguous.

You can build up a complicated search piece by piece, stopping after each new search condition
to see how many matching references you’ve found so far. This comes in particularly handy
when you’re trying to find just a few specific references in a database containing thousands of
entries.
Since your database doesn’t yet contain thousands of entries, you’ll need to use your
imagination a bit as we proceed here.

I seem to recall once seeing an article about an unusual application of neurosurgery. It was in
one of the major medical journals, and must have appeared prior to 1985.
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Refining a search

Let’s begin our hunt by finding all journal articles about neurosurgery. Go ahead and enter this
search in the Find window:

Now uncheck the Load results while searching checkbox (for reasons that will become clear in a
moment), and then press the Find button.
As with the other searches you’ve done, Papyrus opens a new Group window. But this time it
doesn’t simply fill that Group with the references found during our search. That’s because this
time we told it to not automatically load the search results. Instead, Papyrus performs your
search and then opens the Refine Search dialog:

W96 Searching and Replacing

Here we can see all of the searches that have been run so far in the Group named untitled.
Specifically, there has been a single search performed, and this search has been assigned the
imaginative name S1. This search found a total of two matching references.
Here is where I’d appreciate you starting to exercise your imagination. Pretend that we
just found 200 matching references. Otherwise the following steps are going to seem
like a lot of unnecessary work.

Okay, let’s narrow down this vast set of results. First, let’s see how many pre-1985 references are
in the database. This means doing a new search, so click the New button. Up comes the Find
window, which now includes S1 among the “fields” we can include in a search:

But we’re not going to select S1 just yet. Instead, just find all references from before 1985:

Ah, another vast sea of contenders:
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Let’s combine these two searches to narrow the possibilities. Click the New button, and then
enter this search specification:
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Note that when we use S1 or S2 in our search specification we do not include a comparison
such as = nor any value such as neurosurgery. The above S1 AND S2 means “Find all references
that were found both in search S1 and in search S2.”
Okay, click the Find button.

Well, that didn’t help in limiting the number of possible matches!
I had recalled that the article in question appeared in a major medical journal. Let’s try this new
search:

No need for you to type out that whole journal name. Just enter a reasonable abbreviation, such as nejm, and then press -L.

But apparently this wasn’t the correct major medical journal...

How about:

Ah-ha!—
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You can stop using your imagination now. This time we really did find exactly two references.

So we now have two references that are about neurosurgery, pre-date 1985, and appeared in the
journal I apparently had in mind. It’s time to examine our catch more closely.
Although all of these searches belong to the current Group, the Group itself is still empty. We
must now load one of the search result sets into the Group. So with search S5 selected, click the
Load button. Papyrus will add the references found in this search to the Group:
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Note that the Group description still reflects the original search specification that created the Group. By now that description isn’t really an accurate summary of why these
particular two references are in the Group.
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If after examining these references we were still unsatisfied, we could perform further searches
within this Group by going to the Group menu and picking Refine Search.... This would reopen the Refine Search dialog, and we could then continue to create and combine additional
searches. Try it now for yourself, if you like.
•

•

•

Before we leave this topic, I’d better say a few words about this load business.
Whether Papyrus loads the results of a search into the Group is controlled by the Load results
while searching checkbox in the Find window. If the box is checked, then Papyrus will immediately load each successful match into the Group as it is found. If the box is not checked, then
Papyrus will instead open the Refine Search dialog and just report the total number of successful matches. You can then run additional searches, or else load the results of any of the searches.
There are two reasons for separating the load step from the search step. First, suppose that after
doing a whole series of searches you end up with one search—let’s call it S6—with 25 matches,
and a further-refined one—S7—with only 2 matches. You might feel that S7 has become overly
narrowed, and decide to examine the results of S6 instead. Because Papyrus allows you to load
any of your searches, not just the most recent one, this is no problem.
The second reason is at least as important. When Papyrus performs a search it reads through
your database to identify the matching references. This takes a certain amount of time, but
Papyrus has been designed so that most searches will get through this step quite rapidly. In
order to load the results into your Group, through, Papyrus must then pull up each of these
references and examine the existing members of the Group in order to decide where the new
one should be inserted. The more complex the sorting method used by the Group (e.g., alphabetically by author, then chronologically by year, then...) the longer it will take to insert each
new reference into the Group at the appropriate spot. By separating the searching step from the
loading step, each of the searches you perform will run more quickly, and you only have to pay
the loading penalty once.
Please don’t let me scare you too much about this loading thing! It really does not take
an eternity to load references into a Group. But for a simple search, finding each reference does take less time than loading it, so the more matches your search finds, the
more time spent on the loading part of the process.

So, when should you check the Load results while searching box, and when shouldn’t you?
For the typical quick hunt for a reference, check the loading box. If a relatively small number of
matches are going to occur, then there will not be much time spent loading them into the Group,
and you can avoid the extra steps of using the Refine Search dialog.
For more complicated searches, particularly those where you would like to start with one or
two broad criteria and then narrow the results based on the number of matches found, it makes
sense to defer loading until you’ve seen how many matches you’ve got.
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See Also...
Congratulations! You have now learned how to search your Papyrus database for particular
references. Most often you will find yourself running simple searches, and in many cases you
can get away with just clicking a Quick Find button in the Keywords, Journals or Names window.
But you have also learned to set up complicated searches, and to use the Refine Search dialog
to assemble a search piece by piece.
There are still important concepts you will want to review sooner or later in the CONCEPTS Indexes
chapter.

See also:
CONCEPTS
Indexes
Groups
REFERENCE
Group Window
Find Dialog
Refining a Search
SHORTCUTS
Find Dialog
Refine Search Dialog
WORKBOOK
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Introduction
From time to time you will need to make a global change throughout your database. For example,
you may discover that a particular author’s name has frequently been misspelled. Or perhaps
you’d like to add the text “Used in my 1999 review article” to the Comments field of a few
hundred references. Or you might decide that the keyword you’ve been entering as “Totally
Loony” would look better to your supervisor as “Thought Disorders.”
Papyrus provides several convenient ways for you to make such sweeping changes. Simplest
are changes to keywords or journals, since these are already saved in their own autonomous
“dictionaries.” Similarly, the Names window provides a central location for globally editing
author and editor names. For information in all other fields, Papyrus provides two different
sorts of search-and-replace dialogs.

Keywords
From the Windows menu choose Keywords. The Keywords window displays all of the keywords currently available in your database:

You can see how many references cite each keyword. For example, there is currently
one reference bearing the keyword Attitudes, and two bearing the keyword Neurosurgery. The built-in keyword INCOMPLETE is not currently being cited by any references.

Let’s change one of these keywords. Select Tobacco, and then click the Edit button.
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Do you remember all of the methods you can use to select Tobacco? You can click that
line with your mouse. You can use your ↑ and ↓ keys to move the selection. Or you can
type the first few letters of the keyword.

In the resulting Edit Keyword window, let’s make some innocuous change to the spelling of
this keyword. Hmm. How about:

After you have made this spelling correction, click the Change button. You will immediately
see the change reflected in the Keywords window.
Any reference that cites this keyword will henceforth display the new spelling. If you would
like to confirm this for yourself, click the Quick Find button.
Close the Keywords window when you’re done.

Journals
Changing a journal name or journal abbreviation is as easy as changing a keyword. From the
Windows menu choose Journals. The Journals window will open, showing all of the journals
you have so far entered in your database:
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There’s actually nothing wrong with what we’ve entered for either of these journals, but just for
the practice, select JAMA and click Edit.
Or just option-double-click the JAMA line. In these “dictionary” windows (Keywords,
Journals, Formats, Names, Glossary) option-double-clicking an entry is always the same
as clicking the Edit button.

You’ve encountered this dialog before—it’s the same as the New Journal dialog in which you
entered these journals into Papyrus in the first place.
I don’t have any changes in mind for this particular journal, so just click the Cancel button, and
then close the Journals window.
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Names
The Names window behaves similarly to the Keywords and Journals windows, although what’s
going on behind the scenes is actually a bit different.

I’d like to fill in the full first name, rather than just the initial, for Snooks,BB. So select that name
and then click Edit.
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Go ahead and change Snooks,B B to Snooks,Barbara B:
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Notice that the Sort as text automatically mimics our changes. More about that in a
moment.

Click the Change button. Our new spelling of this author’s name will appear in the Names
window, and also in any windows showing references bearing her name.
Next we’ll make a more subtle change to LaFièvre. Select that name and click Edit.
Or just option-double-click the name.

This time leave the Change to text alone, but in the Sort as field remove the La:

We are telling Papyrus that although this author’s name should always be displayed as
LaFièvre,H, when alphabetically sorting references the name should be treated as just Fièvre,H.
This distinction between a name’s appearance vs. its sorting behavior often arises with compound names such as van Gogh,V or von Braun,W.
Click the Change button. Note that the Names window now marks this name with a •, to
indicate that it will be treated specially when sorting:
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You can now close the Names window.

Replacing text
Open the All References window and select references #4 and #5:

Now from the Edit menu pick Find & Replace Text...
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With this dialog you can find and replace text appearing in any field of any or all of the references in your database.
Let’s make a change to just the two references we selected in the All References window. Click
the Selected items radio button. Then fill in the remaining items like this:

We are telling Papyrus to examine the references we have selected (as opposed to every reference in your database), and look for the word neurosurgery appearing in their Title fields. If it is
found, Papyrus should replace it with brain surgery, after first asking us to confirm each replacement.
Go ahead and click the Replace button. In each of the Confirm Change dialogs that then appear,
click the Change button so that Papyrus will proceed with the replacement.
Use the All References window to confirm that Papyrus made these changes correctly.
Let’s do another. This time we’ll make the change over the entire database. We’ll also use the
Whole word checkbox:
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Go ahead and click Replace. Confirm each change when Papyrus asks you. Note that because
we checked Whole word, Papyrus does not make any change to the word neurosurgery appearing in Reference #6.
Now let’s undo the damage we’ve caused, without pausing to confirm each correction:

Click Replace to return things to their former state.
•

•

•

Let me demonstrate what that Adopt target’s case checkbox is for. Try this:
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Click Replace and then take a good look when the Confirm Change dialog appears:
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Since we did not check the Case sensitive box, Papyrus accepts Nothing as a match for our Find
text of nothing. In replacing it with almost nothing, though, Papyrus has followed our instructions and altered the first letter of each word to uppercase, matching the case of the word being
replaced.
We really shouldn’t alter LaFièvre’s title without his permission, though, so click No change.

Changing fields
Find & Replace Text is very nice for many things. But sometimes you need to alter a certain
field in a batch of references, regardless of the existing contents of that field. For example, you
might wish to add a particular phrase to the Comments field of each reference.
Allow me to demonstrate. Open the All References window and this time select references #4,
#5 and #6. Then from the Edit menu choose Change Field...
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Now fill in the Source Text as shown below, and click Append to end of target field.

With the same three references still selected, let us now move the contents of each reference’s
Comments field to its Abstract field instead. Here’s how:
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Go ahead and click the Change button. As you’ll see in each Confirm Change dialog, and as
you can double-check afterwards in the All References window, Papyrus will indeed add this
new sentence to the Comments field of each of the three references. In the case of Reference #6,
which already contained some Comments, the new sentence is correctly appended to the end of
the existing text, as we requested.

Be sure to pay attention to the details here, since this sort of global change can drastically alter your
database! We have limited our modifications to the three Selected items. The source for each
change will be the existing contents of each reference’s Comments field. Since we intend to
move the Comments, rather than merely copy them, we have told Papyrus to erase the Comments field after we’ve performed the change. Whatever Papyrus finds in the Comments field
will be put into the target field, namely Abstract. If any text already exists in these references’
Abstract fields it will be replaced by the incoming information.
Now click the Change button, and then accept each Confirm Change dialog. Afterwards use
the All References window to assure yourself that Papyrus did indeed accomplish what we
asked of it.
You might need to Edit each affected reference to be absolutely convinced that Papyrus
did indeed move the former Comments to the Abstract field.
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See Also...
You now know how to make global changes throughout your database. Changing a keyword,
journal or name is particularly easy. For other fields, Find & Replace Text allows you to quickly
locate and modify any bit of text, while Change Field... lets you add text to entire fields, or
move the contents of one field to another.

See also:
CONCEPTS
Journals
Keywords
Names
REFERENCE
Keywords Window
Journals Window
Names Window
Find & Replace Text
Change Field
SHORTCUTS
Keywords Window
Journals Window
Names Window
WORKBOOK
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Introduction
One of the main benefits of Papyrus is to automate the otherwise tedious task of preparing
bibliographies and inserting the corresponding reference citations into the text of your manuscripts.
You accomplish this by using Papyrus to insert placeholders into your manuscript as you compose it in your word processor. Then you tell Papyrus to process your manuscript. During this
step Papyrus builds a Group containing the references indicated by the placeholders. It then
creates a new copy of your manuscript in which the placeholders have been replaced by the
appropriate in-text citations, and to which the bibliography has been appended.
In this chapter you will create a short manuscript, sprinkle some Papyrus placeholders throughout it, and have Papyrus process it. I will also introduce you to some of the more common
special cases that can arise.

Overview
Before I walk you through the actual steps here, let me provide a bit more detailed overview of
the entire process.

Preparing your manuscript
Suppose that you are hard at work in your word processor, preparing your epochal work on,
say, recent advances in the neuroanatomical basis of humor. You reach the end of a sentence,
and feel the need to cite a reference. You must now insert a placeholder for that reference into
your manuscript:
...Surprisingly, humor has occasionally been identified even among certain senior
researchers.[[2]]

We refer to the double brackets, [[ and ]], as delimiters. By default Papyrus expects you to use
double brackets for your delimiters, but you are free to change these to any character or characters you prefer.
Within the delimiters appears either the Papyrus Reference # or ID Field corresponding to the
desired reference.
A placeholder can also include additional information inside parentheses. Papyrus will ignore
this information when it processes your manuscript, but in the meantime it can help you recall
which reference is being cited:
...Surprisingly, humor has occasionally been identified even among certain senior
researchers.[[2 (Laszlo et al 1991)]]
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You can also cite multiple references at a single point, by including more than one Reference #
within your placeholder:
...But several studies [[4 (Ramasubramanian & Martin 1979); 5 (Ramasubramanian &
Mull 1979); 6 (Ramasubramanian 1992)]] have shown that such attitudes can be changed.

If you have memorized all of your favorite Papyrus Reference #s (or ID Fields), you can simply
type your placeholders yourself. But most of the time you will let Papyrus assist you in inserting placeholders.
First you switch to Papyrus and locate the appropriate reference. If you know the initial author
you can quickly find the reference in the All References window; if not, you can perform whatever sort of search you desire. Once you have found the reference you simply drag it to your
word processor window—the appropriate placeholder will now appear in your text.

Processing the manuscript
Okay, so now the first draft of your manuscript is complete, including plenty of placeholders
throughout. It’s time to print a copy for your co-workers to review.
In Papyrus, you go to the Group menu and choose Process Manuscript... In the resulting dialog you point Papyrus to your word processor document and indicate which Papyrus output
format pertains.
Now Papyrus will create a new Group for your manuscript’s bibliography. As Papyrus reads
through your manuscript, it adds to this Group each of the references mentioned in your placeholders.
Next Papyrus creates a copy of your manuscript in which each of the placeholders has been
replaced by the appropriate in-text citation. The appearance of this citation is controlled by
your output format. For example, if you are using APA format you will get author-year citations:
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...Surprisingly, humor has occasionally been identified even among certain senior
researchers (Laszlo, Snooks, & Old, 1991).

Other formats, such as Vancouver, instead demand a superscripted number:
...Surprisingly, humor has occasionally been identified even among certain senior
researchers.13

Finally, at the end of this new copy of your manuscript Papyrus will insert the properly-formatted bibliography of your cited references. These will be in either alphabetic or citation order,
as indicated by your chosen output format.
Now that your new manuscript is ready, you can either delete the Group that Papyrus has just
created, or else save it for future use. In most cases you will want to save it, since you are
probably not yet finished with this particular manuscript...
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Revising
Your ever-helpful colleagues will no doubt have a few constructive criticisms regarding your
work. To implement their suggestions you must now return to the original copy of your manuscript—the one with the placeholders.
Make any changes to the manuscript you wish, including adding or removing placeholders.
After a short time (one hopes!) you will be ready to print a second draft.
You now repeat your previous steps, telling Papyrus to again perform its Process Manuscript...
function. If you saved the Group from last time, Papyrus will still remember the name of your
word processor document and which output format to use.
Papyrus now creates a new copy of your second draft, complete with appropriate in-text citations
and final bibliography.
You can repeat this cycle as many times as necessary. Just remember:
Always make your revisions to the original copy of your manuscript—the
one with the placeholders.
Once everyone is happy with the final manuscript, you can now send it off to the leading journal
in your field. All that remains is to prepare your acceptance speech for next year’s awards
ceremony.

Resubmitting
Alas! Apparently ignorant philistines have seized control of the leading journal in your field.
Your manuscript has been returned to you.
Do not take this setback personally. Instead, follow the example of other famous scholars. Go
back to Papyrus and once again choose Process Manuscript... Change the output format to, say,
Psychology Today, allow Papyrus to process your manuscript, and mail off the results.

Inserting placeholders
To begin with this chapter’s exercise, launch your word processor and begin typing an article.
For now you can type complete nonsense if you like; just pretend that you are working on your
next claim to fame.
At some point, you decide that you need to cite a reference. Let’s suppose that you have just
typed:
These findings have been confirmed.
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Now switch over to Papyrus. Open the All References window and select a reference. For
example:

What you do next depends on your particular word processor. If it is reasonably modern then it
should support drag/drop. Try for yourself: drag the selected reference from the All References
window to your word processor window, dropping it at the end of the sentence you just typed.
If your word processor supports drag-and-drop, a placeholder should now appear:
These findings have been confirmed.[[4 (Ramasubramanian & Martin 1979)]]

If dragging doesn’t work with your word processor, then you can fall back to copy/paste. In
Papyrus, with the reference selected in the All References window choose Copy from the Edit
menu. Then switch back to your word processor and Paste.
Next we will insert a placeholder citing three references. Go ahead and type a few more sentences in your word processor “manuscript.” Now return to Papyrus and select three references
in the All References window:
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Remember: hold down the Shift key while clicking with your mouse to select a contiguous block of references; hold down the  key
Ê while clicking to make a non-contiguous
selection.

Using either drag/drop or copy/paste, bring this selection of references into your word processor manuscript:
A number of silly studies have made such claims.[[1 (Runson & Rogerstein 1990); 3
(LaFièvre 1992); 6 (Ramasubramanian 1992)]]
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Now save your word processor document, and then close the document’s window. (If your
document is left open in your word processor, Papyrus might not be allowed to access it in our
next step.)

Processing the manuscript
Now that you have created, saved, and closed your magnum opus, switch back to Papyrus and
from the Group menu pick Process Manuscript... Papyrus will ask you to point out your word
processor manuscript. Once you have done so, you will be presented with this dialog:

Note that Papyrus automatically suggests a name for the new copy of your word processor
document that is about to create. By default, Papyrus simply appends new to the end of the
name of your original document. If you would prefer some other name, click the corresponding
Change button.
In the upper right corner of the dialog Papyrus identifies the document’s creating word processor (in our example above we have chosen a fairly obscure word processor from a small company
in the western U.S.). If you see Unrecognized document type, then you have used a word processor that Papyrus does not currently understand.
Unfortunately, at this time one such unsupported word processor is AppleWorks (formerly ClarisWorks). We have made repeated attempts to convince Apple to share the
AppleWorks file format with us, but for no clear reason Apple has refused to do so.
Should that decision ever be changed, we look forward to adding full AppleWorks support to Papyrus.
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In the meantime, should you chose to complain about this situation to your friend at a
major Macintosh magazine, or to your aunt who sits on Apple’s board of directors, who
would I be to limit your freedom of speech?

Having established the document that Papyrus is about to process, we must next tell Papyrus
which output format it is to use for this manuscript. The suggested STANDARD format is unlikely to satisfy any editor. So click the Change button beside Master format.
Papyrus will present a list of the output formats you have so far added to your database. Pick
any one you like—I’d suggest you avoid the three built-in formats—and click the Select button.
For now, we are not going to concern ourselves with the Initial footnote format nor the Subsequent footnote format. The remaining options regarding placeholders and inserting the
bibliography are also fine for now.
Click the Layout... button. The resulting dialog should look familiar to you:

This is just a simplified version of the usual Papyrus dialog for printing or exporting a list of
references. The usual questions about base font, margins, headers, etc. are missing, since these
details will be determined by the word processor document into which Papyrus is about to
insert this bibliography.
Change anything here that you wish, then click OK. Now in the Process Manuscript dialog
click Proceed.
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Papyrus will open a new Group window for your bibliography. What happens next depends
on your word processor. For some word processors (such as Word 5) Papyrus simply makes its
own revised copy of your manuscript. With others (including Word 6, Word 98, and Nisus
Writer) Papyrus actually uses your word processor as a tool to perform the revisions. In these
cases you will see:

You should heed this warning!
Depending on the word processor involved, you may next be treated to a bit of a show as
Papyrus jumps back and forth to your word processor to process your document.
When the smoke clears, Papyrus will have filled in your new Group with the appropriate references, in the appropriate order. In your word processor you can now view the newly created
copy of your manuscript, and confirm that the placeholders have been replaced with the correct in-text citations, and that the bibliography appears at the end of the document, in the right
format.

Common special cases
After you have inserted a placeholder into your manuscript, circumstances might require you
to type a few extra characters inside that placeholder. Here are a few of the more common such
situations.

Citing just the year
Often you will wish to display only the citation’s year, because its authors have already been
mentioned in the text. For example:
...as LaFièvre has pointed out (1992)...

To accomplish this, insert the letter y (or Y, if you prefer) immediately after the starting delimiter. This stands for year only. Thus, to generate the preceding line you would include in your
manuscript:
...as LaFièvre has pointed out [[y 3 (LaFièvre 1992)]]...

This also works for multiple citations. This:
...as LaFièvre has pointed out [[y 3 (LaFièvre 1992); 27 (LaFièvre 1985)]]...

becomes:
...as LaFièvre has pointed out (1985, 1992)...

Additional text
Sometimes you will need to include some additional text within a citation. For example:
...as we have seen (especially in Laszlo et al. 1991, but also in LaFièvre 1992)...

You can specify such text within your placeholder by using curly braces ({...}):
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...as we have seen [[{especially in }2 (Laszlo et al 1991){, but also in }3 (LaFièvre 1992)]]...

Page numbers
Usually you can use this same technique for citing particular pages within a work. For example,
to end up with:
...although there is some disagreement on this point (LaFièvre 1992, p. 17)...

you would begin with:
...although there is some disagreement on this point [[3 (LaFièvre 1992){, p. 17}]]...

There are, however, sometimes more complicated situations. We’ll cover those elsewhere.

Inserting formatted references
Inserting formatted references automatically
In some cases you will want Papyrus to convert a placeholder in your manuscript not to a
superscripted number or a parenthetical author-year citation, but rather to a formatted reference. For example, perhaps you need to include a reference in a bottom-of-the-page footnote.
Or maybe you’d like a complete reference to appear in the caption of a table.
Inserting the letter f (or F) immediately after the starting delimiter of a placeholder tells Papyrus
to replace the placeholder with a formatted citation.
You might recall that the Process Manuscript dialog specifies two formats besides the “master”
format:
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Most style books that describe the use of footnotes present two different sets of rules for formatting the footnotes: one set for the first time a given reference is cited, another for subsequent
citations of the same reference. For example, an initial citation might appear in the form:
H. LaFièvre, Why Nothing is Funny: A Deconstructionist Analysis, 2nd ed. (Cambridge:
Harvard University Press, 1992), 43.
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while a subsequent citation to this reference in the same manuscript would be much abbreviated:
LaFièvre, Why Nothing is Funny: A Deconstructionist Analysis, 52.

When you use a placeholder with an f, Papyrus will automatically substitute either the “Initial”
or the “Subsequent” format you have specified, depending on whether this is the first appearance of a particular reference in your manuscript.
Of course, the examples above are not in STANDARD and COMPACT format. They are
based on the Turabian formats for footnotes, which will be familiar to most graduate
students. The corresponding predefined Papyrus output formats are named TUR FOOT1
and TUR FOOT2.

Inserting formatted references manually
Sometimes you simply want to paste a formatted reference directly into a word processor document, without worrying about Process Manuscript. Sometimes you need to quickly paste a
couple of references into an e-mail you’re sending to a colleague.
Now I must tell you a secret. Every time in this chapter I have told you to drag/drop or copy/
paste a reference from Papyrus to your word processor, you have actually been taking advantage of a shortcut in Papyrus. It is now time for you to learn the rest of the story.
In Papyrus, select a reference in the All References window, or in a Group window. From the
Reference menu pick Cite...

If you click OK at this point, Papyrus will insert the usual placeholder for this reference into the
clipboard. You can see a preview of that placeholder here in the lower portion of the Cite dialog.
The effect, in other words, will be identical to what you’ve been accomplishing by simply copying a reference in Papyrus and then pasting it into your word processor.
But now click the Format 1 button:
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As the preview demonstrates, if you click OK now, the clipboard will contain the full reference,
in STANDARD format. Try it for yourself—click OK, switch to your word processor, and paste.
As you have probably guessed, clicking Settings... takes you to a dialog in which you can specify
the two formats to be offered by the Cite dialog. You can also indicate several other preferences.
A full explanation of the options available in the Cite Settings dialog is available in the Citing
references chapter of the REFERENCE section.
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See Also...
You now understand the basics of inserting placeholders for references into your manuscripts,
and using Process Manuscript to simultaneously convert these to the appropriate in-text forms
and append the finished bibliography to the manuscript.
Papyrus includes a number of additional options for coping with the many special cases that
can arise in preparing a manuscript. For all the details, you will want to read the next two
chapters of the WORKBOOK, as well as the REFERENCE chapters indicated below.
See also:

CONCEPTS
Bibliographies vs. Footnote Lists
Output Formats
Bibliographic Conventions
Groups
REFERENCE
Citing References
Process Manuscript
SHORTCUTS
Cite Dialog

W128 Working with Manuscripts

CHAPTER 12

Specific Pages

Introduction ...................................................... W130
The usual approach ........................................ W130
The perverse approach .................................. W131
Modifying your output format ........................ W132
See Also... .......................................................... W133

WORKBOOK

Chapter 12: Specific Pages

W129

Introduction
Almost all bibliography editors agree that when your bibliography includes an entry for a lengthy
work, such as a book or monograph, the bibliography entry should refer to the entire work and
not to some particular page or pages of interest.
It is therefore within the manuscript’s in-text citation that specific pages are mentioned:
...though not everyone agrees with this finding (LaFièvre 1990, p. 27).

or:
...though not everyone agrees with this finding.3(p.27)

Every now and then, though, you will encounter a bibliographic style that instead expects you
to include specific pages within the bibliography entry itself:
3. LaFièvre, H. (1990): A Refutation of Antideconstructionism, 3rd ed. Harvard University Press, Cambridge. p. 27.

This can lead to ugly situations. Suppose that later in your manuscript you refer to a different
page from the same book. You will now have to create a second entry in your bibliography that
refers to this other page:
3. LaFièvre, H. (1990): A Refutation of Antideconstructionism, 3rd ed. Harvard University Press, Cambridge. p. 27.
...
19. LaFièvre, H. (1990): A Refutation of Antideconstructionism, 3rd ed. Harvard University Press, Cambridge. p. 92.

Still, there are some bibliography editors who seem to prefer this sort of redundancy to cluttering up their in-text citations.

The usual approach
When you use Papyrus’s Process Manuscript function to automatically scan your word-processor manuscript, you can include specific page numbers in the in-text placeholder:
...though not everyone agrees with this finding [[42 (LaFièvre 1990){, p. 27}]].

This is actually just an application of the more general ability to include any sort of additional
text within a placeholder. The text within the curly braces will be maintained in the new in-text
citation:
...though not everyone agrees with this finding (LaFièvre 1990, p. 27).
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The perverse approach
To satisfy those few editors who prefer to see all page numbers relegated to the bibliography
itself, Papyrus provides both a manual and an automatic solution.
If you are manually assembling a Group, you can indicate that a particular item refers to specific pages of a reference. First, select the relevant item in the Group window:

Then choose Specific Pages... from the Group menu. This will produce a dialog box:

Fill this in:

If later you need to change these specific page numbers, or remove them, you can again choose
Specific Pages... to bring back the above dialog. There you can change or erase the page numbers.
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and click Okay. An indicator will now appear in the Group window to confirm that this item is
citing specific pages:

Later when you tell Papyrus to create a bibliography from this Group, the specific pages will
appear there:
LaFièvre, H. A Refutation of Antideconstructionism. 3rd ed. Cambridge: Harvard University Press, 1990. p. 27.

•

•

•

You can also insert specific page numbers into your bibliography when you use the Process
Manuscript function to automatically scan your word-processor manuscript.
To accomplish this, insert the letter P after the reference in your placeholder, followed by the
specific page numbers:
...though not everyone agrees with this finding [[42 (LaFièvre 1990)p27]].

Modifying your output format
Regardless of whether you specify these page numbers manually or automatically, for them to
actually appear in the final bibliography you must be sure to use an output format that explicitly includes the Specific pages field. For example, if we look at the Book template of the
CHICAGO A format, we do not see any mention of Specific pages:

So to produce a bibliography that resembles CHICAGO A but that will also mention specific
page numbers where appropriate, we must modify the output format:
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See Also...
As you have learned, dealing with citations to specific pages can be simple or complex, depending
on the demands of your editor. Either way, though, Papyrus can help you through the task.

See also:
CONCEPTS
Bibliographies vs. Footnote List
Output Formats
Bibliographic Conventions
Groups
REFERENCE

Chapter 12: Specific Pages
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Citing References
Process Manuscript
Template Entry
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Introduction
Some editors in fields such as chemistry or physics, as well as those of a few other crowded
journals such as Science, apparently feel compelled to squeeze as much text as possible onto
every page. So when these editors see several references being cited at a single point in a manuscript, they expect you to combine all of them into a single item in the bibliography:
...but completely contradictory results have also been shown.12
12. M. A. Spoon, Cancer Res. 31, 4819 (1987); L. U. Wartsburg, Cell 82, 234 (1990); A.
Cramer, CA Cancer J. Clin. 47, 15 (1997).

This approach is understandable, I suppose, but it can lead to some complications. For example,
suppose that later in the above-excerpted manuscript another sentence refers to just one of
these three references. Since our parsimonious editors would certainly object to listing the same
reference twice in a bibliography, we must now pull the commonly-cited work out of the original citation:
...but completely contradictory results have also been shown.12,13
...Meanwhile, one group did indeed confirm these findings.12
12. L. U. Wartsburg, Cell 82, 234 (1990).
13. M. A. Spoon, Cancer Res. 31, 4819 (1987); A. Cramer, CA Cancer J. Clin. 47, 15
(1997).

There is also a question of how to sort the references within one of these multiple citations. My
impression is that they are to be listed in chronological order, but I have never seen this rule
stated explicitly.
As you have perhaps surmised, Papyrus can handle all of this.

Manual approach
When you prepare a Group of references, you can manually indicate that some of them are to
be cited together in the resulting bibliography.
First, select the references that are to be cited together:
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Then choose Cite Together from the Group menu. Papyrus will mark these references to indicate that they will be cited together in the bibliography:

WORKBOOK

If later you decide to cite these references as separate entries in the bibliography after all, you
can select one or more of them and choose Cite Separately from the Group menu.
Of course, this entire discussion applies only to Groups that are sorted in Citation Order.
If your bibliography were to be sorted in, say, alphabetic order, then you certainly wouldn’t
be asked to combine multiple references into a single bibliography entry.
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Automatic approach
When you use the Process Manuscript function to automatically scan your word-processor
manuscript, you can tell Papyrus to cite multiple references together:

Papyrus will automatically combine references as described above, sorting each set in chronologic
order. Where necessary Papyrus will also pull out commonly-cited references and give them
their own separate bibliography entries.
If for some reason you do not want Papyrus to chronologically sort a given set of combined references, use the suppress sorting option in that placeholder.
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See Also...
Most of you will never need to worry about the issues discussed in this chapter. But if you
publish in chemistry, physics, or another field in which journal editors like to cram everything
into as few bibliographic entries as possible, you know now how to satisfy such whims.

See also:
CONCEPTS
Bibliographies vs. Footnote Lists
Output Formats
Bibliographic Conventions
Groups
REFERENCE
Group Window
Process Manuscript
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Introduction
Papyrus lets you establish links between your keywords. For example, you can declare that
one keyword represents a sub-category of another keyword. You can tell Papyrus that two
keywords are synonyms, or even antonyms. Or you can indicate any other relationship you
desire.
There are two things you can do with these links. First, when you perform a search based on
keywords you can tell Papyrus to follow some or all keyword links. For example, a search on
the keyword Cute fuzzy animals would succeed in finding a reference lacking that particular
keyword but bearing the keyword Koala (assuming that you had previously linked those two
keywords).
The other main use of keyword links is to help you in choosing keywords to assign to a new
reference, or to use in a search. The Keywords window can be set to automatically display links
as you browse through your list of keywords. So as you consider a particular keyword, you’ll
be reminded of other keywords that might be more specific or otherwise more appropriate.

Creating a link
Let us begin by opening the Keywords window:

We are going to link Surgery and Neurosurgery. Begin by selecting either one of these, and then
click the Links window button. A Keyword Links window will open for your selected keyword:

W142 Links

Now select the other keyword in the Keywords window, and drag it to the Keyword Links
window. This dialog will appear:

The Keyword Links window now displays our new link:
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Here is where we indicate the nature of our new link. The first choice of link types would be
appropriate if Neurosurgery were a super-category of Surgery. But the reality is just the opposite. So with your ↓ key or your mouse select the second link type, which indicates that
Neurosurgery is the sub-category and Surgery the super-category. Then click the Link button.

The numbers in brackets are the same numbers that appear in the Keywords window—
they indicate how many references in your database cite each of these keywords.

Let’s go a bit further here. Since there is nothing funny about neurosurgery, drag Humor from
the Keywords window to the Keyword Links window—but be careful to drop it directly onto
Neurosurgery rather than elsewhere in the window. Our new link is to be with Neurosurgery,
not Surgery.
When asked, indicate that these are antonyms:

In the Keyword Links window, a triangle now appears next to Neurosurgery, indicating that
this keyword has links of its own (besides the implied back-link to Surgery):

Click that triangle and all of Neurosurgery‘s links will be displayed:
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In other words:
Surgery has one link—to a sub-category, Neurosurgery.
Neurosurgery has two links. The first is a link to a super-category, Surgery—
this is actually the same link as the one from Surgery to Neurosurgery, seen
from the other end. The second of Neurosurgery’s links is to an antonym, Humor.
So to create a link between two keywords the steps are:
• Open a Keyword Links window for one of the two keywords.
• Drag the other keyword to that Keyword Links window.
• Pick the appropriate link type.

Removing a link
Linking Humor to Neurosurgery has a certain appeal, but we’d better remove that link to keep
our database appropriately serious.
In the Keyword Links window, select Humor:
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Now press your Delete key, or choose Clear from the Edit menu.
That’s all there is to it. The link has been erased.
We are done with this Keyword Links window for now. Please close it.

Links in the Keywords window
In the Keywords window click the Show Links button. Then select one of our linked keywords:

The pane in the lower part of the window is a miniature rendition of a Keyword Links window
for whichever keyword is selected in the upper pane. You can switch between the panes with
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your Tab key, and when the lower pane is active your ↑ and ↓ keys will do what you’d expect.
Of course, you can also use your mouse to select keywords in the lower pane, or to click the
little triangles there.
If you select a keyword in the lower pane, the Edit..., Delete, Select, Quick Find and Links
Window buttons all work as usual. You can also drag a keyword from the lower pane to another window, just as you can from the upper pane.
So now when you are considering a keyword for inclusion in a search or for addition to a
reference, you can easily view all of its linked keywords and think about using one of them
instead of, or in addition to, the original keyword.
To get rid of the lower pane, click the Hide Links button.

Searches
Now let’s see if we can put these fancy links to use, shall we? We’ll perform the same keyword
search twice, first ignoring links and then using them.
From the Reference menu choose Find... Run this search:
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Papyrus will find the one reference bearing the keyword Surgery. So far, so good.
Now choose Find... again and set up the same search. But this time click the Follow keyword
links checkbox. A few new items will appear:

Chapter 14: Keyword Links

W147

This question about “levels” relates to the number of links you want Papyrus to traverse. For
example, if Surgery has the sub-category Neurosurgery, and Neurosurgery in turn has a link to
the sub-category Laminectomy, then following only 1 level of keyword links would pick up any
references with Neurosurgery but not those bearing only Laminectomy. Following 2 levels would
pick up all of these references.
Click the Links... button. Papyrus now asks which types of link you wish to follow:

The default setting is to follow any and all links. If you instead choose Only these: then you can
pick which types of link to follow. For example, you might wish to exclude antonyms from your
search.
Click the OK button, and then click the Find button to proceed with your search. This time
Papyrus will find not only the one reference bearing the keyword Surgery, but also a second
reference that lacks this keyword but which does cite the linked keyword Neurosurgery.
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See Also...
The techniques you’ve just learned for creating links between keywords allow you to create not
just a hierarchy of terms and subterms, as you might find in many library or online database
systems, but a complex web of interconnections.
You can review the indicated CONCEPTS chapters for more about the possibilities here. The
REFERENCE and SHORTCUTS chapters provide some further details on manipulating keyword links.

See also:
CONCEPTS
Keywords
REFERENCE
Keywords Window
Keyword Links Window
SHORTCUTS
Keyword Links Window
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Introduction
In the last chapter you learned about creating and using links between keywords. Papyrus also
lets you establish links between references.
One type of a reference link that we’ve already covered in the WORKBOOK is to link a reference to
notecards.
Another use of reference links would be to link a reference to another reference that is a review
or commentary on the first. You might also choose to link a newer study to an older one with a
link indicating follow-up or confirming study or refutation.
Some people use references to trace the history and sociology of a field of scholarship. For this
type of work, it might be useful to link references to indicate that the primary author of one was
a student of the primary author of the other.
Reference linking is a new concept for bibliographic database programs. We
look forward to hearing what uses you find for it!
As with keyword links, when you perform a search you can tell Papyrus to follow some or all
reference links. Papyrus will find all references based on your search criteria, and then also
include in the results all related references (notecards, reviews, commentaries, etc.)
Similarly, any time you have Papyrus print or export some references, you can also direct it to
include linked references.

Creating a link
Let us link together two of our references. Specifically, this one:
2. Laszlo,JA; Snooks,Barbara B; Old,DH (1991): Unconscious punning among medical
researchers. In: Sublimation and Compensation. (Jung,CG; Old,DH, eds.) Pergamon
Press, New York, 102–129.

is a review article that cites this one:
1. Runson,SK; Rogerstein,BT (1990): The judicious use of nitrous oxide in the treatment of Grave’s disease. New Engl. J. Med. 182, 254–267.

Open the All References window and select Reference #1. Then click the Links window button.
This new window will appear:
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Now return to the All References window and select Reference #2. Drag this reference to the
Links window to tell Papyrus that you wish to link the two references. Papyrus will ask what
type of link you intend:

We want to pick the fourth choice, which indicates that Laszlo et al. is a review, and Runson &
Rogerstein the work reviewed. So select this fourth choice and click the Link button.

In the Links window, Papyrus now displays your new link:
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These two link types—Reference/Notecard and Review/Work reviewed—are already defined
for all Papyrus databases. You can create your own additional link types by clicking the New
link type... button.

So to create a link between two references the steps are:
• Open a Links window for one of the two references.
• Drag the other reference to that Links window.
• Pick the appropriate link type.

Removing a link
Getting rid of a link between references is quite easy. In the current Links window, use your
mouse or arrow keys to select Reference #2. Then press your Delete button, or choose Clear
from the Edit menu. Voilà—the link is gone.
But for now let’s restore the link. From the Edit menu choose Undo Clear.

The Links window
You can manipulate the references in a Links window much as you would in the All References
window or in a Group window. If you select a reference you can edit it, either via the Reference
menu or with the usual Option-double-click shortcut. You can delete a reference from your
database, or cite it in a manuscript. You can also use the Links window button to open another
Links window for any of the references.
The default format used in the Links window is COMPACT. You can switch between this format and STANDARD by double-clicking a reference.
Double-click the
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button to see what else you can do in the Links window.

Searches
Now let’s confirm that our new link behaves correctly during a search.
Choose Find... from the Reference menu. Tell Papyrus to search for:

Now check the Include linked items checkbox. Some new items will appear:

Telling Papyrus to follow 1 level of links means that we want to see the references that are
linked directly to those found by the search. If we changed this to 2 levels we would also get the
references linked to those references.
You can control what types of links Papyrus will follow. Click the Links... button and this dialog
appears:

For now click OK to accept the default. Then click the Find button to run your search.
The result of your search should indeed include not only the one reference with Runson as an
author, Reference #1, but also the reference linked to that one, Reference #2.
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The default setting is to follow all types of links. If you click Only these: then you can pick
exactly which link types are relevant.

Printing
When you print or export references, you can tell Papyrus to also include linked references in
your output:

Clicking the Links... button brings up a dialog you’ve seen before:

As with searches, you can tell Papyrus to include all linked references, or else you pick the
specific types of links you wish to follow.
Unlike with searches, you cannot have Papyrus print/export more than one level of
links.

The printed/exported document will indicate links via indentation:
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References
1. Runson,SK; Rogerstein,BT (1990): The judicious use of nitrous oxide in the treatment of Grave’s disease. New Engl. J. Med. 182, 254-267.
Review:
2. Laszlo,JA; Snooks,Barbara B; Old,DH (1991): Unconscious punning among
medical researchers. In: Sublimation and Compensation. (Jung,CG; Old,DH, eds.)
Pergamon Press, New York, 102-129.

See Also...
We’ve just scratched the surface of what you can do with reference links. While many of you
will have no need to use these features, we hope they will prove valuable to those of you who
are interested in studying the interconnections amongst your data.

See also:
CONCEPTS
Notecards and Linked References
REFERENCE
Reference Links Window
Print/Export
Find
WORKBOOK

SHORTCUTS
Reference Links Window
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Introduction
The best way to explain this feature is with an example:

References
Fièvre,H
3.

LaFièvre ‘92: Why Nothing is Funny: A Deconstructionist Analysis

Laszlo,J A
2.

Laszlo &c; ‘91: Unconscious punning among medical researchers

Martin,S
4.

Ramasubramanian,Martin ‘79: Eclectic neurosurgery, Part I: Excision of inhibitions

Mull,M
5.

Ramasubramanian,Mull ‘79: Eclectic neurosurgery, Part II: Implantation of healthy
attitudes

Old,D H
2.

Laszlo &c; ‘91: Unconscious punning among medical researchers

Ramasubramanian,S R
6.

Ramasubramanian; ‘92: Eclectic neurosurgery

4.

Ramasubramanian,Martin ‘79: Eclectic neurosurgery, Part I: Excision of inhibitions

5.

Ramasubramanian,Mull ‘79: Eclectic neurosurgery, Part II: Implantation of healthy
attitudes

Rogerstein,B T
1.

Runson,Rogerstein ‘90: The judicious use of nitrous oxide in the treatment of Grave’s
disease

Runson,S K
1.

Runson,Rogerstein ‘90: The judicious use of nitrous oxide in the treatment of Grave’s
disease

Snooks,Barbara B
2.

Laszlo &c; ‘91: Unconscious punning among medical researchers
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This is a cross-reference list by Author. As you can see, Papyrus has listed all of the authors in
our sample database in alphabetic order. After each author’s name, all references by that author
are then shown.
Papyrus’s Cross-Reference List function can produce this sort of list based on Author, Year,
Keyword, or any other field that is indexed in your database. The most commonly cross-referenced fields are Author and Keyword.

Full Author list
To create the list I just showed you, go to the File menu and choose Cross-Reference List... This
dialog will appear:

For now it is indeed the Author field that we wish to cross-reference, so leave the Field pop-up
menu as is. The From and Through settings default to starting with the first author in the
database and proceeding through the final author, which is also fine for now.

Now click OK. The usual Papyrus Print/Export dialog will open. For my example list I changed
the indicated format to COMPACT. Go ahead and try printing the list for yourself.

Partial Keyword list
This time we’ll print a cross-reference list based on keywords. But we will limit the list to only
those keywords starting with a letter between N and S.
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The Item sorting section controls the arrangement of each author’s batch of references. In the
list on the previous page, you can see that the Ramasubramanian references were indeed sorted
alphabetically, the default setting here.

This is a rather arbitrary choice of keywords, to be sure. With a real database a more
meaningful example might be to stick to keywords beginning with Neuro.

So choose Cross-Reference List... once more. This time fill in the dialog as follows:

Just for variety, let’s set the sorting to Chronologic.
Proceed with the Print/Export, and the results should resemble this listing:

References
Neurosurgery
5.

Ramasubramanian,Mull ‘79: Eclectic neurosurgery, Part II: Implantation of healthy
attitudes

6.

Ramasubramanian; ‘92: Eclectic neurosurgery

Politics
7.

Chapter 1: Humor as fiction

Review Article
6.

Ramasubramanian; ‘92: Eclectic neurosurgery

Success
6.

Ramasubramanian; ‘92: Eclectic neurosurgery

Surgery
5.

Ramasubramanian,Mull ‘79: Eclectic neurosurgery, Part II: Implantation of healthy
attitudes
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See Also...
Cross-Reference List... is pretty much a one-trick pony. But when you do need this sort of list
Papyrus makes it very easy for you to obtain it.

See also:
CONCEPTS
Indexes
REFERENCE
Print/Export
Cross-Reference List
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Introduction
Let us begin with an example:
References
1.

Runson,Rogerstein ‘90: The judicious use of nitrous oxide in the treatment of Grave’s
disease

2.

Laszlo &c; ‘91: Unconscious punning among medical researchers

3.

LaFièvre ‘92: Why Nothing is Funny: A Deconstructionist Analysis

4.

Ramasubramanian,Martin ‘79: Eclectic neurosurgery, Part I: Excision of inhibitions

5.

Ramasubramanian,Mull ‘79: Eclectic neurosurgery, Part II: Implantation of healthy
attitudes

6.

Ramasubramanian; ‘92: Eclectic neurosurgery

LaFièvre,H: 3
Jung,CG: 2
Laszlo,JA: 2
Martin,S: 4
Mull,M: 5
Old,DH: 2
Perish,N: 6
Ramasubramanian,SR: 4, 5, 6
Rogerstein,BT: 1
Runson,SK: 1
Snooks,Barbara B: 2

What we have here is a normal list of references (in COMPACT format in this case), followed by
an index of the authors and editors. After each person’s name in the index are shown the
Reference #s of the corresponding references in the list above.
This sort of reference list with index is useful when you are publishing a large bibliography by
itself—a comprehensive list of references on a given topic, say, or all of the references published
by your department in the past year. The reference list itself will be sorted alphabetically or
chronologically; the author/editor index will allow readers to locate all publications by a particular person.
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Similarly, a keyword index would come in handy in locating precisely those references that
relate to a specific subtopic.
Papyrus can create this sort of index for almost any field in your database.

Producing a List with Index
Begin by selecting the references to be listed. To create the list on the previous page, I opened
the All References window and selected References #1 through #6. You might do the same now.
Then from the File menu pick List with Index... Here is the resulting dialog:
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If you click OK, then you can proceed to produce the same list and index that I did. But feel free
to experiment with the various settings here. The sample index entry in the dialog will change
to reflect your adjustments.

See Also...
List with Index is fairly self-explanatory. A few experiments should clear up any questions you
may have.
You can find some more details about the various options here in the REFERENCE section.

See also:
REFERENCE
Print/Export
Indexed List
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Introduction
This is the first of a series of chapters that deal primarily with Papyrus formats. The following
chapters get into increasingly arcane aspects of designing formats for importing references into
Papyrus. This chapter, though, addresses the more mundane topic of making your bibliographies pretty.
In addition to the examples I’ll give in this chapter, remember that we have
also provided you with several collections of predefined formats, contained
in Format Libraries. The Formats, Format Libraries and Predefined Formats
chapter of this WORKBOOK explains how to copy formats from these Libraries
into your own Papyrus database. Once copied, you can use the format editing features that we are about to discuss to examine these formats in detail.
For a general discussion of formats, be sure to read the Output Formats chapter in the CONCEPTS
section.
In the present chapter I will walk you through the creation of four sample formats:
VANCOUVER, CHICAGO A, AM ANTIQ and TABLE. Complete versions of the first three
can be found in our supplied Format Libraries; each represents a different field of scholarly
endeavor. The fourth, TABLE, is an example of a Papyrus tabular output format.
I have arranged the parts of this chapter in increasing complexity, and you will benefit from
working through all of them, even if some do not seem directly relevant to you right now.

VANCOUVER
The VANCOUVER format is the most commonly accepted style for biomedical journals. First
created by a group of journal editors in Vancouver, British Columbia, in 1978, the format is
documented in a series of publications. The one in front of me right now happens to be:
“Uniform Requirements for Manuscripts Submitted to Biomedical Journals”, JAMA, March
19, 1997, Vol. 277, No. 11, P. 927

You will find the complete VANCOUVER format in our BioMed Format Library.
Here is a sample Article portrayed in the VANCOUVER style:
13. Smythe AB, Jones CD. Physiology of the koala. N Engl J Med 1978;137:231-5.

This is a very straightforward format, though a bit terse.
•

•
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•

In Papyrus, begin by opening the Formats window and clicking the New... button. In the resulting dialog, fill in the format’s name and description like this:

The Format Type is correctly set to Output.
A format consists of several separate, interrelated sections. These are listed in the scrolling list
to the right. First are four general sections, which apply to all reference types. Following these
are a series of templates, one for each reference type.
All output formats need to fill in the four general sections. You will also usually want to
define at least the Article, Book and Chapter templates. For the rest, use your judgment.
For example, most medical journal styles do not bother specifying what to do for a Map
reference.
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VANCOUVER: Sorting & Citing
In the scrolling list, double-click Sorting & Citing. This will bring up the following dialog:

This dialog establishes how the references will be sorted in the bibliography, and the related
issue of how they will be cited in the text of your manuscripts.
For VANCOUVER, the default settings here are all correct. References appear in the bibliography in the order that they are first cited in the text. The in-text citations should be numbers in
parentheses, as illustrated in the samples appearing in the upper right pane of the dialog.
If you are familiar with the biomedical literature, you might have expected me to tell
Papyrus to put the in-text citations in superscripts, rather than parentheses. In fact,
most of these publications do indeed show the citation numbers superscripted. However, the published rules for the VANCOUVER format indicate that the author’s manuscript
is to be submitted with the citation numbers appearing in parentheses; the journal’s
typesetters will then convert these to superscripts.
Of course, these rules were originally promulgated before laser printers had become
ubiquitous. If you do use superscripts rather than parentheses in your manuscript, I
doubt that the editors will return it to you for correction.

There are a lot of options visible in this dialog, but most of them apply to formats in which the
in-text citations are by author and year, rather than number. So we’re done—click the OK button.
A checkmark now appears besides Sorting & Citing, indicating that you have dealt with this
section of the format.
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VANCOUVER: Numbering & Layout
Let’s proceed to Numbering & Layout. Either double-click that item, or else use your arrow
keys to select it and then press Return.

This dialog controls whether the references in the bibliography are to be numbered, and how
they should be indented. The default numbering method, Sequence #, is correct for
VANCOUVER.
The Reference # choice would never be used with a normal output format—few readers will be interested in the numbers you’ve assigned to references in your personal
Papyrus database. It does come in handy, though, for formats that you use in conjunction with maintaining your Papyrus database and reference collection. For example, all
three built-in formats—STANDARD, COMPACT and BRIEF—display the Reference #.

WORKBOOK

Reference ID field applies to the styles used in certain mathematics, computer science, physics, etc. journals. These prefer to cite references by part or all of the first
author’s name, plus an indication of the year, such as “Smith1997” or “SMIT97”.
The No number at all choice goes along with the in-text author/year citation method.

The remaining settings here are all fine for VANCOUVER. So click the OK button.
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VANCOUVER: Authors
Now double-click Authors to bring up this dialog:

Here we address the surprisingly thorny issue of how to display the names of authors. There
are four parts to this dialog. We currently see the Each name part. Once we have dealt with
these settings we will move on to Multiple names, and then Special cases and et al..
As is common in the sciences, VANCOUVER cares only about the authors’ initials, not their full
first names. However, in its terseness VANCOUVER uses the most compact punctuation for
those initials, so change the First name punctuation accordingly:

VANCOUVER gives the surname first for both the first author and subsequent authors, and
uses simply a space between them, so we must make these changes as well:
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If you’ve followed along with me so far, the preview pane should now look like this:

Okay, we’ve established the appearance of the individual author names. Now click the Multiple names button to move on to the next aspect of author display.

VANCOUVER uses a comma and space between each author and the next, so that’s what we
need to enter in each of three places available here:

WORKBOOK

Now click Special cases.
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As discussed elsewhere, when an article has no author given, as with many editorials, you
should enter Anon. for Author #1. This section of each output format determines whether Papyrus
should display this Anon. as is, or whether it should be suppressed. In the case of VANCOUVER
we do want to suppress an author of Anon., so check the Suppress author if “Anon.” checkbox.
But leave unchecked the other checkbox regarding shifting the Title into the Author position.
As for Repeated authors, VANCOUVER like most physical science styles always displays the
authors for all references, even when they repeat from one reference to the next.
Finally, click the et al. button. Fill in the resulting settings as follows:
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Note that by default, Papyrus italicizes et al. Since VANCOUVER does not, you must select the
et al. text and then go to the Style menu and choose Plain Text.
If you’ve done everything correctly, then your dialog’s preview panel should appear just as the
one above. Once you’re satisfied that it does, click the OK button.

VANCOUVER: Editors
Now double-click Editors. VANCOUVER specifies the same rules for editor names as for author
names. So fill in the dialog as follows.

WORKBOOK
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Actually, as with most bibliographic styles VANCOUVER does not address what you’re
supposed to do when there are an excessive number of editors. But I suspect that the
VANCOUVER creators would apply their Author et al. rules in such cases.

Once you’ve finished setting up the Editor section, click the OK button.
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VANCOUVER: Article in journal
We have now finished with the four general sections of the VANCOUVER format. Next we
need to create the templates for each reference type.
I will go into great detail about the Article template, and make a couple of points about the
Book template. The remaining templates will then be easy for you to understand on your own.
In the New Format window, double-click Article in journal (or select it with your arrow keys
and press Return). Here is the dialog that will result:

On the left is a list of all the fields that might arise for an Article. Many of these are seldom used,
obscure fields. In setting up our template we won’t concern ourselves with most of these, focusing for now just on the fields typically present when citing biomedical journal articles.

Our template will take form in the lower right pane. Here is what we’re about to create:

Chapter 18: Creating New Output Formats

W179

WORKBOOK

The top right pane shows a preview of the template. Note that even though we have not yet
begun to create our Article template, the preview already shows a Sequence # as previously
specified in the Numbering & Layout section.

As you can see, our template “spells out” the appearance of a typical Article. We get the various
fields from the field list, where they receive checkmarks as we use them. The intervening punctuation we simply type directly into the template.
So, to begin creating this template, double-click Author in the field list:

Next type a period and a space. Then double-click Title.
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Proceed in this fashion to create the entire template shown above.
If you’d rather not keep reaching for your mouse, you can use your Tab key to move
between the field list and the template. To select a field in the list you can use your
arrow keys, or you can type the first few letters of the field name. Once you have
selected a field, press Return to insert it into your template.

You’ll note that even though your template now matches the one shown above, the preview
appears a bit different:
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We need to establish a few more details here. So press—did you guess?—the Details button.

Many fields have details that can be adjusted. Of the fields we’ve used so far in our template,
Journal Abbreviation, Year, and Pages each offers a few options.
For Journal Abbreviation, the VANCOUVER format expects no periods. So click the Without
periods button.
The Abbreviation style option applies when your Papyrus database allows more than
one system of journal abbreviations. For example, the biomedical world uses one set of
abbreviations for journals, while the chemistry world has its own list. More about this
elsewhere.

Like most formats, VANCOUVER displays the Year in Full. The Suppress if non-numeric question mainly applies to works whose Year field is In press or the like. Some bibliography styles
do not want to see such a phrase in the usual Year position, so you can tell Papyrus to “suppress” them. But VANCOUVER does expect In press to appear in the usual position, so don’t
check this box.
Page numbers can be abbreviated in a ridiculous variety of ways, but Papyrus can deal with all
the popular methods we’ve so far encountered. VANCOUVER uses the Simple style, so click
that button.
Your preview should now be identical to the one I showed you above. So we’re done, right?
Well, not quite. The template we have now entered will work correctly for 95% of Articles. But
we need to make it a bit more sophisticated to handle the remaining 5%.
Click the Template button to return to the previous template view.
Although VANCOUVER does not usually want you to include an issue number for Articles,
there are some journals for which one must always do so. (See the Journals chapter in CONCEPTS
for a discussion of this.) So we need to provide for this possibility in our template:

W182 Printing and Exporting, Advanced

Switching back to the Details view there is now a new option available to us:

By leaving this box unchecked, we tell Papyrus that only certain journals need to have their
issue number displayed.
In your database’s collection of journals, each entry indicates whether citations to that
journal must always include the Issue. The same applies for Day & Month and for
Series. VANCOUVER is typical of scientific bibliographic styles in not requiring these
items if the Pages by themselves are sufficient to find the correct issue of the journal.

This is all well and good, but what about the majority of Articles for which no Issue was entered? According to our template above, Papyrus will end up displaying such references as:

Horrors! Those empty parentheses will never do. So Papyrus provides a way to deal with such
situations—the If First buttons:

Perhaps you’re wondering why these brackets are called If First rather than, say, If
Present.
In certain circumstances you might include more than one field within a single set of
brackets. If for a particular reference the first field is absent, then Papyrus will not
display the subsequent field(s) either.
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Those If First brackets will not actually appear in your bibliography. Rather, they surround
fields and punctuation that may or may not appear for any particular reference. In this case, if
a reference does have an Issue it will show up, with parentheses around it. But if there is no
Issue, then there will be no parentheses either.

This sort of thing comes up mostly with import formats rather than output formats, so
please don’t worry about it now.

We can use this same trick to accommodate Supplements (such as the Part 2 in 137(4 Part 2)):

In this case I have nested one set of brackets within another. If there is no Issue, then we won’t
even consider displaying the Supplement. But if there is an Issue, then we’ll follow it with a
space character only when a Supplement is also present. Actually, though, this is not really the
best way to handle Supplements—I’ll return to this topic in a moment.
Another reason to use If First brackets is to handle Articles that are still in press. In such cases
we will not have Volume, Issue, nor Pages to display. To prevent a lot of extraneous punctuation showing up, we can make these modifications:

So an Article still in press would yield:

Actually, the official VANCOUVER rules would prefer to see a period between New
Engl J Med and In press. Most editors, though, will accept this slight transgression
without returning your manuscript for correction.

Let’s now add another layer of complication. We’ve taken care of Articles in which the Issue
must be displayed, but what about those for which Day & Month is required? And what about
those that require both, perhaps with a Supplement thrown in for good measure? We could simply enter this:

But now any time there’s an Issue it will be followed by a comma, regardless of whether there is
a Day & Month or not. And if there is no Issue, but there is a Day & Month, we will not see either
of them—Papyrus only looks at the first field appearing within If First brackets in deciding
whether the entire bracketed contents will be displayed.

W184 Printing and Exporting, Advanced

Yuck! We’ve reached the limit of what we can do with If First brackets. So it’s time to introduce
a new trick—If Any brackets:

These new brackets work much like If First brackets, but they are smarter. In the above example,
the parentheses will show up only if either the Issue or the Day & Month or a Supplement—or
any combination of these—appears. In addition, the intervening punctuation will appear only
if both preceding and following fields are displayed. So this:

could yield any of the following, depending on which fields are present for a particular reference:

Although If Any brackets are smarter and sometimes cleaner than If First brackets, they involve
much more thought for Papyrus. They can therefore slow output down a little bit. Also, unlike
If First brackets, If Any brackets cannot be nested. For these reasons, you should use If First
brackets whenever possible, and reserve If Any brackets for situations such as the above.

Here’s yet another concern with which we must cope. You will run into some journals that over
time have fissioned into a bunch of separate journal series. For example, the American Journal of
Physiology includes one series on integrative physiology, another on endocrinology, etc. In
VANCOUVER format it is customary (as far as I have been able to figure out!) to include such
Journal Series information with the Issue:
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Now that I’ve made all these educational points, I need to correct something. VANCOUVER
actually puts the Day & Month, when present, after the Year, not the Issue. So let us rearrange
things accordingly:

And now, one final refinement. In case a reference contains information in its Also Print field,
let’s include that at the very end:

That takes care of the VANCOUVER template for Articles. Really.

VANCOUVER: Book/Monograph
Now I’ll show you how VANCOUVER‘s Book/Monograph template should appear:

Of course, the Details are also important:
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Most of this should make sense to you now, so I will just make a few points here.

The Spell “editor/editors” etc. settings allow you to indicate that a given format should display
these as ed./eds. or whatever rather than using the full words.
Note that although you can use the separate fields Publisher and City of Publication, Papyrus
offers a combined “field” for templates, Publishers & Cities. This is because sometimes a book
will have more than one set of publishers and cities—it may have been published simultaneously in the U.S. and the U.K. by two different publishers, for example. In the associated
Details, in addition to indicating whether Publisher comes before or after City, and what punctuation comes between them, you specify the Punctuation between multiple publishers to
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The “Author” role field will only contain information when the “authors” of a book are really
editors (or, occasionally, compilers, translators or commentators). You will always want to put
If First brackets around this field, so that the associated punctuation will not be displayed when
the “authors” really are authors.

handle cases of multiple publication. The sample reference here includes two publishers and
cities.
You’ll recall that Specific pages might sometimes appear in a Book/Monograph reference. Actually, I think that most biomedical publishers expect you to cite the specific page numbers in
your in-text citations. But just to be safe I’ve included provision for specific pages here in the
Book/Monograph template.
That’s all I will say about the VANCOUVER format. The complete format is available in the
BioMed Format Library; see the Formats, Format Libraries and Predefined Formats chapter for a
reminder of how to copy our predefined format into your own database, where you can then
study it at your leisure.

CHICAGO A
The CHICAGO A format is one of two presented in the Chicago Manual of Style. This book defines the rules used by many academic publishers, in many disciplines. The 14th edition of the
Chicago Manual refers to CHICAGO A as the “documentary-note” or “humanities” style.
In CHICAGO A our sample Article would appear as follows:
Smythe, Albert B., and Christine D. Jones. “Physiology of the Koala.” New England
Journal of Medicine 137 (1978): 231-35.

Since you have just worked through the VANCOUVER format in some detail, I will show you
how to set up CHICAGO A with a minimum of discussion, except where I am introducing a
new concept.
Begin by opening the Formats window and clicking the New... button. Then fill in the name
and description:
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CHICAGO A: Sorting & Citing
The Sorting & Citing section of this format is more interesting than VANCOUVER‘s. Rather
than numbering the references in the bibliography and then citing them by number within a
manuscript, CHICAGO A lists the references in alphabetical order, and cites them in the text
using the (Author, Year) method.
Actually, I’m cheating a bit here, for pedagogic purposes. In the Chicago Manual’s documentary-note system there are no in-text citations to the bibliography. Rather,
superscripted numbers in the text take the reader to either footnotes or endnotes, which
include both additional text and complete bibliographic entries. The final bibliography is
simply a stand-alone list of references, in alphabetic order.
But for the sake of learning, let’s just pretend that CHICAGO A uses in-text citations of
the Author-Year style. Okay?

WORKBOOK
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CHICAGO A: Numbering & Layout
The Numbering & Layout section of CHICAGO A is straightforward:
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CHICAGO A: Authors
The Authors section of CHICAGO A is mostly self-explanatory:
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Note the section about repeated authors. With CHICAGO A, one does not repeat the authors if
they are identical to those of the previous reference:
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According to the rules of CHICAGO A, if an author for a particular article has been entered as
Anon., then there will be no author listed in the displayed reference, not even Anon. So here we
tell Papyrus to suppress such authors. (I will come back to this when we get to the Article
template in a moment.) There are some formats, such as APA, that would in such cases have us
move the reference’s Title to where the authors would normally appear, but CHICAGO A is not
one of these.

Smythe, Albert B., and Christine D. Jones. “Physiology of the Koala.” New England
Journal of Medicine 137 (1978): 231-35.
------. “Eucalyptus Euphoria.” Journal of Lethargic Pharmacokinetics. 35 (1982): 23-9.

CHICAGO A: Editors
The Editors section is unremarkable:
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CHICAGO A: Article in journal
Now here is what the Article template of CHICAGO A looks like:

There are several things to note here.
We have told Papyrus that if a reference’s author is Anon. it should not display the author. Since
in such cases there will be nothing appearing at the beginning of the article display, we need to
also suppress the period and space that are supposed to follow the authors. Hence the initial If
First brackets around the author part.
According to CHICAGO A, the Journal Name is supposed to be italicized. We accomplish this
quite easily, by selecting the
field in our template, and then choosing Italic from
the Style menu.
The CHICAGO A format specifies that all significant words appearing in titles should be capitalized. Hence the Capitalize brackets,
and
, surrounding the Title field.
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If you knew that all article titles in your Papyrus database were consistently entered with
all words capitalized, then you would not need to use the Capitalize brackets here in the
Article template. But if you sometimes use CHICAGO A yet other times use format
styles that do not want all words capitalized—such as almost all formats in the physical
sciences—then you can enter titles with only their first word capitalized and let the format take care of capitalizing when Papyrus outputs your reference lists.

As with VANCOUVER I have included lots of If First brackets to cover references in press,
references with or without Issues, with or without Supplements, and with or without Day &
Month. The If Any brackets serve the same function here that they did in the VANCOUVER
format.

WORKBOOK
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CHICAGO A: Chapter in book
Here is the Chapter in book template of CHICAGO A:
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There is a lot going on here, but nothing you shouldn’t be able to figure out. Do take the time,
though, to make sure that you understand how all this fits together.
To examine the remaining sections of CHICAGO A, copy the complete format to your database
from the Humanities Format Library.

AM ANTIQ
American Antiquity is an important journal in anthropology, and its bibliographic style is used
in many other contexts. (It is also one of the few journals whose Instructions to Authors devotes
a full half-dozen pages to bibliographic style, leaving us with much less guesswork than usual!)
Here is our familiar sample reference, plus two other skeletons of references, in AM ANTIQ
style:
Smythe, Albert B., and Christine D. Jones
1988 Physiology of the Koala. New England Journal of Medicine,
Series B 137(4 Suppl. A) April 12:231-235, Previously published
in New Zealand.
Thompson, Esther F.
1982 XXXXXX YYY ZZZZZZ XXXXXX YYYYYYYY ZZZZZ XXXXX
YYYYYYYYY XXXXXX ZZZ XXXXXXXXXX YYYY ZZZZ XXXXX.
1992 XXXXXXXXXXX YYYY ZZZZ XXXXXXXXXX YY ZZZZZZZ XXX
YYYYYYYYYYY ZZZZ XXXXXXXXX YYY ZZZZZ XXX YYYYYYY
XXXX YYYYY ZZZ XXXXXXXXXX YYYY ZZZZZ.

The most interesting new wrinkle here is the indentation. For the first reference by a particular
author or group of authors, the Authors appear on their own line, beginning at the left margin.
The next line starts with the Year, indented a bit. Any additional lines of text wrap around to
begin fresh lines that are indented a bit more.
Papyrus can be taught to handle this indentation style correctly. The secret lies in the concept of
paragraphs.

So for AM ANTIQ we will consider the Authors line one paragraph, and the rest of each reference (starting with the Year) a second paragraph. The first line of the first paragraph has no
indentation, the first line of subsequent paragraphs is indented, and continuation lines of
any paragraph are indented further yet.
Finally, we will tell Papyrus to suppress the Author paragraph altogether if a reference’s authors
are identical to those of the preceding reference.
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We usually consider each reference to be a single paragraph—if sometimes a rather pathologically-shaped sort of one, as in the above examples. However, we can tell Papyrus to break
references into more than one “paragraph,” and to indent the second and subsequent paragraphs differently than the first.

AM ANTIQ: Numbering & Layout
I will not take the time now to review the Sorting & Citing section of AM ANTIQ, as it is quite
similar to that of CHICAGO A. Instead let’s proceed directly to Numbering & Layout:

As promised, we have told Papyrus to indent a New paragraph somewhat, and to indent further the Subsequent lines of all paragraphs (i.e., all lines after the first line of a paragraph).

AM ANTIQ: Authors
Here is the interesting part of the Authors section:
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The Repeated authors section is where we tell Papyrus to suppress the Authors field when it is
identical to that of the previous reference. This will have some implications for how we set up
the Article template, as you’ll see in a moment.
Note that for references with an Author of Anon. we are telling Papyrus to shift the Title into the
Author position. Here is an example from the American Antiquity guidelines:
The Puritans
1978 Time. October 9:64-65.

The Article template will also reflect this concern.

AM ANTIQ: Article in journal
And now, here is the template for an Article in journal:

WORKBOOK
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That bar character after the Author field is a Paragraph Break. You insert it into a template by
clicking the
button:

This template says: “If there are authors—i.e., they have not been suppressed because they were
identical to those of the previous reference—then display them and then go on to a new paragraph. Begin the new paragraph with the Year, followed by the rest of the reference information.”
As you will see when you enter the above template, Papyrus displays each paragraph
of your template in a different color, to make the paragraph breaks more apparent.

Recall that we had previously specified that for Anon. references the Title is to be shifted into
the Author position. That would leave the Title position empty, so we have used If First brackets
around the Title field and its following period and space.
Copy the complete AM ANTIQ format from the Humanities Format Library if you would like to
review its remaining templates.

TABLE
By now you’re familiar with Papyrus’s built-in BRIEF format:
999

Smythe; Jones 1988 Physiology of… N. Engl. … 137:231

This is a tabular output format. Each field or groups of fields appears within a restricted column, so the overall appearance of the reference list is that of a neat table.
When a field is too long to fit into the available space, as are both the Title and Journal Abbreviation here, it is truncated.
You can create your own tabular output formats. You may arrange whichever fields you wish,
in whatever order, on one or more lines. Here is our sample reference as displayed with the
two-line TABLE format we are about to create:
999

Smythe, Jones
1988 N Engl J Med
Physiology of the koala

137(4):231

Begin by clicking the Format’s window New... button. Enter the name and description of the
format as shown below, and click the Tabular output button:
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TABLE: Numbering & Layout
Since we do not expect to use this format in conjunction with any published manuscripts, we
need not complete the Sorting & Citing part of the format. So let us look at Numbering &
Layout:
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Note that Papyrus doesn’t allow us to specify the indentation of subsequent lines as it usually
would. With a tabular output format all “paragraphs” will be exactly one line long—overly
long fields will be truncated to fit.
Also note that I’ve set the units here to characters rather than the inches I’ve been using for our
other formats. There’s really no need for this change; I just find it easier to leave the correct
amount of space for the Reference # if I think in terms of characters. This way there will be
enough room for a 6-digit Reference #, which should cover most Papyrus databases.
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TABLE: Authors
The Authors section is straightforward. For the sake of compactness, we’ll tell Papyrus to omit
the authors’ initials altogether:

There’s no need to set up any et al. rules. If there are more Authors than can fit into the column
we provide, Papyrus will simply truncate them.
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TABLE: Article in journal
Okay, now let’s set up the Article in journal template for TABLE:

As in AM ANTIQ, we use the
the template.

button to insert a Paragraph Break between the two lines of

Between each pair of columns we insert a Column Break:

You are not restricted to a single field between Column Breaks. As you can see, here I have
included Volume, Issue, and Starting Page, along with some punctuation, within a single column.
The Details view is where we control the relative widths of our columns:

WORKBOOK

If the second line of our template had included more than one column, we would have
gotten a corresponding second Columns line here in the Details view.

With your mouse, drag the column indicators to adjust the column widths:
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Note that these widths are not measured in inches or characters or any other unit. Rather they
are relative to the line length. When you use this format in a Group window, for example, if
you enlarge the window then each column will enlarge proportionally.
Click the OK button to save this Article template.

TABLE: Book/Monograph
Now let’s set up a corresponding Book/Monograph template for TABLE:

As you can see, there is no requirement that we provide the same number of columns (or lines,
for that matter) for each different reference type. But I have set the widths of the Author and
Year columns the same as in the Article template. That way the first two columns will line up
nicely in a reference list including both Articles and Books.
•

•

•

Feel free to experiment by setting up templates for some other reference types.
You might also try this: make a Group of references and then click the Group’s Preferences...
button. Set the Group’s Table view format to TABLE, and its Lines shown per reference to 2.
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See Also...
In this chapter we have worked through three output formats of increasing complexity, plus a
tabular output format. We have covered most of the techniques you will need to set up your
own output formats.
For further details about the many features available in the various Format editing dialogs, see
the Format Entry chapter in the REFERENCE section.
There are also some time-saving shortcuts you’ll want to read about.

See also:
CONCEPTS
Bibliographies vs. Footnote Lists
Output Formats
Journals
REFERENCE
Formats Window
Format Entry
Sorting & Citing
Numbering & Layout
Authors/Editors Format
Template Entry
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SHORTCUTS
Format Entry Dialog
Template Entry Dialog
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Introduction
Important note This is not the first chapter in this WORKBOOK. Importing references into Papyrus from other sources is not the simplest way to begin
using Papyrus. If you have not yet spent at least a little time trying more
basic Papyrus operations you may experience unnecessary difficulties with
your first imports. This means you!
Sorry. Our technical support staff insisted that I include that.

Actually, importing references into Papyrus can be quite a smooth and easy process. It can also
sometimes be a complex and potentially frustrating process. In this chapter I will present an
overview of the steps needed to load references from various sources into Papyrus. In doing so
I will try to help you understand why most imports will be easy, others more challenging, and
an occasional few just not worth the bother.
Then in the next four chapters I will present more specific advice for particular types of imports.
•

•

•

When you select Import... from the Reference menu, the following dialog will appear:

In the rest of this chapter we will explore this dialog.
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Source file

The chief prerequisite for importing references into Papyrus is a computer file that contains a
bunch of interesting references. There are many possible sources for such files:
• bibliographies you’ve typed for previous publications
• CD-ROM databases, such as Silver Platter
• online databases, such as Medline or Dialog
• monthly diskette update services, such as Current Contents on Diskette or
Reference Update
• general-purpose database programs, such as Access or dBase
• other personal bibliographic database programs
Wherever your file comes from, it must meet a few absolute requirements:
• the file must be a plain text file—not the idiosyncratic native-format file of a
word processor or database program
• between references there must be at least one blank line, so that Papyrus can
tell where each reference begins and ends
• within a reference there should be no blank lines
• all of the references in the file should follow a more or less consistent format
There is also one optional requirement:
• the file should contain only references—no titles, headers, footers or other
effluvia

Chapter 19: Importing—Overview

WORKBOOK

This is optional because as long as each page header or other gibberish is separated
from its neighboring references by blank lines, it will simply be spit out by Papyrus as an
unrecognizable “reference.” But if your file has page headers that run right into the
references, then you will need to remove these headers with your word processor prior
to importing the file into Papyrus.
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Files that come from bibliographic databases—whether CD-ROM, online, or monthly diskette—
almost always meet all of these requirements. (We are trying to be reasonable here!)

Import format

Okay, so you’ve got your file of interesting references. Next you need to explain to Papyrus how
these appear. You do this via a Papyrus import format.
If you are loading references from a commonly available source, then the odds are excellent that
we have already provided the import format you need in one of our Format Libraries. You can
open each relevant-sounding Format Library and copy any useful formats into your own database.
In other cases you will have to devise your own import format. The following chapters provide
extensive guidance for that task. Our Technical Support department is also always happy to
assist you.

Fussiness level

The Fussiness level you select can have significant effects on the outcome of your import. It
addresses a trade-off inherent in the way Papyrus imports references.
Papyrus contains a very large store of knowledge regarding references and their components—
things that I sincerely hope you will never have to think about yourself. For example, it knows
that a book’s title may be followed by a volume number, and that such volume numbers are
generally preceded by Volume, Vol., vol., or the like. Therefore, when Papyrus is scanning an
incoming reference, if what it has tentatively identified as the title contains the word vol., this is
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probably not simply a title but rather a title plus a volume number. Papyrus will therefore
conclude that it has made a mistake in deciding which part of the incoming information is the
reference’s title. So it will back up and try a different way of matching the reference to the
import format.
Papyrus has dozens of these little rules, and they yield important improvements in Papyrus’s
accuracy during imports. Unfortunately, the rules are not universally true. Regarding our title/
volume rule, for example, consider any French works on flight (English “flight” = French “vol”).
Such helpful but imperfect rules are generally called heuristics by artificial intelligence people.
(And you thought Papyrus was just another dumb database program!) They are supposed to
make computers smarter, but now and then they actually result in a complete and utter screwup.
The import Fussiness level controls the extent to which Papyrus applies its heuristics. Set at
Finicky, Papyrus will use all the rules it knows. At Tolerant it will let a lot of things slip by (such
as vol appearing in a title). Finally, when set to Oblivious even strange punctuation (such as
mismatched parentheses)) will be accepted.
In general, you should try Finicky for data files that do not always clearly separate each field
from the next. This would include most word-processed bibliographies from your previous
publications.
For most downloads from bibliographic databases, Tolerant will do the best job. You can also
try it when Finicky has inexplicably rejected some references from a data file.
Oblivious should usually be reserved for trying to import references that Papyrus rejects at the
Tolerant level.
Each of the import formats we provide contains an indication of the Fussiness level at which it
is likely to perform at its best. But you may sometimes have to experiment with different Fussiness levels for your particular data files.
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Log file

As Papyrus works through your source file, it create a log file summarizing its results. This is
simply a text file that includes the first few lines of each incoming reference, followed by a
message indicating whether the reference was successfully imported or not.
The log file also includes warning messages, alerting you to keywords or journal names that
are new to your database, odd entries that Papyrus has cleaned up during the import, etc. You
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should review these messages for your first few imports, as you develop a feel for how Papyrus
behaves.
While importing, Papyrus will display the log file in a separate window so you can keep an eye
on how things are progressing.
You can name the log file whatever you like. Papyrus’s default suggestion is to add .log1 to the
end of your source file’s name.

Reject file

If there are any incoming references that Papyrus can’t figure out, it will copy them to a reject
file. Once the import is done you can open this reject file in your word processor and correct
any typographical errors. Then you can tell Papyrus to try to import the now-corrected file.
In other cases you will simply tell Papyrus to try importing the reject file using a looser Fussiness level.
You can name the reject file whatever you like. Papyrus’s default suggestion is to add .rej1 to
the end of your source file’s name.
If you later tell Papyrus to import this rej1 file, it will suggest a name for the new reject file
of rej2.

Duplicate references

As you can see, Papyrus provides several options for dealing with incoming references that are
duplicates of references already in your database.

W214 Importing

Papyrus is fairly intelligent about deciding when a reference is most likely a duplicate. It compares the author names, recognizing that, say, Smith,AB in the incoming reference could be the
same person as Smith, Alice B. in the existing reference. It compares the years, recognizing that
2001 might correspond to In Press. It also compares the title, pages and a few other fields.
If Papyrus concludes that an incoming reference matches one already in your database, it then
proceeds as indicated by your choice here:
Automatically skip
Papyrus will copy the incoming reference to the specified duplicates file, and
will not add it to your database. Later you can review the duplicates file with
your word processor. Or you can tell Papyrus to import the duplicates file, this
time selecting Pause to decide to double-check its accuracy.
Pause to decide
Papyrus will pause in its progress through your source file, and display a
window showing you both the incoming and the existing reference. Papyrus
then waits for you to instruct it whether to keep your existing reference and
skip the incoming one, delete the existing reference and replace it with the
incoming one, merge the two references, or simply accept the incoming reference in addition to the existing one.
Save anyhow
The incoming reference is added to your database. A warning in the log file is
the only indication that the reference is a duplicate.
Merge incoming reference with existing reference
Papyrus will add to your existing reference any new information it finds in the
incoming reference. For example, if the incoming reference has an Abstract
that was not already present in the existing reference, Papyrus will add that
Abstract now.
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Save incoming reference, delete existing reference
If you know in advance that the incoming references are more complete or
accurate than the corresponding references already in your database, select
this choice. The incoming reference will replace the existing one—Papyrus will
also give you the option of re-using the existing Reference # for the incoming
reference.
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Reference #s

You will usually want to let Papyrus start numbering the incoming references at whatever
Reference # is the next available in your database. That’s the number Papyrus suggests here.
But if you would rather bring in the new references with a distinctive range of Reference #s
(starting at 10,000, maybe) you may do so by typing the starting number here.
If you are using an import format that includes Reference # as one of the incoming fields, then
Papyrus will offer you the checkbox shown above. Checking this box tells Papyrus that it should
keep the incoming number rather than assign a fresh Reference #.

Keywords

If the incoming references already have their own keywords you may or may not wish to keep
them. For example, downloads from an online system such as Medline often include a lot of
keywords that you might prefer to not have cluttering up your personal database. The Retain
incoming keywords checkbox lets you keep these or not, as you prefer.
Some databases store their keywords in ALL UPPERCASE. If you check the De-capitalize incoming keywords box then Papyrus will convert these to mostly Lowercase.
You can add one or more keywords to all of the incoming references. For example, if you are
importing the results of an online search, you might wish to assign your own keyword to each
of the references indicating their common topic.
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When you click the Add button your Keywords window will open, allowing you to select the
relevant keywords. These will then appear in the Import dialog:

You can drag these keywords to rearrange them, and you can use your delete key or choose
Clear from the Edit menu to remove any from the list.

Running the import
After you click the Proceed button in the import set-up dialog, the Import window appears:

Here you can monitor the overall progress of your import.
The Pause button allows you to temporarily halt the import—this might come in handy if you
want to pause a large import so that you can turn your computer’s full attention to another
task.
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This doesn’t imply that you must pause an import to accomplish other work with your
computer. Papyrus monitors your computer’s other activities and automatically scales
back its own demands on the machine when you are working in other programs (or in
other Papyrus windows).

Click the Stop button to abort the import.
When the import begins, Papyrus also opens an Import Log window:
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This window shows you the log file as Papyrus records its progress through your import. You
can see the first several lines of each reference, followed by any warnings or error messages.
You can close the Import Log window if you like. In fact, with the Import Log window closed
your import will run slightly faster, since Papyrus will not constantly need to update this window.
Even with the Log window closed, Papyrus will continue to write its warnings and errors
to the log file. You can always review the log file later in either Papyrus or your word
processor.

Did you notice that little triangle in the Import window, to the left of the progress bar? Clicking
the triangle expands the Import window so that you can more closely follow and alter Papyrus’s
importing behavior. This comes in particularly handy when you are creating and “debugging”
a new import format. See the REFERENCE chapter Import for all the details.
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See Also...
You should now have a good feel for the general procedure of importing references into Papyrus
from other sources. Of course, the most important aspect of all this is the one I have so far barely
touched upon—designing an appropriate import format for each data source.
In the next chapter, Importing—Predefined, Straightforward, I will lead you through the steps of
importing references from nice, clean sources for which we have already provided import formats.
Then in Importing—Predefined, Complicated I will address the issues that arise when a source is
neither nice nor clean. The output of some bibliographic databases is cumbersome, irrational,
or just plain inconvenient. We have provided import formats for many of these, but there are
some extra steps needed in performing these imports.
Importing—Word Processor Bibliography shows you how to create an import format designed to
match a bibliography that you already have in your word processor.
Finally, Importing—Other Structured Databases gets into all of the details you need in order to set
up import formats to handle sources not provided for in our Format Libraries. The chapter
begins with some simple cases, and then continues on to increasingly ugly situations.

See also:
CONCEPTS
Reference Types and Fields
REFERENCE
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Reference Types and Their Fields
Formats Window
Import
Using Papyrus with TeX, LaTeX, and BibTeX
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Introduction
Be sure to read the Importing—Overview chapter before starting this one.
Many bibliographic databases are very well-behaved, producing output files that are almost
completely self-consistent and predictable in form. Among these solid citizens are Current Contents on Diskette, most versions of Medline (PubMed, NLM, BRS, Dialog, PaperChase, Ovid,
Silver Platter, etc.), Chem Abstracts (STN, Dialog), Biological Abstracts, and BIOSIS. (These are
certainly not the only pleasant sources, just some of the biggies.)
You will find import formats for these well-behaved sources in our various import Format
Libraries. You need only copy the relevant format from the Library to your database and then
perform the import at the Fussiness level suggested by the format. If any references are rejected,
try importing the reject file at a looser Fussiness level.
In general with these sources there is no need for you to edit the downloaded file prior to
importing it into Papyrus. However, should you decide to do so (e.g., to remove some uninteresting references from the file), be sure to save the result as a plain generic text file when you’re
done. Any other file format is likely to either insert strange word-processor codes into the text,
or else screw up the indentation of the references.

Altering Assumptions
We have set up our formats with certain assumptions; you can edit the formats if you disagree
with any of these assumptions. For example, we have usually chosen to not retain affiliation/
address information about the authors—you will find a Discard indicator in the format templates at the point where such information appears in the incoming references. So if you would
like to retain this information, you need only edit the format and change the appropriate Discard to Affiliation/Address.
Similarly, we have used the Abstract indicator to tell Papyrus to store incoming abstracts into its
Abstract field. If you do not want to keep abstracts in your database, change this to a Discard.

Troubleshooting
There are two chief things that can interfere with imports from these well-behaved sources. The
first is when a rogue data-entry clerk decides to make up new rules while typing in some particular reference. Fortunately this is not too much of a problem for the sources we are discussing
in this chapter. If a reference does get rejected during one of your imports, you will probably be
able to use your word processor to correct the offending portion and then re-import it.
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The more serious problem is that every year or so the curators of these bibliographic sources—
no doubt feeling a need to express their personal creativity—decide to modify something in
their product’s output style. These are sometimes very small changes, ones that will have no
effect on your Papyrus imports. Others are medium-size changes that necessitate small modifications to a Papyrus import format. And occasionally certain database vendors have been known
to completely rearrange their output files, without warning anyone.
If you find that a Papyrus import format that always used to work fine has suddenly stopped
doing so, it is likely that your data suppliers have been fooling around with their output
style. You should compare your downloaded files with the Papyrus format and see if you can
detect what has changed. If you can figure this out then you need only edit the Papyrus format
to match the new style, and all should be well (for another year, anyway).
But if you cannot figure out what has changed, or if you do not see how to modify the Papyrus
format to deal with the changes, then get in touch with us. If you are one of the first to report the
problem we will probably ask you to send us a copy of some of your downloaded data so that
we can examine it ourselves. If others have preceded you then we can simply send you the new
format.

See Also...
If you have a source of bibliographic data for which we do not provide an import format, our
Technical Support department will be happy to help you create an appropriate import format.
There is no charge for this service.
As we update old import formats and create new ones, from time to time we post updated
Format Libraries to our Web site. You can often save yourself some time and trouble by checking our site to see if we’ve already created the import format you need.
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REFERENCE
Reference Types and Their Fields
Formats Window
Import
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Introduction
Be sure to read the Importing—Overview and Importing—Predefined, Straightforward chapters before starting this one.
Some bibliographic databases yield output that is difficult or impossible for Papyrus to import.
There are three ways they accomplish this:
• Providing the bibliographic information in a consistent fashion, but in a way
that makes it difficult for Papyrus to accurately discern the boundaries between the various items.
• Providing the information in an inconsistent fashion, where every data-entry clerk seems to have been encouraged to type in authors, titles, and the
other fields according to personal preference.
• Both of the above.
For sources of the first kind, we have responded by creating plug-in filters. These are small
conversion programs invoked by some Papyrus import formats to clean up the incoming data
before Papyrus attempts to match it to the format templates.
For the second category, where no two incoming references look alike, we have produced extremely convoluted import formats. These are designed to cope with as many variant entry
forms as seemed practical. Because the formats are so complicated, their imports tend to run
more slowly than others.
Some of these inconsistent databases are so ugly that a single complex import format is not
enough. For these we have had to create a collection of multiple import formats.

Plug-in filters
Plug-in filters are stored in your Papyrus Additions folder.
An import format can specify one or more filters:
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In this example, the Alphabetize Tags filter is specified. This filter will take incoming data such
as:

and convert it to:

Other plug-in filters include:
Silver Platter—Used with data obtained from any of the many databases distributed on CD-ROM under the Silver Platter brand.
Outdent Percents—Used with formats based on Refer, including data exported
from the EndNote bibliographic software.
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Since different sources of Medline data provide the various “tags”—UI, AU, TI, etc.—in different
orders, using the Alphabetize Tags filter allows us to create a single common import format that
can expect to encounter all of the tags in alphabetical order.

We create new plug-in filters from time to time, and post them to our Web site. If you have an
importing challenge that you feel requires a new plug-in filter, please provide our Technical
Support department with a small sample file and we’ll see what we can do to help you.

Multiple import formats
When a data source is extremely inconsistent, even the most convoluted import format may
prove inadequate to handling all of the variant entry forms. In such cases you must use a series
of formats.
For example, to cope with the GeoRef database as provided by the Silver Platter CD-ROM we
are currently up to four separate formats (there may be more by the time you read this). This
particular database actually falls into the third category of challenging databases, where the
various fields are both unpredictable and indistinguishable, so each of the import formats must
also use a special plug-in filter. The downloaded data is imported using the first of the four
import formats. The rejects from that import are then re-imported using the second import
format. And so on, until all the variants have been accepted by one format or another.

See Also...

See also:
CONCEPTS
Reference Types and Fields
REFERENCE
Reference Types and Their Fields
Formats Window
Import
Plug-in Filters
Using Papyrus with TeX, LaTeX, and BibTeX
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Introduction
Be sure to read the Importing—Overview and Creating New Output Formats
chapters before starting this one.
In this chapter I will show you how to import existing word-processed bibliographies into
Papyrus. How well this works depends entirely on how self-consistent the original typist was
in formatting the references.
To illustrate what I mean by “self-consistent,” suppose one article in a bibliography were entered
as:
Smith, J.A. and C.B. Jones. A really important study. Journal of Major Import 123: 523537, 1991.

but another in the same bibliography looked like:
Rogers R; Hammerstein O: Language acquisition among the Cockney. J. Broadway
1961. Vol. 32, pp. 23-27

This would be an excellent example of a bibliography that was not self-consistent. For a less
blatant inconsistency, consider this hypothetical citation:
Galápagos, I.S. and P. W. Finch (1840): Suggestions for increasing tourism. Journal of
Cosmetic Ornithology, 14:281-284.

It is okay that the first author’s initials follow his/her surname while those of the second author
precede his or hers. That is a very common bibliographic convention. However, it is not okay
that there is a space between P. and W. but no space between I. and S. Papyrus has to be extremely
fussy about the presentation of author names and initials in order to stand any chance of figuring out tough cases such as this one:
Smith, JA, Jr, Rogers, CB, Jones, RI, III, Waters, JJ

(We’ll return to this issue of inconsistencies in author names later in the chapter.)
Even if your bibliography is less than impeccable, though, do not yet despair. Before this chapter is done I will present several tricks to help cope with the most common sorts of obstacles.

Preparing the document
All right, let’s begin by supposing that you have a bibliography in your word processor that
you would like to load into Papyrus. Your first task is to save a copy of the word processed
document as a plain generic text file. This will cause all word processor codes to drop out,
leaving only the actual text of the references.
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It will also convert all text to the standard Roman script system. This means that special
characters in the Symbol font or in a different writing system will be lost.
If this is an issue for your document you should first do a search-and-replace in your
word processor to convert such non-Roman characters to some sort of temporary code.
For example, you might replace α with /alpha/ and Σ with /Sigma/. Then later you can
use Papyrus’s search-and-replace facilities to convert these back to the correct font.

Next, take a look—with your word processor, or with Papyrus’s Open Text Document... command—at the text file you have just created. Papyrus requires at least one blank line between
each reference and the next. If there are no such blank lines, then use your word processor to
insert them.
The easiest way is generally to tell your word processor to search for [Hard Return] and
replace it with [Hard Return][Hard Return].

Okay, you now have a file that is (hopefully) importable. The next step will be to set up a
Papyrus import format that matches the style used in your file. Before turning to Papyrus you
might wish to print out a page or two of your text file for easy reference.

Creating the format
In Papyrus, open the Formats window and click the New... button. Make up a name for your
format and add whatever description you wish. For Format Type choose Import. Set the Default
Import Fussiness Level to Finicky.
Now turn back to the Creating New Output Formats chapter of this WORKBOOK for a review of
setting up a format. Even though you are now creating an import format, you will proceed
exactly as if you were trying to create an output format to match the style used in your bibliography file.

By way of example, let’s pretend that your bibliography was supposed to be in the American
Psychological Association (“APA”) format.
I say “supposed to be” because the APA format is so picky, demanding, and in places
irrational that we have yet to encounter the human capable of typing an entire APA-style
bibliography without breaking at least a few of the rules.

Here is a sample reference straight from the APA style manual (4th edition):

Chapter 22: Importing—Word Processor Bibliography

W231

WORKBOOK

But do not get more complicated in your format than is called for by your text file version of the
bibliography. For example, do not italicize or boldface any fields—all such character formatting
was removed from your file when you saved it as plain text. And do not overcomplicate your
format by including a lot of unnecessary If First or If Any brackets—if none of your actual references includes, say, an Issue number, then there is no need to account for the optional presence
of the Issue field within your format template.

Bekerian, D. A. (1993). In search of the typical eyewitness. American Psychologist, 48,
574-576.

And here is the Article template of the APA output format that is provided with Papyrus:

Now, there is a lot going on in this output format that you would not need just for importing a
file full of straightforward references like the sample shown. For example, the Day & Month bit
is there only for journals that require their Day & Month to be given, which is rare. The underlining is unnecessary, as I’ve already discussed. If your citations are to typical journals, then
you will not have to worry about Journal Series. There are If First brackets around Volume and
Pages because the output format has to cope with references still in press; you do not need
those brackets if all (or nearly all) of the references in your file do indeed have a Volume and
Pages. And so on.
In fact, assuming that the bulk of journal article citations in your file resemble the above sample,
the Article template of your import format could simply be:

Much less intimidating, yes?
Once you’ve got the first draft of your import format, a helpful next step is to take one or two
typical references from your bibliography and manually enter them into Papyrus. Then have
Papyrus display these references using your new format. (You will first have to temporarily
change your format’s Type from Import to Output.) You can then compare these results to your
original file and see if you got everything correct (periods, commas, spaces, everything). If not,
then go back and tweak your format until the results look perfect.
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There is one discrepancy you can get away with. If there are spaces anywhere within
your template (between the Title and the Journal Name, for example), you need not
worry whether these are supposed to be one space, two spaces, three spaces, etc.
When Papyrus imports a reference, among the very first things it does is convert each
string of spaces in the incoming reference to a single space. It does the same with each
string of spaces appearing within your format. So while your format does need to distinguish between no spaces vs. one-or-more spaces, it does not need to distinguish between
one space vs. two-or-more spaces.

Okay, you’ve created the first draft of your new import format. Go ahead and try importing
your file. (For this type of import I suggest you start with a Fussiness level of Finicky.)
How did you do? If you based your import format on truly typical samples from your file, then
the import should have successfully brought in at least some references. Next you need to look
at the rejected references and see what is different about them. Then you can either use your
word processor to edit the rejects, or you can modify your format to better fit them and then try
importing again.

Debugging
When you expand the Import window to its full form, one of the newly-revealed controls is a
checkbox labeled Show cogitation:
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Clicking this box switches the window into “debugging” mode:
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The top part of the window shows the format template that Papyrus is currently trying to match
to the incoming reference. As it proceeds through the template, Papyrus highlights the part of
the template and the matching part of the incoming reference that it is currently evaluating.
When there is a tentative match, Papyrus colors the corresponding parts of the template and
incoming reference to so indicate.
In many cases where your import is not going well you will be able to determine why by carefully watching the debugging view as Papyrus tries to match the pieces of your template to the
incoming data.
All the details on debugging mode can be found in the REFERENCE chapter Import.

The “sieve” approach
You do not have to import all of the references from your file in a single pass. For example,
suppose that half of the references list their authors like this:
A.B. Smith, C.D. Rogers, and E.F. Jones...

while the other half omit the comma before the “and”:
A.B. Smith, C.D. Rogers and E.F. Jones...
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This is exactly the sort of thing about which Papyrus gets extremely persnickety. So set up your
format to include the comma, and run the import. Half of the references will be imported, the
other half will be sent to the reject file. Now change your format so that it omits the comma, and
tell Papyrus to import the previous rejects.
The same approach works well when other elements of the references, such as Volume or Pages,
have been entered in more than one way, perhaps with differing punctuation. Import all of
those that were typed one way, then modify your format to bring in another batch from the
reject file.
If you can successfully import a whole group of references at a time just by modifying your
format, then this will be quicker than using your word processor to individually edit each of
your references into conformity.

Sacrifice the few for the many
If the bulk of references in your bibliography are reasonably consistent journal articles, but
there are also a few books and chapters scattered here and there, then just concentrate on the
journal articles. Once you’ve got those imported you can see how many books and chapters
remain in your final reject file. If you think you can quickly set up Book and Chapter templates
to work for these, then by all means go ahead and do so. But it will sometimes be quicker to
simply print out the final reject file and enter these few remaining references into Papyrus by
hand.
Of course, you can save some typing—particularly of lengthy titles and comments—by
using Copy/Paste or Drag/Drop to move text from your word processor to Papyrus.

Full Names vs.Initials

To have Papyrus loosen up on this, choose Full rather than Initials for First name(s) in the Authors section of your format. When set to Full Papyrus will accept either spelled-out first names
or simply initials. Choosing Full also causes Papyrus to accept initials regardless of whether
they are separated by a period and a space, just a period, just a space, or neither.
So if your file contains a variety of punctuation between author initials, or a mixture of initials
and spelled-out first names, try the Full setting and review the results.
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As I’ve indicated a few times, Papyrus is very picky about author punctuation, so that it can
correctly handle the worst cases that might arise. However, your particular bibliography most
likely doesn’t include many instances of those worst cases.

Journal Names vs.Abbreviations
If you see that some of your journal article citations include a full journal name while others
show only a journal abbreviation, then in your Article template use Journal Name rather than
Journal Abbreviation.
When matching incoming text to the Journal Name field, Papyrus will check whether there are
any periods within that text. If there are, then Papyrus will consider the text to be an abbreviation; otherwise it will be considered a name.

Do not be too proud
If you are getting nowhere after an hour or two, please stop We did not sell you Papyrus in order
to make you frustrated.
Though I sometimes wonder whether all software companies can make that claim...

We can usually help people with this sort of import via a simple e-mail or phone call. We might
ask you to e-mail or fax us a page or two of your bibliography.
We are happy to assist you with your imports. If necessary we will set up the necessary
import format for you. There is no charge for these services.
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See Also...
Although in this chapter I’ve presented the most important information and tricks for creating
an import format to deal with word-processed bibliographies, there is no substitute for experience. Over the years we here at Research Software Design have amassed a huge collection of
tricks. Yet sometimes I still find myself staring at a disappointing format for an hour, only to
finally realize that I typed a period where I should have entered a comma.
It’s true that Papyrus is extremely picky about such small details. And I share your inevitable
wish for a computer program smart enough to just look at a list of references and recognize that
this bit is a book title and so that must be a publisher’s name.
But until that day arrives please be patient with your humble computer, and with us. And feel
free to contact our Technical Support department for assistance, particularly with your first
import format or two.

See also:
CONCEPTS
Reference Types and Fields
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REFERENCE
Reference Types and Their Fields
Formats Window
Import
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Introduction
Be sure to read the Creating New Output Formats chapter, as well as all four
of the preceding import-related chapters, before starting this one.
This final chapter on importing covers the most complicated thing you can do with Papyrus—
creating a new import format to deal with data sources for which we have not already provided.
I will begin with relatively easy cases and gradually get more complicated. At the end of the
chapter I’ll offer some guidance for coping with truly nightmarish sources.
Another important resource for your understanding of import formats are
the predefined formats we’ve already provided in the various import Format Libraries. When faced with a confusing source file, you might want to
look through the predefined formats to see if we have already dealt with a
similar source.
The data sources I am addressing in this chapter are mainly the commercially-provided bibliographic databases—whether via the Internet, an intermediary service such as DIALOG, a
CD-ROM, or monthly diskettes—but also the output from local or personal databases. The
latter include both dedicated bibliographic database programs (such as Papyrus) and generalpurpose database programs (such as dBase).
Some providers of bibliographic data do a better job than others. The ideal bibliographic database should have three characteristics:
First, data entry should be consistent. If in one reference the volume number appears after the
journal name, separated simply by a comma, then it should not appear in another reference
preceded by “vol“.
Second, output style should be consistent. If in one reference the volume number appears on a
line tagged VO-, then it should not appear in another reference on a line marked SO <VO>-.
Third, the overall output form should be such that a computer program can figure it out. Usually when you do a search with a commercial bibliographic database you have a choice of output
styles in which to receive the search results. Some of these styles are easier for humans to read,
while others are better for computer programs. There are a number of typical features that
almost all database vendors provide in at least one of their output styles: (1) no blank lines
within a reference; (2) one or more blank lines between references; (3) a clear method of indentation to define “paragraphs” of information within a reference; and (4) identifying “tags” at the
beginning of each “paragraph.”
The last two of these—indentation and tags—are not always essential for a successful
Papyrus import. And an appropriate plug-in filter can even compensate for a problem
in the other features. But things are simplest if all four features are present.
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Most commercial bibliographic data sources do at least a fair job of following these criteria;
many do an excellent job. Though a few are simply abominable. (Not that I would be so crass as
to single out, say, AGRICOLA or GeoRef as specific illustrations of this last category.)
For personal/local databases, the biggest problem is usually inconsistency of data entry. For
one thing, references have often been entered by several minimally-remunerated students, each
following his or her own personal rules. For another, apart from Papyrus most personal bibliographic programs do not pay much attention to the data you enter—accidentally type in an
author’s name without capital letters, or with the initials on the wrong side of the surname, and
few programs will object. But when such an entry later shows up in an output file to be imported into Papyrus, there is no predicting how it will actually appear. This is an example of the
famous computer acronym “GIGO”—garbage in, garbage out.
Actually, no real programmer has said “GIGO” since about 1959. Still, you might find
applications for this handy phrase in other, non-computer aspects of your life.

When you need to create a Papyrus import format for a nice friendly database that follows the
rules of consistency and machine-readability, your task will not be especially difficult. As the
data get uglier and uglier, though, your job will get harder and harder. As I’ve mentioned elsewhere, if you are getting nowhere after an hour or two, please stop and e-mail/phone/fax/
write us for assistance.
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Chapter 23: Importing—Other Structured Databases

W241

Brackets and special codes
First let me remind you of some special codes available to you when defining a Papyrus format:
Paragraph break here.
The contents of these If First brackets may or may not appear in a
particular reference.
These If any brackets are the same as the If First brackets, but they
allow for more complex interdependencies of the elements appearing within
the brackets.
Here are two others that will be useful for import formats:
Special “field” code meaning “something appears at this point in
the reference, but we will not retain it when importing the reference into
Papyrus.”
These Multiple brackets are the same as the If First brackets, but
whatever appears within them may repeat any number of times.
If any of these don’t make sense to you right now, they will after we use them in some examples.

Layout
I’ll start with a source that uses a Medline-style output. Medline is an online database maintained by the National Library of Medicine. While we have already provided predefined import
formats for many vendors and repackagers of Medline (each of whom has invented its own
variation on the NLM’s format), the same principles will apply to many other database sources.
Note: The format we’ll create in the rest of this chapter is for teaching purposes only. For actual Medline imports you will want to use one of the
predefined import formats that we have provided with Papyrus.
Here is a sample reference in a Medline-style format:
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As you can see, the reference is broken into a series of what we will call paragraphs, and each
paragraph begins with a two-letter tag. In this case the tags stand for Unique Identifier, Authors,
Title, Language, MeSH Headings, Address, Abstract and Source.
The paragraphs are distinguished by their indentation. Each paragraph—besides the very first
one—begins at the left margin with the first letter of its tag, and all subsequent lines of the
paragraph are indented 6 spaces. (Did you notice that there were two spaces between each tag
and the hyphen?) When performing this import Papyrus will consider any line that has been
indented 6 spaces to be a continuation line, while lines beginning in any other position will be
treated as starting a fresh paragraph.
So let us start creating our import format. I will call mine MED:
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Tolerant is usually the best Fussiness Level for this sort of import.
Next double-click Numbering & Layout and we’ll fill in that section:
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Note that even though the sample reference does show some sort of number on its first line,
we’re telling Papyrus that there are no Reference nor Sequence numbers present. This is because we’re going to be discarding that first-line number, so there’s no need to treat it specially—it’s
just a line of irrelevant text.
Also note that the indentation I’ve specified for First line and New paragraph are the same, even
though that first-line number does appear to have been indented a few spaces. When using this
import format, Papyrus will consider any line indented exactly 6 spaces to be a “subsequent
line” of the current paragraph; all other lines will be considered to start a fresh paragraph,
whether they are indented zero, two, or ten spaces.

Authors
The Authors section of this format is straightforward. Recall that the corresponding part of the
incoming reference looks like this:

So we’ll tell Papyrus to put a space between each surname and its initials, and a semicolonspace between each author and the next:
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The answers I’ve provided for the et al. questions correspond to official National Library of
Medicine usage.

Editors
For imports from Medline the Editor questions are irrelevant, as Medline and the services that
derive from it contain only journal articles—which do not have Editors.
Actually, some older parts of Medline do contain a few Books and Chapters. However,
these account for a fraction of a percent of the total; since 1981 only Articles have been
added to the database. Moreover, the Books and Chapters were not entered in a consistent fashion in the first place. Bottom line: if the National Library of Medicine is the
ultimate source, don’t worry about reference types other than Article.

For data sources that do include editors, the Editors section of your import format will usually
be straightforward to fill in.

First draft template
Now comes the main event—the template for Article in journal. Here’s a reminder of what our
incoming references look like:
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And here’s a first attempt at the corresponding template:

As you enter this template, Papyrus tries to help keep it legible by automatically moving to a
new line following each , and by coloring each paragraph differently from its neighbors.

Similarly, if you did not want to retain the Abstract, you would change that field code to

.

Note that I’ve indicated that Day & Month might appear after the Year. This field wasn’t present
in the above example, but I know from many other examples that Medline sometimes provides
Day & Month in this position. Before we’re done in this chapter there will be some other If First
brackets added to our template.
Despite my previous obsession about two spaces appearing before each hyphen, you’ll note
that I’ve included only a single space at those points in the template. Although we did indeed

Chapter 23: Importing—Other Structured Databases

W247

WORKBOOK

As you can see, we are telling Papyrus to discard the number at the start of the incoming reference, as well as the Unique Identifier, Language and Address. If you wished to retain any of
these, though, you could change
to the appropriate field code. For example,

need to be very careful about this when we specified the indentation rules, we do not need to
be as picky here. For each reference in the source file, once Papyrus has figured out the paragraph indentation it will then convert any series of spaces in the incoming reference to a single
space. It will also discard any spaces that appear at the very beginning or very end of a paragraph. Similarly, any series of spaces within your format template will also be converted to a
single space.
I’ve used the Keywords field code here, rather than Major Keywords or Minor Keywords. Papyrus
will treat any incoming keyword containing an asterisk as a major keyword; the rest will be
considered minor. Usually this is the way you will want to handle keywords in your own templates. The exception would be when dealing with a source in which major keywords appear in
one paragraph and minor keywords in another.
Let’s not forget the Details section:

The Punctuation between keywords is simply the semicolon-and-space apparent in the sample
reference.
Indicating that incoming Journal Abbreviations are Without periods implies that Papyrus is to
automatically add periods while importing, in this case converting N Engl J Med to N. Engl. J.
Med.
If your Papyrus database had established more than one style of abbreviating journal names,
then this Abbreviation style pop-up menu would now allow you indicate the style of the incoming abbreviations.
Papyrus can figure out for itself that 231-5 is an abbreviated form of 231-235, so it does not
need you to explain that incoming Pages are in the Simple style. However, you do still have the
ability to indicate a prefix of p./pp., Page/Pages, etc. for the Page field. For our Medline-style
reference, though, this doesn’t apply.
Before proceeding any further, you should convince yourself that the above template does indeed match the sample Medline-style reference.
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Missing pieces
Next we need to consider a few special situations that may arise in our source file. First, some of
the references will lack one or more fields. For example, many databases will display the Language only if it is not English, so the LA paragraph will often be absent. Not all references have
an Abstract, and not all include MeSH Headings. In fact, some references will even lack Authors—this is Medline’s way of dealing with some of its Anonymous entries. So let’s throw in
some more If First brackets:

Do you see how these brackets account for the possibly missing fields?
I will now make an exceedingly important point.
You have to be careful how you combine your brackets with your paragraph breaks. For example,
the following template would work equally well as the one above:
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But this template is flawed:
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It’s evident from Papyrus’s auto-formatting that something is screwy in here. There is a missing
between the UI and AU paragraphs. And there is an extra one between AB and SO.
A related issue with brackets and paragraph breaks is that a template should never end with a
. That would mean “There is a paragraph break following the final paragraph of the incoming reference,” which is—by definition—not possible.
Suppose that in our source file we found a few references with an additional paragraph following their SO paragraph, let’s say an MI field, for Miscellaneous Information. When this
information is present we wish to store it in the Papyrus Also Print field:

There is a problem with the way I’ve handled this. Imagine an incoming reference with no MI
paragraph. When matching our template to this reference, Papyrus will ignore the final bracketed MI stuff, effectively leaving us with this template:
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Since this ends in a , it is not correct. The correct approach would have been to work backwards from the end of the template, always ensuring that the absence of one or more incoming
paragraphs would not leave us with a screwed-up arrangement of s. In this case we would
thus end up with:
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Can you see why this is a correct solution?
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Variant pieces, Part 1
Okay, here is where we left our template:

We need to account for references that lack an Issue—almost all databases will suppress the
parentheses in the SO line if there’s no Issue to display inside them:

While we’re at it, let’s also handle Supplements:

As you can see, we can nest one set of If First brackets inside another.
However, what I’ve specified here assumes that there will never be a Supplement unless there’s
also an Issue. Remember, these are If First brackets—if the first enclosed field is absent then the
entire bracketed section will be ignored. Unfortunately, sometimes a Medline article will have a
Supplement without an Issue.
So this would be a good place to use If Any brackets instead:

Now Papyrus will be willing to accept either an Issue, a Supplement, or both inside a set of
parentheses. But if neither is present, and there are no parentheses, that will be okay too.
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But, I hear you brighter students asking, how will Papyrus interpret (7) or (Part 2)? How
will it know that 7 isn’t a Supplement, or that Part 2 is just one field, namely a Supplement and not an Issue?
The answer lies in those heuristics that Papyrus employs. We’ve built into Papyrus
some knowledge of how typical Issues and Supplements will and won’t appear. The
relevant built-in rules will be in place as long as you run your import at Finicky or Tolerant. At Oblivious, though, all bets are off.

•

•

•

Now suppose that on further examination of our source file we discover that its creators were
imperfect. Specifically, some of the references display their AB paragraph after the SO paragraph, rather than before it.
Well, we could create a second new format with a new template for these upside-down references:

But it would be nicer if you only needed to perform a single import. So let us design a template
that can handle either type of reference:
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As I pointed out in the previous chapter, you could then import a large batch of references from
the source file using our first format, and thereafter import the rejects using this new format.

See? Since each AB section lies within If First brackets, there’s no harm in putting both of them
into the one template. The only trade-off is that if you carry this sort of thing to extremes with
many, many bracketed options you will probably notice your imports running a little more
slowly, as there will now be many more permutations for Papyrus to consider before it finds the
appropriate combination for any particular incoming reference.
•

•

•

Here is another situation that I encounter depressingly regularly. Suppose that most of your
incoming references do appear as our original sample, with their SO paragraph looking something like:

but that there are also some references arranged like this:

Again, we could simply design two separate formats, each with a template appropriate to one
form or the other. The first would be the one we’ve been working with so far:

The second would correspond to the oddball references:
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Do you agree that this does indeed match the second kind of reference? Note that the
commas and spaces have to make sense in relation to the brackets just as the s did
in our earlier discussion.
Hence I have specified:

rather than:

Picture the latter for the case where neither Issue nor Supplement appears, and therefore the bracketed section is effectively absent.

But we could instead make a single template that can handle both possibilities. There are several
ways we could do this, such as:

You will have to study this for a minute to confirm that it really does what I claim.
Remember: the more complicated a template becomes, the more careful you
must be to imagine that template with one or more of its bracketed parts
missing, making sure that what’s left still makes sense. Just as a pair of adjacent s is an error, so is an unintended pair of adjacent spaces or commas.

Here is a common situation that often arises with personal databases. Suppose that your
colleague’s personal bibliographic database program is able to output its contents in Medlinestyle. In the MH paragraph are a string of keywords separated by semicolons. Unfortunately,
due to the way data were input, or perhaps due to limitations in the original database software,
sometimes there will be an extra semicolon at the end of the paragraph:

Papyrus never likes to import a field that ends with this sort of dangling punctuation. (No selfrespecting keyword, for example, would end with a semicolon!) So we would need to modify
our template to cover this possibility:
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Variant pieces, Part 2

As you see, a set of If First brackets does not necessarily have to include a field code. It’s okay to
just have some punctuation inside there.
•

•

•

Recall that our template currently discards incoming Language information:

Now suppose that we still have no interest in storing the Language when it is English, but that
we would like to keep this information for other languages. Consider this:

Do you understand what I’ve done here? If the Language of the incoming reference is listed as
English, then the first of the two bracketed LAs will gobble up the whole paragraph, and the
second LA section will simply think that no Language had appeared. But if the Language is
something other than English, then the first LA will shrug and go hungry, leaving the second LA
to grab the Language and store it in Papyrus’s Language field.
•

•

•

Sometimes a Medline reference will contain a NO or Notes paragraph:

Let’s store this information in Papyrus’s Comments field:
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Another paragraph that can sometimes appear is PT or Publication Type:

The Comments field seems like a good place for storing this information as well:

WORKBOOK
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Hmm. Now we’ve told Papyrus to put both the Publication Type and the Notes information
into the same Papyrus field, Comments. What will happen if one of the incoming references
includes both of these fields?
Actually, a reasonably nice thing: if an incoming reference includes both fields, they will indeed
both end up in the Comments field. Papyrus will first encounter the PT information, which
goes into the Comments field. When it subsequently runs into the NO information, Papyrus
then adds this to the end of the existing Comments field:

Repeating pieces
Next complication: repeating fields. The fields that most commonly repeat themselves are
authors and keywords. For example, here is a different but equally typical form of Medlinestyle reference:
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While our previous sample reference listed all of its authors in one AU paragraph, and all of its
keywords in a single MH paragraph, this sample gives each author and keyword its own, tagged
paragraph.
To cope with these differences we have to get a little sneaky.
If you can figure this one out before reading further, let me know—we might offer you a
job.

Let’s do the keywords first. You might be tempted to try something like this:

WORKBOOK

But if there are more than three MH paragraphs this won’t work. In any case, such a method is
quite inelegant.
Instead, we leave the Article template alone:
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But in the Details section we specify:

Get it?
Use the

button to insert the paragraph break symbol here. And note that there’s a

space after the hyphen.

•

•

•

We handle the authors in basically the same way, though in the Authors section of the format:
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•

•

•

That takes care of authors and keywords. Once in a while, though, some other field may show
up repeatedly. For example, some Medline-style data sources include multiple PT, Publication
Type, paragraphs. Again we could deal with these like this:

but once again we’d have to guess the maximum possible number of repetitions. Here is where
we use a variant of If First brackets, Multiple brackets:
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While If First brackets mean “this bit may or may not appear,” these Multiple brackets mean
“this bit may or may not appear, or it may appear repeatedly.”
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If an incoming reference includes more than one PT paragraph, then all of these will be stored
in the Papyrus Comments field.

Plug-in filters
I’ve already introduced you to plug-in filters. When your import format specifies one or more
plug-in filters, then each incoming reference will be processed by these filters prior to Papyrus
trying to match it to your format’s templates.
One of the most useful filters is Alphabetize Tags. If your import source does not always present
its tagged paragraphs in a consistent order, then you can use Alphabetize Tags to guarantee a
predictable order. You will then need to set up your templates accordingly.
For example, if we tell Papyrus to use the Alphabetize Tags plug-in with our MED format, then
our template for journal articles must be changed to:

•

•

•

Another filter that some of you will find very helpful is Outdent Percents. Bibliographic sources
from the Unix world were often created using styles known as Refer or Bib. These styles use
tags such as %A and %T rather than AU and TI.
Refer is also the standard export format used by EndNote.

The Outdent Percents filter ensures that any line starting with a percent sign will begin at the
left margin, while all other lines will be indented exactly one space. This will allow Papyrus to
use its usual indentation approach to determine the boundaries of each incoming paragraph.
•
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•

•

A complete list of available plug-in filters appears in the REFERENCE section’s Plug-in Filters chapter.
New filters also appear from time to time on our Web site.
If you are faced with an import problem that you believe needs a new plug-in filter, please
contact our Technical Support department.

Multiple reference types
I have confined my examples in this chapter to journal articles. As should be obvious, other
reference types would be dealt with analogously. However, don’t get carried away. If some
reference types never appear in your source file, then you should not provide a template for
those types.
For each incoming reference, Papyrus will try to apply each defined template until it finds a
match. It always tries the templates of a format in the order shown in the Import window’s popup menu:

So if your file contains, for example, mainly Articles, plus some miscellaneous references that
you wish to classify as Others, there will be three drawbacks if you unnecessarily define templates for any of the remaining reference types. First, you will waste a lot of your time defining
them. Second, Papyrus will waste a lot of its (and your) time trying to apply them to those
references that are supposed to be Others. Third, should Papyrus accidentally succeed, you
may end up with some awfully strange-looking Dissertations and Patents.
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Templates for any user-defined reference types will be tried prior to Notecard and Other
reference.

Data sources from Hell
Here are just the SO paragraphs from a single actual CD-ROM product:
SO: Plant-Physiol. Rockville, Md. : American Soc. of Plant Physiologists. May 1989. v.
90 (1) p. 290-295.
SO: Proc-Natl-Acad-Sci-U-S-A. Washington, D.C. : The Academy. Feb 1989. v. 86 (4) p.
1244-1248. ill.
SO: Inf-Rep-M-X-Marit-For-Rec-Cent-Can-For-Serv. Fredericton : The Centre. 1988.
(169) 14 p. ill., maps.
SO: For-Chron. Ottawa, Can., Canadian Institute of Forestry. Feb 1982. v. 58 (1) p. 3134.
SO: Res-Rep-Off-Rural-Dev-Soil-Sci-Fert-Plant-Prot-Mycol- Korea-Repub-Min-AgricFish. Suwon, The Office. Nov 1981. v. 23 p. 75-79.

Okay, let’s take this one step at a time. Looking at just the first of these, we can create a straightforward first draft template:

I should point out that Papyrus is reasonably smart about journal abbreviations, and will
automatically convert Plant-Physiol into Plant. Physiol. (Yes, well I did say reasonably
smart.)

Note that I’ve used a
code because we have no reason to retain the city of publication
and publishing society for each journal. But this creates a problem. We want the field codes to
match the following bits of data:

But Papyrus only knows that the
is supposed to match something that
ends with a period and space, and that the
will then match the next thing that ends
with period and space. So there is nothing to prevent this match:

Not pretty! So we will make our template a bit more complex:
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This will force the correct matches:

This template will still work for the second example, except that there is now something—
”ill.“—tacked onto the end. Only a slight modification is required:

The third sample lacks both the Day/Month and the Volume. So:

Even with these changes, this will still work for the first two references.

Thus after Papyrus deals with the parenthesized Issue it will try to match something beginning
“ p. “ This will still work for the first two examples, where the page numbers will then be
matched by the
, correctly leaving nothing for the following
. In the third reference Papyrus will not find “ p. “ immediately following the parentheses, so it will go on to take
everything up to the next period (“14 p.“) and match it to the
. Got it?
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The third sample also seems to include the total number of pages—”14 p.“ rather than a pagerange. This is probably because the reference is not really an article from a journal, but rather a
small report published as a pamphlet in a series. Still, the source file actually does categorize
this reference as an “Article.” If we are to accept this categorization and bring in the reference as
an Article (a questionable decision, actually), then let’s save the “14 p.“ in the Papyrus Also
Print field:

The fourth example presents quite a challenge to our composure. We have lost the colon between city and publisher—now there is a comma instead! Well, we could try something like
this:

But no, that would allow these matches for the first sample:

because we have now made the colon optional. No, we need to take a larger perspective:

A significant amount of cogitation should convince you that this template will correctly handle
all of the first four examples.
The fifth example is similar to the fourth, except for omitting its Issue. So:

That takes care of references resembling any of our five samples. But, as you might guess, this
particular data source actually yet further variants! So if you were trying to develop the perfect
import format for this source, you would create the best draft of the format you could, and then
try using it to import a large data file. Each time you found a batch of references rejected, or
matched very strangely, you would go back and modify the format to accommodate that batch.
Then you would have to double check that your modification did not cause problems with the
formerly successful references. For particularly nasty data sources, this iterative process can go
on for days.
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There is one shortcut. Once your format is successfully bringing in a large percentage of the
references, you can give up on the rest and bring them all in as Others. The field codes for
Others are rather more limited than those for Articles, so our template for the SO paragraph
could be:

This will not produce beautiful results in Papyrus, and if you later need to output the references
as a real bibliography they will come out rather oddly. But at least you’ll be getting the information into your personal database.
You can also try complaining to the providers of these nightmare databases. If all of you do so,
they may eventually mend their ways.

See Also...
If you are going to be designing your own import formats, consider this chapter to be just an
introduction to doing so. You will learn much from working on your own formats and paying
close attention to the debugging mode display.
And as I keep mentioning, feel free to contact us for assistance.

See also:
CONCEPTS
Reference Types and Fields
WORKBOOK

REFERENCE
Reference Types and Their Fields
Formats Window
Import
Plug-in Filters
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Introduction
In addition to references to printed material—such as Articles, Books, Chapters, etc.—Papyrus
includes built-in reference types for both Internet and Usenet sources.
You can also include Internet URLs (Unique Resource Locators) within any of your references.
Papyrus can then link to your Web browser, e-mail client, newsreader or other Internet-related
application when you wish to follow those links.
When you have Papyrus create a reference list as an HTML document, Papyrus will incorporate such URLs as active links.

References to online sources
Papyrus comes with two reference types, one for Web pages, ftp sites, etc., and the other for
newsgroup postings on Usenet.

Internet source
The fields available for an Internet source reference include these:
Authors
For some sources, such as many Web pages, this will be an organization rather
than an individual.
Year
It’s up to you whether you indicate the year the source was created, the year it
was last updated, or the year you accessed it. In subsequent fields we’ll get
more specific.
Author e-mail
If relevant, here is where you can provide the author’s e-mail address.
Title
For a Web site this is usually obvious. For an ftp site or some other sources you
might wish to enter a brief description—such as ftp site of Research Software
Design.
URL
This is really the heart of the reference, as it provides the reader a way to look
up the source. You should provide a complete URL, such as http://www.rsd.com/
rather than just www.rsd.com.
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Date posted
This is where you should indicate when the source was posted to the Web, ftp
site, or wherever. Including this date will help readers keep track of updates to
the source.
Date accessed
And this is where you can indicate the date that you last reviewed the source.
Given the dynamic nature of the Internet, this is generally a good thing to include in your citations.
Other typical Papyrus fields are also part of the Internet source reference type, including Also
Print, Abstract, Comments, Keywords, Language and so on.

Usenet post
Newsgroups work a little differently than the rest of the Internet, so we have provided a separate reference type for Usenet posts:
Authors
The human name of the author, if it was included in the post. Otherwise you’ll
have to use your judgement as to the best name, screen name, or other identification to use here.
Year
Nothing tricky here, as all Usenet posts are clearly dated.
Author e-mail
If available, this provides readers with a way to contact the poster.
Subject
The Subject line of the post.
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Newsgroup
It is essential for you to provide the name of the newsgroup to which the post
was made.
Date posted
This is often essential for identifying the correct post.
Message-id
All posts include, somewhere in their headers, an official message-id. This
unique identifier will allow your reader to distinguish among several posts by
the same person to the same newsgroup on the same date.
Archive URL
If the post is available on the Web from a Usenet archive, such as Deja News or
AltaVista, you can provide the URL for that archive’s copy of the post, giving
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the reader a quick and reliable way of locating the post long after it has disappeared from local newservers.
Again, other typical Papyrus fields, such as Abstract and Keywords, are also available for Usenet
post references.

Internet Config
When Papyrus works with your Web browser or other Internet-related application, it uses a
system extension named Internet Config. This is the creation of an international group of programmers, and is available free of charge.
Recent versions of the Mac OS come pre-equipped with Internet Config, as do an increasing
number of commercial applications. Most likely you already have a copy of Internet Config on
your computer. If not, you can download it from the Web, <http://www.share.com/peterlewis/
ic/index.html>.
Internet Config provides a central location for indicating your Web browser, ftp client, e-mail
client, and other Internet-related applications. When you click a URL in Papyrus, it is Internet
Config that sends that URL to the appropriate application.
When you launch the Internet Config application, here is approximately what you’ll see (depending on the version of Internet Config you’re using):

Click the Helpers button. You can now indicate which application should be used for each type
of URL. For example, for a Web URL (“http:”) you should specify your usual Web browser:
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Now when you tell Papyrus to follow a “http:” URL to a Web site, it will automatically instruct
your Web browser to display that site.

WORKBOOK

Chapter 24: Working with the Web

W273

URLs in text
If you select a URL that appears anywhere in Papyrus, you can choose Launch URL from the
Edit menu:

Papyrus will instruct your Web browser (or other appropriate Internet-related application) to
access the URL.
As a shortcut, you can simply - double-click anywhere in the URL to launch it.

Reference URLs
One of the hidden fields available to all of Papyrus’s reference types is URL:
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Use this field to store a relevant link for the reference, such as the entry for an Article in a Webbased database such as PubMed, or an online catalog listing for a Book.
Once you have provided a URL for a reference, you can select that reference in any window and
choose Launch URL from the Edit menu to have your Web browser bring up that URL for you.
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Journal URLs
More and more journals these days have their own Web sites. So in Papyrus, journals also
include their own URL field:

Once you have provided a journal’s URL, you can launch that URL from the Journals window:
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Moreover, when you choose Launch URL for an Article reference, if that reference does not
include anything in its own URL field, then Papyrus will use the URL for the journal in which
the Article appeared.

URLs in HTML reference lists
As you will recall, you can have Papyrus output a list of references as an HTML document,
ready to be posted to your own Web site.
For any reference that includes a URL in its URL field (or, for Articles, in its journal’s URL field),
Papyrus will automatically make that reference into a link to the URL:
<HTML><HEAD><TITLE>Reference List</TITLE></HEAD>
<BODY>
<FONT FACE="Helvetica">
<p ALIGN="center">
<b>References</b></p>
<p ALIGN="justify">
<a HREF="http://www.nejm.com/">1. Runson SK, Rogerstein BT. The judicious use
of nitrous oxide in the treatment of Grave’s disease. New Engl J Med 1990;182:25467.</a></p>
<p ALIGN="justify">
<a HREF="http://www.pergamon.com/JungOld91.html">2. Laszlo JA, Snooks BB,
Old DH. Unconscious punning among medical researchers. In: Jung CG, Old DH, editors. Sublimation and Compensation. New York: Pergamon Press; 1991:102-29.</a></
p>
<p ALIGN="justify">
3. LaFi&egrave;vre H. Why Nothing is Funny: A Deconstructionist Analysis. 2nd ed.
Cambridge: Harvard University Press; 1992.</p>
</FACE>
</BODY>
</HTML></FONT>
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See Also...
About the only thing that this version of Papyrus doesn’t do is act as its own Web server for your
Papyrus database. We do have plans along these lines, but first we’d like to receive suggestions
and requests from those of you who actually use a Macintosh for a Web server. So talk to us!

See also:
REFERENCE
Reference Entry Window
Journals Window
Database Settings
Print/Export
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Introduction
Each Papyrus reference includes a set of fields for holding pictures or other graphics. Possible
uses for these fields include storing illustrations, charts, or tables from the corresponding reference.
By using this feature with references of type Notecard or Slide/Visual, you can even employ
Papyrus as your primary graphics database.

Entering pictures
Unless you have set different preferences, the Picture fields default to hidden. So open a new
Reference Entry window and click the Show hidden fields checkbox. A new field will appear:

You can paste or drag any picture or graphic from any other application to this field:

As with Keywords, each time you insert a Picture a new Picture field opens up, ready for another picture.
If you insert a picture that contains multiple representations, such as PICT plus EPS, or
maybe a QuickTime movie, Papyrus will display only the PICT form but will store all
representations.
This means that you can store a complex graphic from, say, Photoshop in Papyrus.
Even though only the PICT representation will appear while you’re in Papyrus, when
you later copy or drag the Papyrus Picture field to another application, all of the original
data will still be present.
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Displaying pictures
Most Papyrus output formats are set to ignore pictures. But a format can be set to include them,
via its Numbering & Layout section:

When you use this output format, Papyrus will display all of a reference’s pictures immediately
following the reference itself:
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If you tell Papyrus to export references to a MacWrite or RTF file, using an output
format that includes pictures, then the pictures will be correctly exported as well.
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If you tell Papyrus to export references to an HTML file, however, Papyrus will simply
include a generic placeholder for each picture:
<IMG SRC="image_file">
You can subsequently create your Web-appropriate image files and correct these placeholders accordingly.

See Also...
We’re sure that some of you will think of innovative uses for this Papyrus feature. Let us know
what you come up with!

See also:
REFERENCE
Reference Entry Window
Print/Export
Numbering & Layout
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Introduction
Papyrus works very nicely with any spellchecker that uses the standard Word Services interface for communicating with other applications. The most well-known and well-supported
such spellchecker is Spellswell Plus, available at a very reasonable price from Working Software. Another spellchecker that works well with Papyrus is Excalibur, which is free.
For information on Word Services, see <http://www.wordservices.org/>.
Spellswell Plus can be found at Working Software’s site, <http://www.working.com/>.
Excalibur can be downloaded from <http://www.eg.bucknell.edu/~excalibr/
excalibur.html>.

Papyrus can spellcheck any piece of text you enter. It can also check the spelling of one or more
entire references, skipping over fields such as Authors.

Spellchecking text
Any time you select some text in Papyrus, the Edit menu includes a Check Text Spelling item:

When you select this item, Papyrus begins by launching your spellchecker if it is not already
running.
If this is the first time you’ve tried this sort of thing then Papyrus will ask you to locate
your spellchecker.

If the spellchecker has a problem with what you’ve typed, it will ask you to correct the problem.
After you’ve done so the spellchecker will return to the background and you will find yourself
back in Papyrus.
If you did instruct the spellchecker to alter your original text, you will find that the correction
has now been made in Papyrus.
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Spellchecking while saving a reference
You can tell Papyrus to automatically run the spellchecker whenever you save a new or changed
reference.
In a Reference Entry window click the Preferences button:

When you check Automatically check spelling when a reference is saved, any time you save a
new or changed reference in a Reference Entry window Papyrus will first submit the reference
to your spellchecker.
Only certain fields will be spellchecked. By default these include the various Title fields (title of
article, title of book, title of series, etc.), Abstract and Comments. You can pick and choose
which fields you want spellchecked via Database Settings... from the File menu.

If no text is currently selected, then the Check Text Spelling command becomes Check Reference
Spelling...:
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Spellchecking a batch of references

As with Check Text Spelling, Papyrus begins by launching your spellchecker if it is not already
running. Then Papyrus asks you which references to spellcheck:

When you click the Check button Papyrus will then submit each reference in turn to your
spellchecker. Any corrections will automatically be saved, and Papyrus will then proceed to the
next reference.
Your Database Settings (from the File menu) control which fields are to be spellchecked. By
default these are the various Title fields (title of article, title of book, title of series, etc.), Abstract
and Comments.

See Also...
If you try various spellcheckers you will find that some do a better job than others of correctly
implementing the Word Services interface—and therefore some do a better job than others in
working with Papyrus.
Feel free to report your findings to us. In some cases we might be able to work with the maker
of the spellchecker to improve the situation.

See also:
REFERENCE
Reference Entry Window
Database Settings
Check Spelling
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Introduction
You have considerable control over the fields and reference types of your database. You can
change their names and properties, and create new fields and reference types to meet your
needs.
As a general rule you should not create a new field or a new reference type if an existing one
would serve. For example, if you create a new field to hold information that could just have
well been stored in the predefined Comments field, then when you later perform a search you
will have to remember to search the new field rather than Comments. And if you someday give
some or all of your references to another Papyrus user, then that person will have to learn what
customized fields and reference types you have used, as they will now be added to his or her
database as well.
However, there are certainly situations where your particular needs require you to add to
Papyrus’s predefined fields and reference types. This chapter explains how to accomplish this.
There are also aspects of existing fields that you might wish to change. These include indexing
and spellchecking, as well as the order in which fields appear in the Reference Entry window
and whether they are to be Required, Optional or Hidden.

Field definitions
From the File menu choose Database Settings.... In the resulting dialog click the Fields &
Reference Types button. This dialog will appear:

The dialog shows us all of the fields currently defined in your Papyrus database. For each field
five properties are shown:
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Base name
The generic name for the field. The field might take on different names for
specific reference types—for example, Author becomes Inventor in a Patent reference—but the base name is the one that will appear in places such as the
Find dialog.
Field type
Each field has a field type. These include Name, Number, Free text, Title, Year,
etc. A complete list of field types appears in the REFERENCE section’s chapter
Reference Entry Window.
Multiple
Fields such as Author are multiple fields. Each time you enter an author, a new
Author field opens up, ready for the next author. Some other multiple fields
are Editor, Publisher, and Keyword.
Indexing
As explained in the CONCEPTS Indexes chapter, Papyrus uses indexes to speed
up searching operations. When you search for references with a given keyword, for example, Papyrus looks them up in its keyword index rather than
searching through the entire database. Similarly, when you are hunting for references with a particular word appearing in their Abstracts, Papyrus just looks
up that work in the abstract index.
Quite a few fields are not indexed at all. How often are you going to search for
all references whose Volume is 251, for example? Or all references starting on
Page 73?
Some field types have special ways of being indexed. These include Name indexing for authors and editors, Year indexing, and Number indexing.
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Text-containing fields such as Title, Publisher, and Comments can be indexed
in either of two ways. Whole indexing stores the entire field as a unit. This
makes sense for fields where you will enter no more than a short phrase, and
where you’re unlikely to ever want to search on individual words from that
phrase. Some whole-indexed fields include Publisher and City. Piece indexing
treats each word of the field as a separate item. This is appropriate for fields
such as Title or Abstract.
Piece-indexed fields include an additional bit of information:

The number represents the threshold for indexing words from this field. In
this case, the 2 means that for the Abstract field Papyrus will not bother index-
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ing words of only one or two letters. As you can imagine, omitting words such
as a, an, and or from the index will save a lot of storage space.
Spellcheck
As I explained in the previous chapter, Papyrus will spellcheck only certain
fields when you ask it to spellcheck a reference. Here is where you specify
those fields.
As you can see, for these existing fields the only things you can change are the indexing threshold
and spellcheck. The remaining properties are permanently fixed when you create a new field.
The fields shown here are the ones built into Papyrus. For non-built-in fields you would
also be able to change the indexing method.

Reference Type-specific Field definitions
In the Fields & Reference Types dialog change the pop-up menu from Field Definitions to
Article in journal:

Although the Base name for each of Papyrus’s built-in fields cannot be changed, you can change
the corresponding Field name that appears for each particular reference type. Although usually these two names will be the same, here are some examples of the use of different names:
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For each reference type a field is either Required, Optional, or Hidden. When you save a reference, if any Required field is empty then Papyrus considers the reference to be incomplete.
Fields marked Hidden only appear in the Reference Entry window when the Show hidden
fields box is checked. Optional fields always appear, but Papyrus will not be concerned if you
leave them blank.
The checkbox here to the left of the field name indicates that this field is relevant to this reference type. If you scroll down to the bottom of the dialog you will find the fields that do not
apply to journal articles:

Because this is a built-in reference type and these are all built-in fields you cannot check or
uncheck any of these boxes. But you will be able to do so for new fields or reference types, as
you’ll see later in this chapter.
That box to the left of the base names is a handle you can use to drag a field to a different
position in the list. This is how you rearrange the order in which fields will appear in the Reference
Entry window.
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For example, if you would prefer that Abstract appear after the Keywords, you would click the
handle for Abstract and drag the field to the new position:

Making a new Field
Click the New Field... button. The dialog returns to the Field Definitions view, now with a new
field at the bottom of the list:

You can now give your new field a base name and set all of its properties. But note well:
Once you click the OK button, the Field type and Multiple settings become
permanent.

W292 Customizing Your Database

If you change your mind and decide to forget about this new field, click the little trashcan icon.
Once you have clicked OK, though, this icon will disappear and the field will become a permanent part of your Papyrus database.
I’m going to use our new field to store a number from 1 to 5, indicating how reliable I consider
the results reported in a reference. 1 will mean “extremely convincing”, while 5 will stand for
“author must be closely related to the publisher.” I will tell Papyrus to index this field so that I can
use it as a fast search criterion:

Okay, we have now defined a new field. But we still need to attach it to each relevant reference
type.
Start by using the pop-up menu to switch to Article in journal. You’ll find our new field at the
very bottom of the list of unused fields. Click its checkbox and it will spring up to the end of the
type-applicable fields:
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If we desired, we could now change the name of this field that will appear when it is used in an
Article. We could also change the field to Required or Hidden when used in an Article. I’m not
going to change either of those things, but I will drag the field (via its handle, remember?) up to
a position between Abstract and Comments:

So much for Articles. If we wished to add our new field to other reference types we would use
the pop-up menu to select each of those types in turn, and then repeat the steps we followed for
Articles.
For now, though, click the OK button to save our changes. Then click Done in the Database
Settings dialog.
Next let’s see if this worked. Open a new Reference Entry window:

Yes, indeed, there’s our new field, right where we intended it. Now let’s confirm that it is indeed a Number type of field. I’ll try entering something other than a number and see what
happens:
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Looks good!

Making a new Reference Type
In the Fields & Reference Types dialog click the Reference Types... button. This dialog will
appear:
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You cannot edit or delete any of the built-in reference types, hence they are all grayed-out.

Chapter 27: Fields & Reference Types

W295

Let’s create a new reference type. Click the New... button, resulting in the following dialog:

Here we type the name for our new reference type, and then click the New button. Our new
type will now appear on the list:

As with new fields, if you decide to delete this new reference type you must do so before dismissing the Fields & Reference Types dialog. Once you’ve dismissed the main dialog, this new
reference type becomes a permanent part of your Papyrus database.
Click OK. Papyrus will now display the field list for our new reference type:
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Reference # is always the first field for all reference types. Now we must click the checkbox of
each additional field that should be included for our type. Then we can arrange these fields in
whatever order we wish, change the field names, etc.
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Now click the OK button, and then dismiss the Database Settings dialog.
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Let’s double-check our work. Open a new Reference Entry window and use the pop-up menu
there to change to our new reference type:

Yes, everything seems to be in order.
We’ll be discussing that string of semicolons in just a moment.
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Updating your Formats
After you create a new field or reference type, you will notice some suboptimal side-effects in
the Reference Entry window.
New fields don’t show up in the preview display:

And with a new reference type the display is quite odd-looking indeed:
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The same applies to the All References window:

Quick reader challenge: So what’s the problem here? What’s the solution?
Subtle hint: see chapter subtitle, above.

The problem here is that the preview display uses Papyrus’s built-in STANDARD format. And
the All References window uses the BRIEF format. (Unless you’ve changed those settings in
your Preferences.) Neither of these built-in formats—nor any other existing format, for that
matter—knows about your new field or new reference type.
A new field is not included in the format’s templates that indicate which fields appear, in what
order, and with what intervening punctuation. So when you display a reference containing
information in the new field, that information will not be included.
For new reference types, there isn’t even a template. Rather than display absolutely nothing,
though, Papyrus makes up a stand-in template for the new reference type, simply displaying
all fields, in the same order used in the Reference Entry window, separated by semicolons.
Second chance reader challenge: So what’s the solution?
The solution is to update your formats, editing them to teach them about your new field or
reference type. Using the techniques described in the Creating New Output Formats chapter, you
must edit each format that you use. Go through the format’s existing templates and add your
new field wherever you would like it to appear. And create new templates in there for your new
reference types.
However, Papyrus does not allow you to edit its built-in formats—STANDARD, BRIEF, and
COMPACT. (Why do you think they’re called “built-in”?) So for these you must do the following:
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• In the Formats window, select one of the built-in formats.
• Click the Duplicate button.
• You now have a new format with a name such as STANDARD copy. Change
the name to something more meaningful such as STANDARD for Sally.
• Edit this new format, adding your new fields to the existing templates and
creating new templates for your new reference types.
• Using the Preferences... buttons in the Reference Entry, Group, and All References windows, change the default display format from STANDARD or
BRIEF to STANDARD for Sally or BRIEF for Sally.

See Also...
Although Papyrus does make it easy for you to create new fields and new reference types, you
will want to consider carefully before doing so. As indicated by what you’ve just read about
updating your formats, there are going to be a few side-effects when you alter the fundamental
structure of your database.
But when you’ve got a good reason to add a new field or reference type, go for it! Papyrus is
here to meet your needs.

See also:
REFERENCE
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Database Settings
Reference Entry Window
Template Entry
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Introduction
Papyrus uses the Macintosh’s system software to sort alphabetic entries according to the rules
of whatever languages you prefer. In addition to setting the language rules for your entire
Papyrus database, you can also override these for individual Groups.
Most of you in countries using Western European languages have a single script system installed on your computers, namely Roman. Within the Roman system are included languages
such as English, French, German, Danish, etc.
There are many script systems available. These include Japanese, Chinese, Arabic, Hebrew,
Thai and quite a few others. As with the Roman script system, each of these can include a
number of languages and dialects.
If your Macintosh uses more than one script system, Papyrus allows you to specify for each
script system which language’s rules should govern alphabetizing.

Database sorting
From the File menu choose Database Settings... Then click the Alphabetizing button to bring
up this dialog:

From the pop-up menu pick the appropriate language.
We have provided the Sort umlauts as in German checkbox for two reasons. First, even if you
are sorting according to the rules of English you might prefer to sort umlauted letters according
to the German method (ö sorted as oe) rather than the English method (ö sorted as o).
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Second, our experiments with at least some versions of Apple’s system software have shown
that even when set to use German rules, the system software continues to sort ö as o. If you
check the above box then Papyrus will ensure the correct sorting of umlauted letters.
If you have multiple script systems installed, then they will all appear in the Alphabetizing
dialog:

Group sorting
With a Group open, go to the Group menu and choose Sort....
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The language pop-up menu allows you to specify the language whose alphabetizing rules should
govern the sorting of references in this Group. You might want to override your database’s
language settings, for example, if you keep your database sorted according to your native language but are currently preparing a bibliography for publication in a foreign language journal.
As with the database settings, you can indicate what to do about umlauted letters independently of the language rules.
If your system includes more than one script system, a second pop-up menu will appear:

Select in turn each script from the script menu, and then use the language menu to choose the
appropriate language for that script.

See Also...
While Papyrus makes it easy for you to change the method of alphabetizing, behind the scenes
Papyrus has to do a remarkable amount of work to keep everything consistent. Let us know if
you ever come upon a language with which Papyrus doesn’t seem to be working perfectly!

See also:
REFERENCE
Database Settings
Sort
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Introduction
If you or one of your colleagues uses Version 7 of Papyrus for DOS, then you may want to
exchange information between that Version 7 database and your Papyrus Version 8 database.
We have put considerable effort into making this sort of exchange as smooth as possible. The
differences between Macintosh and DOS mainly relate to accented and non-English characters,
and we have done what we can to deal with those issues automatically. But the bigger challenge
lies in the differences between Version 7 and Version 8 of Papyrus—the latter includes many
more fields and reference types, so clearly there must be some compromises made when sending Version 8 data back to a Version 7 database.
In this chapter I’ll cover the various sorts of transfers possible between the two versions of
Papyrus.

7→
→8: Entire database
Transferring an entire Version 7 database to Version 8 is straightforward. You will have Version
7 create a set of Papyrus “back-up” files. Then you will tell Version 8 to import these files into a
Version 8 database.
You can create a fresh Version 8 database into which the data are to be transferred. Or you can
bring the data into an existing Version 8 database that already contains its own information.
Duplicate references, journals, and keywords will all be handled intelligently.
In Version 7 do this:
• From the Utilities menu, run Create Back-up Files. This will create a set of
files whose names all end in .BB.
Don’t confuse these with the *.BIB files that comprise your Version 7 database itself.

Next do this:
• Move all of these *.BB files from the DOS computer to your Macintosh.
Now in Version 8 do this:
• Either open an existing Papyrus Version 8 database, or else create a fresh one.
• From the File menu choose Papyrus-Papyrus Transfer...
• Click the button Import from Version 7 - *.BB files.
• Papyrus will ask you to point it to one of the *.BB files, specifically
BACKUP.BB. (Things will be simplest if all of the *.BB files are located in the
same folder as BACKUP.BB.)
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You will now be faced with this dialog:

This dialog is quite similar to Papyrus’s usual Import dialog. The sections regarding Duplicate
references, Keywords, and Reference numbering behave identically.
If your Version 7 database includes notecards, then you’ll want to give a moment’s thought to
dealing with notecard numbering. In Version 7 notecards do not have numbers; they are simply a sort of sub-record tied to a particular reference. But in Version 8 notecards are independent
records in their own right, each with its own Reference #.
If you intend to retain the Reference #s for incoming references, then you will not want incoming notecards to be assigned numbers in the same range. That could lead to a notecard being
given a number already in use by a reference yet to be imported, which in turn will lead to that
reference being assigned a fresh number upon arrival, which in turn will usurp a different
reference’s number, and so on.

After you click Proceed, the Transfer progress window will appear:
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So if you do wish to retain your Version 7 references’ Reference #s, for Starting number for
incoming notecards you should enter some large number, beyond that in use by your existing
references. For example, you might start notecard numbering at 10000.

Papyrus will begin by importing all of the Version 7 keywords, and then all of the journals. The
biggest job is importing the “main” file, which includes the references and notecards (and also
glossary entries). Hooking everything up correctly involves three passes through the main files,
as indicated by the three divisions of the progress bar for Main. Finally the Version 7 formats
will be converted into Version 8 formats and transferred.
Once transferred, the Version 7 keywords, journals, references, etc. will be full-fledged Version
8 records. The only way to see that any of these originated in Version 7 is by doing a Get Info on
one of the transferred references or notecards:

7→
→8: Selected references
Version 7 uses the PAPX format to transfer references from one Version 7 database to another.
You can use this same format to send references to Version 8.
In Version 7 do this:
• If you have never used the PAPX format, use the Format liBrary option to
open the IMPORT.FLB Format Library and then copy PAPX from the Library
to your database.
• From the main menu, use the List option to export whichever references you
like. Be sure to specify PAPX as the format to use. Papyrus will create a text
file with whatever name you indicate.
Next do this:
• Move this text file from the DOS computer to your Macintosh.
Now in Version 8 do this:
• Either open an existing Papyrus Version 8 database, or else create a fresh one.
• From the File menu choose Papyrus-Papyrus Transfer....
• Click the button Import from Version 7 - PAPX file.
• Papyrus will ask you to identify the PAPX text file to be imported.
You will now be faced with this dialog:
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This dialog is quite similar to Papyrus’s usual Import dialog. The sections regarding the Log
and other files, Duplicate references, Keywords, and Reference numbering behave identically.
If your Version 7 database includes notecards, then you’ll want to give a moment’s thought to
dealing with notecard numbering. In Version 7 notecards do not have numbers; they are simply a sort of sub-record tied to a particular reference. But in Version 8 notecards are independent
records in their own right, each with its own Reference #.
If you intend to retain the Reference #s for incoming references, then you will not want incoming notecards to be assigned numbers in the same range. That could lead to a notecard being
given a number already in use by a reference yet to be imported, which in turn will lead to that
reference being assigned a fresh number upon arrival, which in turn will usurp a different
reference’s number, and so on.

After you click Proceed Papyrus will ask you what you wish done with the three user-defined
fields from Version 7:
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So if you do wish to retain your Version 7 references’ Reference #s, for Starting number for
incoming notecards you should enter some large number, beyond that in use by your existing
references. For example, you might start notecard numbering at 10000.

If this is your first transfer from Version 7 then you might indeed want to let Papyrus proceed to
make New fields for each of these. As in Version 7 the fields will initially be named Field A, Field
B, and Field C, but you can change these field names later.
If you have already imported some Version 7 references, though, you will find that your Version 8 database already has three fields with these names. In that case use the pop-up menus to
ensure that those same fields are used now:

However, consider this. If you are transferring references from several different people’s Version 7 databases, then you might actually prefer to create a new set of fields for each of these. If
John used his Field A to indicate in which filing cabinet he stored his reprints, while Jane used
her Field A to hold the price of her books, and Jean used Field A for the color of book jackets,
then you don’t necessarily want all of these disparate bits of knowledge to end up in the same
field in your Version 8 database.
Finally, because Papyrus Version 8 contains a number of fields that were not present in Version
7, you might now choose to have Papyrus move information from a Version 7 user-defined
fields into a now-available Version 8 field.
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7→
→8: Keywords
It’s easy to transfer a list of keywords from Version 7 to Version 8.
In Version 7 do this:
• From the main menu choose Keywords, and then from the Keyword Options
menu choose List.
• Indicate the starting and ending range of keywords you wish to transfer.
• For On device: choose File. When asked for Filename: enter whatever name
you like.
• Papyrus will then ask Suppress header and frequencies, for subsequent Keyword Load? Answer Y.
• Papyrus will now create a text file with the name you provided, containing a
list of keywords.
Next do this:
• Move this text file from the DOS computer to your Macintosh.
Now in Version 8 do this:
• Open the Keywords window.
• Click the Load... button.
• Papyrus will ask you to identify the text file containing the keyword list.
That’s all there is to it, with one caveat.
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Papyrus Version 8 assumes that the incoming text file is a Macintosh text file rather than a DOS
text file. This means that accented letters and non-English characters will be altered in the
loading process. So if your keywords do contain such characters you should first use your
Macintosh word processor to open the text file, clean up any mistranslated characters, and
then save the results as a new text file. This new file is the one that you will then tell Papyrus to
load.

7→
→8: Journals
It’s easy to transfer a list of journals from Version 7 to Version 8.
In Version 7 do this:
• From the main menu choose Journals, and then from the Journal Options
menu choose List.
• Indicate the starting and ending range of journals you wish to transfer.
• If your Version 7 database includes more than one journal abbreviation style,
Papyrus will now ask you which style to include in the list. Pick whichever is
appropriate.
If you have more than one abbreviation style, and wish to transfer all of them, then you
will repeat this entire transfer process for each style. Papyrus will intelligently merge
incoming journals that share a common journal name.

• For On device: choose File. When asked for Filename: enter whatever name
you like.
• Papyrus will then ask Suppress header and frequencies, for subsequent
Journal Load? Answer Y.
• Papyrus will now create a text file with the name you provided, containing a
list of journals.
Next do this:
• Move this text file from the DOS computer to your Macintosh.
Now in Version 8 do this:
• Open the Journals window.
• Click the Load... button.
• Papyrus will ask you to identify the text file containing the journal list.
You will then be asked:
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If in Version 8 you have not created your own custom journal abbreviation styles, then the
suggested Standard abbreviation style is indeed the correct answer. Otherwise pick whichever
abbreviation style is appropriate.
Papyrus Version 8 assumes that the incoming text file is a Macintosh text file rather than a DOS
text file. This means that accented letters and non-English characters will be altered in the
loading process. So if your journals do contain such characters you should first use your
Macintosh word processor to open the text file, clean up any mistranslated characters, and
then save the results as a new text file. This new file is the one that you will then tell Papyrus to
load.
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7→
→8: Formats
Papyrus Version 8 is not able to read a Format Library created in Version 7.
So if you wish to transfer one or more Version 7 formats to Papyrus, you must do so by transferring an entire database which includes those formats.
If you only want to move some specific formats from Version 7 to Version 8, then, here is a
reasonable approach:
In Version 7 do this:
• Make a new Format Library and add the relevant formats to it.
• Make a new, empty Version 7 database.
• In this new database, open the Format Library and copy all the formats from
it.
• From the Utilities menu, run Create Back-up Files. This will create a set of
files whose names all end in .BB.
Next do this:
• Move all of these *.BB files from the DOS computer to your Macintosh.
Now in Version 8 proceed as I’ve explained under 7→8: Entire database.
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8→
→7: References
Papyrus Version 8 can export references using the PAPX format recognized by Version 7.
In Version 8 do this:
• If you wish to export only selected references from your total database, then
either select them in the All References window or a Group window, or else
create a Group that contains just the relevant references.
• From the File menu choose Papyrus-Papyrus Transfer...
• Click the button Export for Version 7.
Papyrus will now ask you which references you wish to export:

When you click Proceed, Papyrus will have you provide a name for the new file it is about to
create.
Next do this:
• Move this file from your Macintosh to the DOS computer.
Now in Version 7 do this:
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• If you have never used the PAPX format, use the Format liBrary option to
open the IMPORT.FLB Format Library and then copy PAPX from the Library
to your database.
• From the main menu, choose the iMport option. When asked, tell Papyrus the
name of the file you have brought over from the Macintosh, and specify PAPX
as the import format to use. Stick with the suggested Fussiness Level of
Oblivious. Answer the remaining questions as you deem appropriate.
If your Version 8 references include information in fields that did not exist in Version 7, this
information will be moved to the Comments field.
If any of your Version 8 references are of a reference type that did not exist in Version 7, they will
be exported as type Other.
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8→
→7: Keywords
Moving a list of keywords from Version 8 to Version 7 is straightforward.
In Version 8 do this:
• Open the Keywords window.
• If you wish to export only certain keywords, select them now.
• Choose Print/Export... from the File menu. In the resultant dialog, specify
Plain text document:

• Click the Layout... button and set Skipped lines between items to 0. Also
make sure that Fixed line length is not checked.
• Provide a name for the new file Papyrus is about to create.
Next do this:
• Move this new file from your Macintosh to the DOS computer.
• You must convert the Macintosh text file that Papyrus has created to a DOS
text file. The easiest way to do this is via the program MACCVT.EXE, available from your DOS Papyrus installation disks or from our Web site.
Now in Version 7 do this:
• From the main menu, pick Keywords.
• From the Keyword Option menu, pick lOad.
• Identify the file to be imported. (This will be the file created by MACCVT.EXE).
Papyrus Version 8 creates a Macintosh text file rather than a DOS text file. Although
MACCVT.EXE handles the basic Mac→DOS conversion, it does not do anything about accented
letters or non-English characters. If your keywords contain such characters, then after running
the file through MACCVT.EXE you should use your DOS or Windows word processor to open
the text file, clean up any mistranslated characters, and then save the results as a plain ASCII
text file. This new file is the one that you will then tell Papyrus to load.
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8→
→7: Journals
Moving journals from Version 8 to Version 7 is straightforward.
In Version 8 do this:
• Open the Journals window.
• If you wish to export only certain journals, select them now.
• Choose Print/Export... from the File menu. In the resulting dialog, specify
Plain text document. (Do not check the For Version 8 journal load box that
will appear when you select Plain text.)

• If you have set up more than one journal abbreviation style in your database, you can use the pop-up menu to pick the appropriate one.
If you have more than one abbreviation style, and wish to transfer all of them, then you
will repeat this entire transfer process for each style. Papyrus will intelligently merge
incoming journals that share a common journal name.
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• Click the Layout... button and set Skipped lines between items to 0. Also
make sure that Fixed line length is not checked.
• Provide a name for the new file Papyrus is about to create.
Next do this:
• Move this new file from your Macintosh to the DOS computer.
• You must convert the Macintosh text file that Papyrus has created to a DOS
text file. The easiest way to do this is via the program MACCVT.EXE, available from your DOS Papyrus installation disks or from our Web site.
Now in Version 7 do this:
• From the main menu, pick Journals.
• From the Journal Option menu, pick lOad.
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• Identify the file to be imported. (This will be the file created by MACCVT.EXE).
• If this Version 7 database includes more than one journal abbreviation style,
Papyrus will now ask you which one is being used in the incoming file.
Papyrus Version 8 creates a Macintosh text file rather than a DOS text file. Although
MACCVT.EXE handles the basic Mac→DOS conversion, it does not do anything about accented
letters or non-English characters. If your journals contain such characters, then after running
the file through MACCVT.EXE you should use your DOS or Windows word processor to open
the text file, clean up any mistranslated characters, and then save the results as a plain ASCII
text file. This new file is the one that you will then tell Papyrus to load.

See Also...
If you will often be moving data back and forth between Versions 7 and 8 of Papyrus you may
decide to limit yourself in Version 8, sticking to the fields and reference types that exist in Version 7. You will want to give this a little thought, and maybe some experimentation.
When you transfer either an entire database or selected references back and forth, Papyrus
will automatically handle all DOS/Mac conversions. When you transfer only a text file containing a list of journals or keywords, though, remember to use a word processor to clean up
accented and non-English characters.

See also:
REFERENCE
Keywords Window
Journals Window
Formats Window
Papyrus-Papyrus Transfer
Print/Export
Import
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Introduction
We have designed Papyrus Version 8 so that transfers between databases are very easy.
Recall that every Papyrus database comprises two documents—a main database document
and an index file:

To make a back-up copy of your entire database, or to move the entire database to another
computer, simply copy both of these documents.
If you lose the index file, or you’re too short on space to copy it, that’s okay. From just a
main database document Papyrus can regenerate the associated index file.

If you wish to combine two different databases on the same computer, you will tell Papyrus to
read into one database all the data from the main database document of the other database.
If you wish to combine two different databases on different computers, you must first copy the
main database document from one database to the other computer. You do not need to also
copy the index file, though.
In the following sections I will provide the details for transferring an entire database, as well as
instructions for transferring only selected references, keywords, journals, etc.

Entire database
An extremely common situation arises when you wish to use the same database on more than
one computer. You might want to move the database back and forth between your desktop and
laptop machines, for example. Or between the computers of a researcher and a secretary.
All you need do is copy both the main database document and the index file of the database
from one computer to the other, in the process overwriting the older copy of the database previously present on the recipient computer.
Be careful to make all additions and corrections to just one of the computers. Later you can
copy the entire updated database back to the other machine.
•

•

•
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It is also possible to absorb one database into another. Perhaps one of your Papyrus-using
colleagues wishes to share her data with you. Or maybe you are collecting into one master
database all of the information that several other people are gathering in their own databases.
With your own already database open, here is how to absorb another database:
• From the File menu choose Papyrus-Papyrus Transfer...
• Click the button Import from Version 8.
• Papyrus will ask you to point it to the main database document from the
other database.
You will now be faced with this dialog:

This dialog is quite similar to Papyrus’s usual Import dialog. The sections regarding Duplicate
references, Keywords, and Reference numbering behave identically.
When you click Proceed, the Transfer progress window will appear:
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Papyrus will deal intelligently with duplicate keywords, journals, etc.
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Later you can always determine the origin of a reference via Get Info:

Selected references
You may find yourself in a situation where you wish to move some references from one Papyrus
database to another, but not the entire database of references. In such cases your first step will be
to create a new main database document that contains only the relevant references.
• Begin by making a Group that contains the references in question. Or else
select these references in the All References window or in some Group
window.
• From the File menu choose Papyrus-Papyrus Transfer...
• Click the button Export for Version 8
Papyrus will now ask you which references you wish to export:

If you have links connecting these references to other references or notecards, you have the
option of automatically including all such linked items in your export. And, as usual with links,
you can click the Links... button to specify which types of links should be followed.
As you can see, you also have the option of exporting your database’s entire collection of keywords, journals, formats, and/or glossary entries. If you do not select these, Papyrus will still
export any journals or keywords that are cited by the references that are exported.
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When you export references, Papyrus automatically includes in the new database document the definitions of any new fields or reference types you have created. This will
allow the recipient database to correctly “understand” all of the incoming data.

• After you click Proceed, Papyrus will ask you to provide a name for the new
main database document it is about to create.
The main database document you have just created is a full-fledged Papyrus database main
database document. If you give it to a new Papyrus user, that person can take this file, as is, as
the starting point for his own database.
But if the recipient already has his own Papyrus database, and now wishes to add to it the data
from your document, he simply follows the same Import from Version 8 steps I’ve already described.

Keywords
To move your entire keyword collection to another Papyrus database, you can follow the Export for Version 8 steps described earlier in this chapter.
But if you wish to transfer only a selected subset of your keywords, then there is a different
approach. You will tell Papyrus to export that subset of keywords to a text file. Then the recipient database will Load the text file, absorbing these new keywords.
To export the keywords, do this:
• Open the Keywords window.
• Select the relevant keywords.
• Choose Print/Export... from the File menu. In the resulting dialog, specify
Plain text document:
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• Click the Layout... button and set Skipped lines between items to 0. Also
make sure that Fixed line length is not checked.
• Provide a name for the new file Papyrus is about to create.
Now to import the keywords into the recipient database, do this:
• Open the Keywords window.
• Click the Load... button.
• Papyrus will ask you to identify the text file containing the keyword list.

Journals
To move your entire journal collection to another Papyrus database, you can follow the Export
for Version 8 steps described earlier in this chapter.
But if you wish to transfer only a selected subset of your journals, then there is a different
approach. You will tell Papyrus to export that subset of journals to a text file. Then the recipient
database will Load the text file, absorbing these new journals.
To export the journals, do this:
• Open the Journals window.
• Select the relevant journals.
• Choose Print/Export... from the File menu. In the resultant dialog, specify
Plain text document:

• If you select For Version 8 journal load, then Papyrus will include each
journal’s Call Number, ISSN, URL, and Comments in addition to its name
and abbreviation.
• If you have set up more than one journal abbreviation style in your database, you can use the pop-up menu to pick the appropriate one.
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If you have more than one abbreviation style, and wish to transfer all of them, then you
will repeat this entire transfer process for each style. Papyrus will intelligently merge
incoming journals that share a common journal name.
Are you wondering why checking For Version 8 journal load can’t include all abbreviation styles along with the rest of each journal’s information? The reason is that your
database and the recipient database might have different numbers of abbreviation styles,
or different assignments—e.g., your style #2 might correspond to the other database’s
style #3. By including only a single style here in the export step, we allow the recipient to
assign the incoming abbreviation to the correct field.

• Click the Layout... button and set Skipped lines between items to 0. Also
make sure that Fixed line length is not checked.
• Provide a name for the new file Papyrus is about to create.
Now to import the journals into the recipient database, do this:
• Open the Journals window.
• Click the Load... button.
• Papyrus will ask you to identify the text file containing the journal list.
You will then be asked:
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If in the recipient database you have not created your own custom journal abbreviation styles,
then the suggested Standard abbreviation style is indeed the correct answer. Otherwise pick
whichever abbreviation style is appropriate.

Formats
To move your entire format collection to another Papyrus database, you can follow the Export
for Version 8 steps described earlier in this chapter.
You also already know how to move only selected formats—via Format Libraries:
• From the Formats window create a new Library, and drag or copy into it the
relevant formats.
• Then take that Library to the recipient database, open it, and drag or copy
the formats from the Library window to the database’s Formats window.

Names
You cannot transfer your database’s entire list of author and editor names to another database,
for the simple reason that the Names window only shows two kinds of names:
• Names that are currently cited by at least one reference
• Names that are sorted differently than they are spelled
So a recipient database won’t be interested in any normally-sorted names that do not already
appear amongst its references’ authors and editors.
However, if you have carefully checked the sorting of many names in your database that are
indeed sorted differently from their spelling, you might wish to share this information with
another Papyrus database.
To do so, you will export some or all of the names from your database to a text file. Then the
recipient database will Load the text file. When it does so, it will ignore any normally-sorted
names. But any names whose sorting differ from their spelling will be retained.
To export the names, do this:
• Open the Names window.
• Optionally, select the relevant names.
• Choose Print/Export... from the File menu. In the resultant dialog, specify
Plain text document:
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• Click the Layout... button and set Skipped lines between items to 0. Also
make sure that Fixed line length is not checked.
• Provide a name for the new file Papyrus is about to create.
Now to import the names into the recipient database, do this:
• Open the Names window.
• Click the Load... button.
• Papyrus will ask you to identify the text file containing the list of names.

Glossary entries
To move your entire glossary to another Papyrus database, you can follow the Export for Version
8 steps described earlier in this chapter.

To export the entries, do this:
• Open the Glossary window.
• Select the relevant entries.
• Choose Print/Export... from the File menu. In the resultant dialog, specify
Plain text document:
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But if you wish to transfer only a selected subset of your glossary entries, then there is a different approach. You will tell Papyrus to export that subset of entries to a text file. Then the recipient
database will Load the text file, absorbing these new glossary entries.

• Click the Layout... button and set Skipped lines between items to 0. Also
make sure that Fixed line length is not checked.
• Provide a name for the new file Papyrus is about to create.
Now to import the glossary entries into the recipient database, do this:
• Open the Glossary window.
• Click the Load... button.
• Papyrus will ask you to identify the text file containing the entries.

See Also...
As you’ve seen, exchanging data between Version 8 databases is straightforward, yet very flexible.

See also:
REFERENCE
Keywords Window
Journals Window
Formats Window
Names Window
Glossary Window
Papyrus-Papyrus Transfer
Print/Export
Import
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Index 1

Index
Symbols
• (target window) R78
# major keywords C36, R31
* (wildcard) W92–W93, R73
\ (backslash) R67

A
Abbreviation styles
journal C30, R239–R240
Abbreviations
indexing of C58
journal C21, C30, R239–R240
Abominable databases W241
Abstract field R30
Abstract from conference proceedings R54
Accented letters W18
Access Codes C68, R237
Access, read-only I4
Accession # field R32
vs. Catalog # field R32
Acronyms, indexing of C58
Additions folder R6
Address. See Affiliation/Address field
Affiliation/Address field R34
Agreement, license I5, I7–I11
Alias
to Papyrus database R12
to Papyrus Help folder R5
All References window R114–R125
display formats R117–R118
drag and drop R121
elements of R115
preferences R118, R119
shortcuts S13–S15
Allowable Reference Numbers R231
Alphabetic order C4, C12, R236–R237, R360
Alphabetize Tags plug-in filter W262
Alphabetizing rules W304–W306
Also Print field R37
American Antiquity format W199–W202
And others C14, R33
AND vs. OR in searches W89–W90
Anon. W201, C14, R33, R94

Index 2

Anonymous W193, C14, R33, R94, R243, R381
vs. Anon. W176, W201, R94, R381
Anthropology
American Antiquity format W199–W202
Antonyms, keyword C38–C39
Apple Computer
less than helpful W122
Apple Events
printing/exporting via R274
AppleScript
most feeble implementation W52
printing/exporting via W52, R274
AppleWorks W51, W52, W122
shockingly inadequate R274
Applications, helper R241
Applications, patent R52
Approach, cool W52
Archival materials R38
Article
in journal R39
newspaper R50
Associated Reference field R98
Assumptions, overriding R67
Author-Year citation. See Name-Year citation
Authors. See also Names
anonymous
W176, W193, W201, C14, R33, R94, R381
appearance in bibliographies W13, C13–
C14, C42–C44, R376–R382
variations C42–C43
corporate C14, R33, R95
in-text citations
ALL CAPS R362
small caps R362
initials vs. first names C42, R32, R190
looking up R73
maximum number of R20
repeated W193, C13
sorting C43, R190
suppress anonymous W193, W201, C14, R94
Authors dialog R376–R382
Authors field R32–R33
Authors Role field W19, R33–R34, R40

B
Backing up database W322, R249
Backslash (\) R67
Balloon help W12, R14–R15
tour W12, R15

C
Call number
journals C32, R163
Capitalization
headline style C15, R30
sentence style C15, R30
Capitalize brackets W196
Capitalizing titles W16, C15
Card Title field W65, C50
Catalog # field R41
vs. Accession # field R32
CD-ROM, installing Papyrus from R4
Change Field Dialog W112–W114, R290–R293
Change text W104–W115, R284–R287, R292–
R293
Changes, global W104–W115
Chapter # field R45
Chapter in book R44–R45
Character set
importing references R329

Characters
accented W18
non-English W18
Check database integrity R248
Checking spelling. See Spellchecking
Chem Abstracts W222
Chicago Manual of Style format W188–W199
Chihuly flasks R352
Citation
Harvard style C16
in text C12, C15, C16
et al. R364
names ALL CAPS R362
names small caps R362
name-year C12, C16
adding initials C16, R362
adding letter C16
numeric C15
Citation order W78–W80, C4, C12, C63, R360
Cite dialog W126–W127, R321–R322
shortcuts W126–W127, S43
Cite Settings dialog R323–R324
Citing
Internet sources R47
multiple references at once W136–W139
references in press C14–C15
URLs R47
Citing references R314–R324
as plain text R320
by ID Field R361
by year only W124, R318
formatted W126–W127
hiding the citation R319
inserting as formatted references R319
sorting within manuscript citation R318
Citing specific pages C4, C17, R316–R317
ClarisWorks W52, W122
shockingly inadequate R274
Clerks, rogue data-entry W222
Client-server R24–R26
Closing windows
without being asked to save S12, S19
Collapse fields W41, R102
Colleagues, clamoring I4
Collections of formats. See Format Libraries
Collections of references. See Groups
Column Break W205

Index 3

CONCEPTS

Base font W40, R275
Base name for field W289
Bibliographic styles. See Formats
Bibliography
authors in R376–R382
automatically adding to manuscript. See Process
Manuscript
editors in R376–R382
et al. in R382
importing into Papyrus W230–W237
indentation in R372–R373
pictures in W281–W282, R373
vs. footnote list C4–C5
Bibliography editors C8
BibTeX R242, R412–R426
Biological Abstracts W222
BIOSIS W222
Book series R41
Book/Monograph R40–R43
Brackets
Capitalize W196
If Any W185
If Any vs. If First W185
If First W183–W184
Multiple W258–W262
Browser, Web R241
BRS W222

Combining
databases W322
journals R165
keywords R153
names R192
Combining multiple references in one citation
W136–W139
Commentators R33–R34, R41, R95
Comments
field R30
journals C32, R163
Compilers R33, R34, R41, R95
Conference proceedings R53–R57
Copies
of database W5, R26
Copying
database to another computer W322
formats R178
formatted reference to manuscript W126–W127
references R108
to other applications R323
Corporate author C14, R33, R95
Creating
new database W4–W20, R9
new fields W292–W295
new formats W170–W207, W231–
W233, W240–W267, R177
new glossary entries R202
new Groups W72–W73
new journals R163
new keyword links W142–W145, W145, R212–
R215
new keywords R151, R238
new notecard W64–W65
new reference links W152–W154, R224–R226
new reference types W295–W298
new references W10–W20, W22–W32, R86–
R111
Creating a subset of a database R266
Cross-Reference List W160–W163, R279
Current Contents on Diskette W222
Cursor, hollow R81

D
Data entry shortcuts
Reference Entry window S11

Index 4

Database
alphabetizing W304–W305
backing up W322, R249
copies of W5, R26
copying to another computer W322
creating a subset of R266
creating new W4–W20, R9
description W5–W6, R231
index file W5, R10, R249
indexes C54–C59, R249
integrity R248
limits R20
locked R25–R26, R83
main document W5, R10
alias to R12
multi-user R24–R26
new R9
pieces of C20–C24, R10
read-only R25–R26, R83
repair R246–R249
shared R24–R26
sorting W304–W305
splitting R266
subset of C62–C65. See also Groups
transferring data to another W308–
W320, W322–W330, R252–R266
advanced concerns R260–R263
exporting for Version 7 W317, R264
exporting for Version 8 W322–W330, R265–
R266
importing from Version 7 via *.BB files
W308–W310, R258–R259
importing from Version 7 via PAPX W310–
W312, R256–R257
importing from Version 8 R253–R255
Database Info dialog W5–W6, R83, R231–R232
Database Repair dialog R246–R249
Database Settings dialog R234–R243
Databases
abominable W241
combining W322
distinct I5, I7
merging W322
multiple W6
Date Accessed field R47
Date field R96
Date, journal C30–C32

New Keywords R238
Numbering & Layout R368–R373, R369
Papyrus-Papyrus Transfer R252–R266
Print/Export W46–W54, R268–R277
Process Manuscript W122–W124, R345–R348
Refine Search R309–R311
shortcuts S41
Sorting & Citing R358–R365
Template Entry R384–R393
shortcuts W181, S47–S48
Dialogs
shortcuts in S3
Display formats
All References window R117–R118
Group window R136–R137
Reference Links window R222
Dissertation/Thesis R45–R46
Dissertations on Microfilm R46
Distinct databases I5, I7
Document Type field R98
Document/Media Type field R37
Drag and Drop
All References window R121
Formats window R182
Glossary window R205
Group window R140, R141
Journals window R169
Keyword Links window R215
Keywords window R155
Names window R194
Reference Entry window R106
Reference Links window R227
to other applications R323
Drag and Drop shortcuts
All References window S14
Formats window S27
Glossary window S31
Group window S18
Journals window S25
Keyword Links window S33
Keywords window S22
Names window S29
Reference Entry window S10
Reference Links window S35
Dragging
formatted reference to manuscript W126–W127
references to other applications R323
Drones, underpaid undergraduate, ravages of
R238
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Date Posted field R47
Dates
entering R96
ISO form R96
Day & Month field W183, R95
Day, Month & Year field R96
Debugging
importing references W218, W233–
W234, R334–R335
Degree field R97
Deleting
formats R178
glossary entries R203
journals R164
keyword links W145–W146, W147–
W152, R215
keywords R152
reference links W154, R226
references W41–W42
Delimiters
in-text placeholders R315
Demande R51
Demo version of Papyrus I4, I7
Departmental site license I8
Description
database W5–W6, R231
Group W73, R132
Dialog
Alphabetizing W304–W305
Authors R376–R382
Change Field W112–W114, R290–R293
Cite R321–R322
shortcuts S43
Cite Settings R323–R324
Cross-Reference List W160–W163, R279
Database Info W5–W6, R83, R231–R232
Database Repair R246–R249
Database Settings R234–R243
Editors R376–R382
Fields & Reference Types W288–W301, R235
Find R298–R311
shortcuts S37–S39
Find & Replace Text W109–W112, R284–
R287, R292–R293
Format Entry R353–R355
shortcuts W181, S45
Import Set-up R328–R331
Layout W49–W51
List with Index W166–W168, R281–R282
Miscellaneous Settings R243

Duplicate references R338–R341
during importing W214–W215, R329–R330
Duplicates file
importing references R326
Duplicating
fields W30, R108, S11
formats R178
references W30, S11

E
Edit menu R399–R400
Editing
formats R178
globally W104–W115
glossary entries R202
journals W105–W106, R164
keywords W104–W105, R151
names W107–W109, R190
references W34–W43
Editing items in place R71
Editor Role field R95
Editors. See also Names
appearance in bibliographies C13–C14, C42–
C44, R376–R382
variations C42–C43
looking up R73
series R41
Editors dialog R376–R382
Editors field R32–R33
Eliminating duplicate references R338–R341
EndNote
exchanging data with R428–R432
Entering
dates R96
journals W14, R71
keywords R70, R238
names W13, R32–R33, R94–R95
et al. R94
shortcuts R94
notecards W64–W65
notecards and references together W68–W69
pages R97
reference numbers R93
references W10–W20, W22–W32, R86–R111
years W13, R34, R95
et al. C14, R33, R94
in bibliographies R382
in-text citations R364
Excalibur W284
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Exchanging data between Papyrus databases. See
Transferring data between Papyrus databases
Exchanging data with EndNote R428–R432
Exporting. See Printing/Exporting
Exporting to EndNote R428–R432

F
Field types W288–W301, R86, R93–R98, R235
associated reference R98
day & month R95
day, month & year R96
degree R97
document type R98
editor role R95
free text R93
ID Field R93
journal R97
keyword R96–R97
name R94–R95
number R94
ordinal R94
pages R97
picture R98
Reference # R93
title R94
year R95
yes or no R97
Fields W288–W301, C26–C33, R28–
R64, R86, R235
Abstract R30
Accession # R32
Affiliation/Address R34
Also Print R37
Associated Reference R98
Authors R32–R33
Authors Role R40
Authors role R33–R34
Card title W65
Catalog # R41
Chapter # R45
collapsing W41, R102
Comments R30
creating new W292–W295
Date R96
Date accessed R47
Date posted R47
Day & Month R95
Day, Month & Year R96
Degree R97

Fileserver
legal issues I7
Filters, plug-in W226–W228, W262–
W263, R6, R395–R396
Alphabetize Tags W262
Outdent Percents W262
Find & Replace Text W109–W112, R284–
R287, R290–R293
Find Dialog R298–R311
shortcuts S37–S39
Find dialog
use of Look up in S38
Finding references W84–W101, R298–R311
* (wildcard) W92–W93
AND vs. OR W89–W90
following keyword links W147–W148
following reference links W155
General “field” C56, R302
loading search results W100, R298–R299
NOT W93–W94
quick finds W86–W88
refining a search W95–W100, R309–R311
Term “field” W91, R301
use of parentheses W94–W95
Folders
organization of R5–R6
Font
base W40, R275
Font menu W40, R405
Fonts
IMPORTANT NOTE W40
Footnote list
vs. bibliography C4–C5
Footnotes C4, C17
informational C5
short titles in R35
Format Entry Dialog R353–R355
Format Entry dialog
shortcuts S45
Format Libraries W59–W60, R180–R181
Format Preview window W57–W58
Format templates
fields in R386–R387
Formats W47–W48, W56–W61
Column Breaks W205
copying R178
creating W170–W207, W231–W233, W240–
W267, R177
deleting R178
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Fields continued
Document Type R98
Document/Media Type R37
duplicating W30, R108, S11
Editor Role R95
Editors R32–R33
hidden W28, W291, R90, R102
ID Field R93
in placeholders R315
ID field R30
in format templates R386–R387
in searches W84
Inventor R51
ISBN R41
Issue Editors R39
Issue Title R39, R48
Keywords R31
Language R36
Location R37
maximum size of R20
Message-id R62
missing C46
Month R95
moving from field to field R99
multiple W289, R90
number of R20
optional W291, C46, R90
Original Title R36
Photographer R60
Picture W280, R31, R98
Place in reference W65, R63
Presentation Type R54
Quotation W65, R63
Reference # R29, R93
required W31, W291, C46, R90, R101–R132
Role of Editor R34, R41
Short Title R35
that are indexed W289–W290, C56
Title R30, R94
Total # pages R40
unusual entries R67
URL W274–W275, R31
user-defined R28
whole-indexed vs. piece-indexed C57–C58
Work Reviewed R36
Year R34–R35, R95
Yes or No R97
Fields & Reference Types dialog W288–W301
File menu R397–R398

Formats continued
display
All References window R117–R118
Group window R136–R137
Reference Links window R222
duplicating R178
editing R178
If Any brackets W185
If First brackets W183–W184
import W231–W233, W240–W267
libraries W59–W60, R180–R181
output W170–W207, C8–C9
paragraphs in W199
predefined W59–W60
previewing W57–W58, R179
printing/exporting R272
selecting R177
Sorting/Printing
Group R133
tabular output W202–W206, C9
transferring from Version 7 W316
transferring to another Version 8 database
W328
Formats window W56–W59, R174–R185
drag and drop R182
elements of R176
shortcuts S27–S28
Formatted reference
inserting into manuscript R319
Free demo version of Papyrus I4, I7
Free Text fields R93
FTP sites
citing W270–W271, R47
Full version of Papyrus I4, I7
Fussiness level W212–W213, R330

G
Garbage
in, out W241
General “field”
as a search term C56, R302
GeoRef W228
German, umlauts in W304, R135, R236, R361
GIGO W241
Global find & replace W104–W115, R284–
R287, R290–R293, R292–R293

Index 8

Glossary entries
creating W22–W24, R202
deleting R203
editing R202
exporting R204
importing R203
loading R203
looking up R73
printing/exporting R204, R272
selecting W22–W24, R201
transferring to another Version 8 database
W329–W330
Glossary window W22–W24, R200–R207
drag and drop R205
elements of R201
shortcuts S31–S32
Going out of business
avoiding I5
Good-bye messages R243
Graphics. See Pictures
Greek letters R68
Group menu R403
Group window R128–R145
description R132
display formats R136–R137
drag and drop R140, R141
elements of R130
preferences R138, R139
shortcuts S17–S19
Sorting/Printing format R133
Groups W72–W82, C62–C65
adding and removing references W73–W75
creating new W72–W73
description W73, R132
pointers in C64
printing/exporting W80–W81
sorting W75–W77, W305–W306, C63, R134–
R135

H
Harvard style of citation C16
Headers and footers
in printing/exporting W50, R276
Headline-style capitalization C15, R30
Hell
data sources from W264–W267

I
ID field R30, R93
in placeholders R315
Identifying
journals R71
keywords R70
If Any brackets W185
vs. If First brackets W185
If First brackets W183–W184
vs. If Any brackets W185
Import formats
creating W231–W233, W240–W267
Import Set-up dialog W210–W219, R328–R331
Import window W217–W218, R332–R335
status R333
Importing
another Papyrus database W322
from EndNote R428–R432
glossary entries R203
journals R166–R167
keywords R153
names R192–R193
plug-in filters R6, R395–R396
references W210–W219, R326–R335
character set R329
creating a Group R331
debugging W218, W233–
W234, R333, R334–R335
duplicates W214–W215, R329–R330
duplicates file R326

Importing references continued
from word processor bibliography W230–
W237
fussiness level W212–W213, R330
indentation W243–W244, R373
keywords W216–W217, W248, R330
keywords, decapitalizing R330
log file W213–W214, R326
paragraphs in W243–W244
plug-in filters W226–W228, W262–W263
prerequisites W211–W212
reference # W216, R330, R331
reference type R333
reject file W214, R326
repeated fields W258–W262
Set-up dialog W210–W219, R328–R331
spaces within W233, W247
speeding the process W218, R332
troubleshooting W222–W223, W249–W251
In preparation C14–C15
In press C14–C15, R37
In-text citation C12, C15, C16
et al. R364
names ALL CAPS R362
names small caps R362
INCOMPLETE (keyword) C46–C47, R101–R132
Incomplete references W31, C46–C47, R101–
R132
Indentation
during importing W243–W244, R373
in bibliographies R372–R373
Index file W5, R10
Index Medicus format. See Vancouver format
Indexed list W166–W168
Indexes C54–C59
non-indexed words W289–W290, C58
rebuilding R249
which fields are indexed W289–W290, C56
whole- vs. piece-indexing W289–W290, C57–
C58
Indices. See Indexes
Individual Items view
All References window R115
Group window R130
Individuals, slightly less trusted R237
Informational footnotes C5
Initials
adding to name-year citation C16, R362
vs. first names C42, R32, R190
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Help
balloon W12, R14–R15
folder R5
alias to R5
key R15
online W11, R14–R17
navigating R17
tour W12, R15
Help menu R14, R16
Helper applications R241
Hidden fields W28, W291, R90, R102
Hiding in-text citations R319
Hierarchical keywords C37–C38
Hoi polloi
members of R237
Hollow cursor R81
HTML
printing/exporting W53, W277, R273

Inputting
references W10–W20, W22–W32
Insert symbol R68
Inserting
formatted reference into manuscript W126–
W127, R319
line-break R69
placeholders into manuscript W120–W122
Installing Papyrus R4–R6
Institutional site license I8
Internet
installing Papyrus from R4
Internet Config W272–W273, R31
Internet source W270–W271, R47
Inventor field R51
ISBN field R41
ISO form for dates R96
ISSN C32, R163
Issue Editors
journal R39
Issue number
journal W183, C30–C32
Issue of journal R48
Issue Title
journal R39
Issue Title field R48

J
Jealousy C15
Journal
abbreviation styles C30, R239–R240
abbreviations C21, C30
abbreviations, reasonable R71
call number C32, R163
comments C32, R163
dates C30–C32
ISSN C32, R163
issue numbers C30–C32
names C30
other information C32
series C30–C32
supplements C30–C32
URL W276–W277, C32, R163
Web sites C32
Journal articles. See Article in journal
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Journals
combining R165
creating W14, R163
deleting R164
editing W105–W106, R164
entering W14, R71
exporting R168–R169
importing R166–R167
loading R166–R167
looking up R71, R73
merging R165
minor C5
printing R168–R169
printing/exporting R272
selecting R162
throw-away R39
transferring from Version 7 W314–W315
transferring to another Version 8 database
W326–W327
transferring to Version 7 W319
Journals window R160–R172
drag and drop R169, R182
elements of R161
shortcuts S25–S26

K
Key
help R15
Keyboard shortcuts
All References window S13
Cite dialog S43
dialogs S3
Find dialog S37
Format Entry dialog S45
Formats window S27
Glossary window S31
Group window S17
Journals window S25
Keyword Links window S33
Keywords window S21
Names window S29
Reference Entry window W39, S9
Reference Links window S35
Refine Search dialog S41
switching windows S5
Template Entry dialog S47

Keywords window R148–R158, R150–R158
drag and drop R155
elements of R149, R150
shortcuts S21–S23
Show Links button W146–W147, W148–W152
Kokai R51

L
LAN
legal issues I7
use of Papyrus R24–R26
Language
sorting based on W304–W306, R135
Language field R36
LaTeX R242, R412–R426
printing/exporting R273
Launching Papyrus R8–R12
Law, Murphy's C26
Layout
print/export W49–W51, R275–R277
Legal copies of Papyrus I4, I5, I7–I11
Letter
added to ID Field citation R30, R270
added to name-year citation C16, R270
added to year R35, R270
Letters
accented W18
Greek R68
non-English W18
Libraries, Format W59–W60, R180–R181
License
agreement I5, I7–I11
departmental I8
institutional I8
policy, ridiculously reasonable I5, I7–I11
Limited version of Papyrus I4, I7
Limits of database R20
Line-break, inserting R69
Link types
forward vs. reverse R214, R225
keyword R213–R215
reference R225–R226
Linked keywords W142–W149, C38–C39, R210–
R217
following, in searches W147–W148, W149–
W151, R305
Linked references W152–W157, C51, R220–R230
following, in searches W155, R307–R308
printing W156–W157
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Keyword links W142–W149, W143–
W149, W152–W157, C38–C39, R210
creating W142–W145, W145, R212–R215
deleting W145–W146, W147–W152, R215
following, in searches W147–W148, W149–
W151, R305
in Keywords window W146–W147, W148–
W152
types of R213–R215
Keyword Links window W142–W149, W143–
W149, W152–W157, R210–R217
drag and drop R215
elements of R211
opening R155, R210
shortcuts S33–S34
Keywords W36–W38, C36–C39, R31
antonyms C38
combining R153
creating R151, R238
deleting R152
during reference importing W216–W217
editing W104–W105, R151
entering R70, R238
exporting R154
hierarchical C37–C38
importing R153
INCOMPLETE C46–C47
linked W142–W149, W143–W149, W152–
W157, C38–C39
loading R153
looking up R70, R73
major vs. minor W248, C36, R31
maximum number of R20
merging R153
printing R154
printing/exporting R272
selecting R150, R212
sub-category C38
super-category C38
synonyms C38
transferring from Version 7 W313
transferring to another Version 8 database
W325–W326
transferring to Version 7 W318
truncated W48
wildcards R70

Linking
keywords W142–W145
notecards to references W66–W67
references W152–W154
Links Window button R104, R119, R138, R155
List
Cross-Reference W160–W163, R279
with Index W166–W168, R281–R282
Lists
picking from R75–R76
Loading
glossary entries R203
journals R166–R167
keywords R153
names R192–R193
references R326–R335
Loading search results W100, R298–R299
Location field R37
Locked database R25–R26, R83
Log file
importing references W213–W214, R326
Look Up (Edit menu) W27, W37, R73, S11
in Find dialog S38

M
MacWrite, printing/exporting as W51–
W52, R273
Major vs. minor keywords W248, C36, R31
Manual order W78–W80
Manuscript
inserting reference placeholders W120–
W122, R314–R324
processing W118–W128, R344–R352
additional text in citation W124–W125
citing just the year W124
clearing Group first R349
formatted references W125–W126
handling multiple chapter manuscripts R349
including informational notes R351–R352
multiple references at once W136–W139
preparing for R345
specific pages W130–W133
Map R49
Margins, in printing/exporting R276
Martinet C9
Masters Thesis R45–R46, R97
Mathematical symbols R68
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Maximum number
of authors R20
of records R20
Medline W222
Meeting proceedings R53–R57
Menu
Edit R399–R400
File R397–R398
Font R405
Group R403
Help R14, R16
Reference R401
Style R407
Windows R409
Merging
databases W322
journals R165
keywords R153
names R192
Message-id field R62
Messages, good-bye R243
Microsoft Word W51, R274
Minor journals C5
Miscellaneous information R37
Miscellaneous Settings dialog R243
Missing fields C46
Mode
read-only I4
Modifying
formats R178
glossary entries R202
journals R164
keywords R151
names R190
references W34–W43
Money, large sums of I4
Monograph. See Book/Monograph
Month field R95
Mouse shortcuts
All References window S14
Formats window S28
Glossary window S31
Group window S18
Journals window S25
Keyword Links window S33
Keywords window S22
Names window S29
Reference Entry window S10
Reference Links window S36

N
Name-Year citation C12, C16
adding initials C16, R362
adding letter C16
Names
combining R192
compound C43
editing W107–W109, R190
entering W13, R32–R33, R94–R95
exporting R193–R194
importing R192–R193
in bibliographies C13–C14, C42–C44, R376–
R382
in-text citations
ALL CAPS R362
small caps R362
initials vs. first names C42, R32, R190
journal C30
loading R192–R193
merging R192
printing/exporting R193–R194, R272
repeated C13
selecting R189
sorting C43, R190
transferring to another Version 8 database
W328–W329
variations C42–C43, R190
vs. persons C43, R190
Names window R188–R197
drag and drop R194
elements of R189
shortcuts S29–S30
Network
legal issues I7
use of Papyrus R24–R26

New
database R9
formats R177
glossary entries R202
Groups W72–W73
journals R163
keyword links W145, R212–R215
keywords R151
reference links R224–R226
New Keywords dialog R238
Newsgroup post. See Usenet post
Newspaper article R50
Nisus Writer W51, R274
Non-English characters W18
Non-indexed words C58
NOT in searches W93–W94
Notecards W64–W70, C50–C51, R63, R86
Card Title field W65
creating W64–W65
entering with references W68–W69
linking to references W66–W67
Place in Reference field W65
printing/exporting W69–W70
Quotation field W65
vs. Abstract field R30
vs. Comments field R31
Number
reference R29, R93
sequence R370
Number fields R94
Numbering
references in bibliography C12, R370–R371
Numbering & Layout dialog R368–R373
Numeric citation C15

O
Offenlegungsschrift R52
Online help W11, R14–R17
navigating R17
Optional fields W291, C46, R90
OR vs. AND in searches W89–W90
Order
alphabetic C4, C12, R360
citation W78–W80, C4, C12, C63, R360
Ordinal fields R94
Original Title field R36
Other information
journal C32
Other reference R64
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Moving data between Papyrus databases. See
Transferring data between Papyrus databases
Multi-user database R24–R26
Multiple brackets W258–W262
Multiple databases W6
Multiple fields W289, R90
Multiple references in one citation W136–W139
Multitasking
and hollow cursor R81

Outdent Percents plug-in filter W262
Output formats W47–W48, C8–C9
creating W170–W207
tabular C9
Overriding Papyrus assumptions R67
Ovid W222

P
Pages
citing particular W130–
W133, C4, C17, C63, R316–R317
discontinuous R39, R97
entering R97
specific W130–W133, C4, C17, C63, R316–
R317
Paper, processing. See Manuscript: processing
PaperChase W222
PAPX transfer
from Version 7 W310–W312, R256–R257
to Version 7 W317, R264
Papyrus
Additions folder R6
client-server version R24
Help folder R5
alias to R5
illegal copies of R4
installing R4–R6
launching R8–R12
legal copies of I4, I5, I7–I11
organization of folders R5–R6
Papyrus database
alias to R12
pieces of C20–C24
Papyrus Help folder R5
Papyrus-Papyrus transfer W308–W320, W322–
W330, R252–R266
exporting for Version 7 W317, R264
exporting for Version 8 W322–W330, R265–
R266
importing
advanced concerns R260–R263
importing from Version 7
via *.BB files W308–W310, R258–R259
via PAPX W310–W312, R256–R257
importing from Version 8 R253–R255
Paragraphs
in formats W199, W243–W244
Parentheses in searches W94–W95
Passwords. See Access Codes
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Paste Symbol R68
Pasting formatted reference into manuscript
W126–W127
Patent R51–R52
Patent applications R52
Persnicketiness W235
Person
vs. name C43
Personal Papyrus tutor I6
Personal preferences of TeX users R412
Ph.D. dissertation R45–R46, R97
Phone calls, lengthy, overseas R4
Photographer field R60
Picking from a list R75–R76
Picture field R31, R98
Pictures W280–W282
entering W280
in bibliographies W281–W282, R373
maximum size of R20
Piece-indexed fields C57–C58
Pirated copy of Papyrus R4
Place in reference field W65, C50, R63
Placeholders
additional text in R316
delimiters R315
ID Field in R315
in manuscript R314–R324
inserting into manuscript W120–W122
Plain text
printing/exporting W53, R273
Plug-in filters W226–W228, W262–
W263, R6, R395–R396
Alphabetize Tags W262
Outdent Percents W262
Pointers, in Groups C64
Policy, license I5, I7–I11
Poster sessions R54
Predefined formats W59–W60
Preferences
All References window R118, R119
Group window R138, R139
Reference Entry window R105
Reference Links window R223
Presentation at meeting R53–R57
Presentation Type field R54
Previewing
formats W57–W58, R179
Print/Export dialog W46–W54, R268–R277

Q
Quick Find W86–W88
Quotation field W65, C50, R63
Quoted citation R58–R59, R98

R
Raison d’être, Papyrus’s W10

Read-only mode I4, R25–R26, R83
Rebuild index file R249
Record types. See Reference types
Records, maximum number of R20
Reference # R29
during importing W216
entering R93
field R93
range W5, R231
Reference Entry window W10–W20, W22–
W32, W34–W43, R86–R111
drag and drop R106
elements of R88
preferences R105
shortcuts S9–S12
title bar R88
Reference links W152–W157, R220
creating W152–W154, R224–R226
deleting W154, R226
following, in searches W155, R307–R308
printing W156–W157
types of R225–R226
Reference Links window W152–
W157, W154, R220–R230
display formats R222
drag and drop R227
elements of R221
opening R104, R119, R138, R220
preferences R223
shortcuts S35–S36
Reference list
importing into Papyrus W230–W237
Reference menu R401
Reference types W288–W301, C26–C33, R28–
R64, R86, R235
Archival materials R38
Article in journal R39
Book/Monograph R40–R43
Chapter in book R44–R45
choosing R89
Conference proceedings R53–R57
creating new W295–W298
default R89
Dissertation/Thesis R45–R46
Dissertations on Microfilm R46
Internet source W270–W271, R47
Issue of journal R48
Map R49
Newspaper article R50
Notecard R63
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Printing/Exporting
as HTML W53, W277, R273
as MacWrite W51–W52, R273
as plain text W53, R273
as RTF W51–W52, R273
as TeX W53, R273
as Web page W53, W277, R273
as word processor document W51–W52, R273
cross-reference list W160–W163
font R275
formats R272
glossary entries R204, R272
Groups W80–W81
headers and footers W50, R276
index cards W51, R277
indexed list W166–W168
journals R168–R169, R272
keywords R154, R272
layout R275–R277
margins R276
names R193–R194, R272
notecards W69–W70
reference links W156–W157
references W46–W54, R269–R271
layout R275–R277
truncating fields in R271
single item per page W51
title of list R275
via AppleScript W52, R274
Priority patent applications R52
Process Manuscript W118–W128, R344–R352
additional text in citation W124–W125
citing just the year W124
clearing Group first R349
dialog W122–W124, R345–R348
formatted references W125–W126
handling multiple chapter manuscripts R349
including informational notes R351–R352
multiple references at once W136–W139
preparing for W120–W122, R314–R324, R345
specific pages W130–W133
PubMed W222

Reference types continued
number of R20
Other reference R64
Patent R51–R52
Poster sessions R54
Presentation at meeting R53–R57
Quoted citation R58–R59, R98
Reports R42–R43
Slide/Visual R60–R61
Usenet post W271–W272, R62
user-defined R28
References
adding to Group W73–W75
anonymous W176, C14, R33, R243
citing
as plain text R320
hiding the citation R319
inserting as formatted references R319
citing in manuscript R314
by year only R318
sorting within manuscript citation R318
collections of. See Groups
copying R108
copying to other applications R323
deleting W41–W42
dragging to other applications R323
duplicates R338–R341
duplicating W30, R108, S11
editing W34–W43
entering W10–W20, W22–W32
entering with notecards W68–W69
fields C26–C33, R235
finding W84–W101, R298–R311
formatted
pasting into manuscript W126–W127
groups of C62–C65
importing W210–W219, R326–R335
character set R329
creating a Group R331
debugging W218, W233–
W234, R333, R334–R335
duplicates W214–W215, R329–R330
from word processor bibliography W230–
W237
fussiness level W212–W213, R330
indentation W243–W244
keywords W216–W217, W248, R330
keywords, decapitalizing R330
log file W213–W214
paragraphs in W243–W244
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References, importing continued
plug-in filters W226–W228, W262–W263
prerequisites W211–W212
reference # W216, R330, R331
reference type R333
reject file W214
repeated fields W258–W262
Set-up dialog W210–W219, R328–R331
spaces within W233, W247
speeding the process W218, R332
troubleshooting W222–W223, W249–W251
in preparation C14–C15, C46–C47
in press C14–C15, C46–C47, R37
incomplete W31, C46–C47, R101–R132
inserting into manuscript R314–R324
linked W152–W157, C51
linking to notecards W66–W67
location of physical reference R37
maximum size of R20
numbering in bibliography C12, R370–R371
obscure R58–R59
printing/exporting W46–W54, R269–R271
removing from Group W73–W75
saving R100
searching W84–W101, R298–R311
selecting R120, R139, R139–R140, R223
sorting W75–W77, C63
spellchecking W285–W286
submitted C14–C15, C46–C47
type. See Reference types
Refine Search dialog W95–W100, R309–R311
shortcuts S41
Reject file
importing references W214, R326
Repair Database dialog R246–R249
Repair database integrity R248
Repeated authors W193, C13
Replacing text W109–W112, W112–W114
Reports R42–R43
Required fields W31, W291, C46, R90, R101–
R132
Reviews R36
Rogue data-entry clerks W222
Role of Author field W19
Role of Editor field R34, R41
RTF, printing/exporting as W51–W52, R273

S
Saving references R100

Shortcuts continued
Glossary window S31–S32
Group window S17–S19
Journals window S25–S26
Keyword Links window S33–S34
Keywords window S21–S23
looking up items R73
moving from field to field R99
Names window S29–S30
picking from a list R75–R76
Reference Entry window W39, S9–S12
Reference Links window S35–S36
Refine Search dialog S41
saving references R100
switching windows S5
Template Entry dialog W181, S47–S48
Show cogitation R333
Show hidden fields W28, R90, R102
Show Links button
in Keywords window W146–W147, W148–
W152
Sign-off messages R243
Silver Platter W222
Single item per page, printing W51
Site license
departmental I8
institutional I8
Slide/Visual R60–R61
Snobbery C14
Sorting
alphabetic order C4, C12, R236–R237, R360
by author. See Sorting: alphabetic order
citation order W78–W80, C4, C12, C63, R360
group W75–W77, C63, R134–R135
language-dependent W304–
W306, R135, R236–R237
names C43, R190
rules W304–W306
umlauts W304, R135, R236, R361
within a manuscript citation R318
Sorting & Citing dialog R358–R365
Sorting/Printing format
Group R133
Spaces within imported references W233, W247
Specific pages W130–
W133, C4, C17, C63, R316–R317
Specifications of database R20
Spellchecking W284–W286, R241, R295
references W285–W286, W290
text W284
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Search & Replace W109–W112, R284–
R287, R290–R293
Searching references W84–W101, R298–R311
* (wildcard) W92–W93
AND vs. OR W89–W90
following keyword links W147–W148
following reference links W155
General “field” C56, R302
loading search results W100, R298–R299
NOT W93–W94
quick finds W86–W88
refining a search W95–W100, R309–R311
Term “field” W91, R301
use of parentheses W94–W95
which fields are indexed C56
Season R95
Security. See Access Codes
Selecting
by typing R75–R76
formats R177
glossary entries R201
journals R162
keywords R150, R212
names R189
references
in All References window R120
in Group window R139, R139–R140
in Reference Links window R223
Sentence-style capitalization C15, R30
Separate databases W6
Sequence number R370
Series, journal W183, C30–C32
Series of books R41
Shared database R24–R26
Sharing data between Papyrus databases. See
Transferring data between Papyrus databases
Shifting title to author position
W201, W202, C14
Short Title field R35
Shortcuts
All References window S13–S15
Cite dialog S43
dialogs S3
editing items in place R71
Editor Role fields R95
entering names R32, R94
entering years R34, R95
Find dialog S37–S39
Format Entry dialog W181, S45
Formats window S27–S28

Spellswell Plus W284
Splitting a database R266
Status window W6, R83
shortcuts S7
STN W222
Style menu R407
Styles
bibliographic. See Formats
journal abbreviation C30, R239–R240
Sub-category, keywords C38–C39
Submitted C14–C15
Super-category, keywords C38–C39
Supplement, journal C30–C32
Suppress anonymous C14
Suppress year if "in press" C15
Symbol font R68
Symbol, inserting R68
Symposium R54
Synonyms, keyword C38–C39
Systems, writing R20

T
Table view
All References window R115
Group window R130
Tabular output formats W202–W206, C9
Target window R77–R79
Telnet sites, citing R47
Template Entry dialog R384–R393
shortcuts W181, S47–S48
Templates, format
fields in R386–R387
Term “field”
as a search term W91, R301
TeX R242, R412–R426
printing/exporting W53, R273
Text, replacing W109–W112, W112–W114
Thermodynamics, Second Law of C26
Thesis. See Dissertation/Thesis
Title R30, R94
capitalizing W16, C15
issue R39, R48
notecard W65, C50
of list R275
original R36
series R41
shift to author position W201, W202, C14
short R35
translated R36
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Total # pages field R40
Tour of balloon help W12, R15
Transferring data
between Papyrus databases W308–
W320, W322–W330, R252–R266
advanced concerns R260–R263
exporting for Version 7 W317, R264
exporting for Version 8 W322–W330, R265–
R266
importing from Version 7 via *.BB files
W308–W310, R258–R259
importing from Version 7 via PAPX W310–
W312, R256–R257
importing from Version 8 R253–R255
to/from EndNote R428–R432
Translators R33–R34, R34, R41, R95
Trouble
getting yourself into C26
Troubleshooting imports W222–W223, W249–
W251
Truncating fields
printing and exporting W48, R271
Tutor, personal Papyrus I6
Type select R75–R76
Types of fields R93–R98, R235
associated reference R98
day & month R95
day, month & year R96
degree R97
document type R98
editor role R95
free text R93
ID Field R93
journal R97
keyword R96–R97
name R94–R95
number R94
ordinal R94
pages R97
picture R98
Reference # R93
title R94
year R95
yes or no R97
Types of links
forward vs. reverse R214, R225
keyword R213–R215
reference R225–R226

U
Umlauts W304, R135, R236, R361
Uniform Requirements for Biomedical
Journals. See Vancouver format
Unusual entries R67
URL
in exported reference lists W277
in reference W274–W275
in text W274
journal W276–W277, C32, R163
URL field W274–W275, R31, R47
Usenet post W271–W272, R62
Users
hard-core C68
types of C68

V
Vancouver format W170–W188
Versions of Papyrus I4, I5, I7
Viewing formats R179

W
Web browser R241

Web page
printing/exporting W53, R273
Web sites, journal C32
Wedgewood crucibles R352
Whole-indexed fields C57–C58
Wildcard (*) W92–W93, R73
Window
All References R114–R125
display formats R117–R118
drag and drop R121
elements of R115
preferences R118, R119
shortcuts S13–S15
closing, without being asked to save S12, S19
Format Preview W57–W58
Formats W56–W59, R174–R185
drag and drop R182
elements of R176
shortcuts S27–S28
Glossary R200–R207
drag and drop R205
elements of R201
shortcuts S31–S32
Group R128–R145
description R132
display formats R136–R137
drag and drop R140, R141
elements of R130
preferences R138, R139
shortcuts S17–S19
Sorting/Printing format R133
Import W217–W218, R332–R335
status R333
Journals R160–R172
drag and drop R169, R182
elements of R161
shortcuts S25–S26
Keyword Links R210–R217
drag and drop R215
elements of R211
opening R155, R210
shortcuts S33–S34
Keywords R148–R158, R150–R158
drag and drop R155
elements of R149, R150
shortcuts S21–S23
Names R188–R197
drag and drop R194
elements of R189
shortcuts S29–S30
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Types of reference C26–C33, R28–R64,
R37, R86, R235
Archival materials R38
Article in journal R39
Book/Monograph R40–R43
Chapter in book R44–R45
choosing R89
Conference proceedings R53–R57
default R89
Dissertation/Thesis R45–R46
Dissertations on Microfilm R46
Internet source R47
Issue of journal R48
Map R49
Newspaper article R50
Notecard R63
Other reference R64
Patent R51–R52
Poster sessions R54
Presentation at meeting R53–R57
Quoted citation R58–R59
Reports R42–R43
Slide/Visual R60–R61
Usenet post R62

Window continued
Reference Entry W10–W20, W22–W32, W34–
W43, R86–R111
drag and drop R106
elements of R88
preferences R105
shortcuts S9–S12
title bar R88
Reference Links W154, R220–R230
display formats R222
drag and drop R227
elements of R221
opening R104, R119, R138, R220
preferences R223
shortcuts S35–S36
Status W6, R83
shortcuts S7
switching
shortcuts S5
target R77–R79
Windows menu R409
Word processor
printing/exporting to W46–W54, R273
properly designed W52
nonexistent R274
Word processor bibliography
importing into Papyrus W230–W237
Word Services W284
WordPerfect W51, R274
Words, non-indexed W289–W290, C58
Work Reviewed field R36
Workforms. See Reference types
World Wide Web (WWW) W270–W278
citing R47
installing Papyrus from R4
linking to R31
WorldScript R20, R135, R236–R237
Writing systems R20, R135

Y
Year
adding a letter R35, R95, R270
entering W13
field W13, R34–R35, R95
non-numeric R35
Year 2000 W13, R34
Year-only citations W124, R318
Yes or No fields R97
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Z
Zeitschrift für Tierphysiologie, Tierernaehrung...
C22

